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Copyright © 2009, 2017, Oracle and/or its affiliates. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a 
license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual 
and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to 
obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, 
please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your 
license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United 
States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are 
"commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and 
agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, 
including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license 
agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--
Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. 
It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe 
use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use 
of the Programs.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not 
responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of 
such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and 
the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of 
the agreement with the third party, including delivery of products or services and warranty obligations related to purchased 
products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third 
party.

Oracle, JD Edwards, and PeopleSoft are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be 
trademarks of their respective owners.



THIRD PARTY SOFTWARE NOTICES

This product includes software developed by Apache Software Foundation (http://www.apache.org/).

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE  DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 2000-2009 The Apache Software Foundation. All rights reserved.

Apache Commons Math Copyright 2001-2008 The Apache Software Foundation 

This product includes software translated from the odex Fortran routine developed by E. Hairer and G. Wanner and distributed 
under the following license:

Copyright (c) 2004, Ernst Hairer

Apache License Version 2.0, January 2004 (http://www.apache.org/licenses/LICENSE-2.0)

THIS SOFTWARE IS PROVIDED "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE  DISCLAIMED. IN NO EVENT SHALL THE VISIGOTH SOFTWARE SOCIETY OR ITS CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Apache Commons Codec Copyright 2002-2009 The Apache Software Foundation 
Copyright (C) 2002 Kevin Atkinson (kevina@gnu.org)

Apache Commons Pool 
Copyright 2001-2011 The Apache Software Foundation

Apache Jakarta Commons Lang
Copyright 2001-2007 The Apache Software Foundation

Apache Jakarta Commons FileUpload
Copyright 2002-2006 The Apache Software Foundation

Apache Commons CLI
Copyright 2001-2009 The Apache Software Foundation

Apache Commons Collections
Copyright 2001-2008 The Apache Software Foundation

Apache Commons Logging
Copyright 2003-2013 The Apache Software Foundation

Barcode4J
Copyright 2002-2010 Jeremias Märki
Copyright 2005-2006 Dietmar Bürkle
Portions of this software were contributed under section 5 of the
Apache License. Contributors are listed under: (http://barcode4j.sourceforge.net/contributors.html) 



Copyright 2002-2010 The Apache Software Foundation

This product includes software distributed via the Berkeley Software Distribution (BSD) and licensed for binary distribution 
under the Generic BSD license.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'' AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 2009, Berkeley Software Distribution (BSD)

This product includes software developed by the JDOM Project (http://www.jdom.org/).

THIS SOFTWARE IS PROVIDED "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (C) 2000-2004 Jason Hunter & Brett McLaughlin. All rights reserved.

This product includes software developed by the Massachusetts Institute of Technology (MIT).

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Copyright © 2009 MIT

This product includes software developed by Jean-loup Gailly and Mark Adler. This software is provided 'as-is', without any 
express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Copyright (c) 1995-2005 Jean-loup Gailly and Mark Adler

This software is based in part on the work of the Independent JPEG Group (http://www.ijg.org/).

This product includes software developed by the Dojo Foundation (http://dojotoolkit.org).

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 



CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright (c) 2005-2009, The Dojo Foundation. All rights reserved.

This product includes software developed by W3C.

Copyright © 2009 World Wide Web Consortium, (Massachusetts Institute of Technology, Institut National de Recherche en 
Informatique et en Automatique, Keio University). All Rights Reserved. (http://www.w3.org/Consortium/Legal/)

This product includes software developed by Mathew R. Miller (http://www.bluecreststudios.com).

Copyright (c) 1999-2002 ComputerSmarts. All rights reserved.

This product includes software developed by Shaun Wilde and distributed via Code Project Open License (http://
www.codeproject.com).

THIS WORK IS PROVIDED "AS IS", "WHERE IS" AND "AS AVAILABLE", WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTIES OR CONDITIONS OR GUARANTEES. YOU, THE USER, ASSUME ALL RISK IN ITS USE, INCLUDING 
COPYRIGHT INFRINGEMENT, PATENT INFRINGEMENT, SUITABILITY, ETC. AUTHOR EXPRESSLY DISCLAIMS 
ALL EXPRESS, IMPLIED OR STATUTORY WARRANTIES OR CONDITIONS, INCLUDING WITHOUT LIMITATION, 
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, MERCHANTABLE QUALITY OR FITNESS FOR A 
PARTICULAR PURPOSE, OR ANY WARRANTY OF TITLE OR NON-INFRINGEMENT, OR THAT THE WORK (OR ANY 
PORTION THEREOF) IS CORRECT, USEFUL, BUG-FREE OR FREE OF VIRUSES. YOU MUST PASS THIS 
DISCLAIMER ON WHENEVER YOU DISTRIBUTE THE WORK OR DERIVATIVE WORKS. 

This product includes software developed by Chris Maunder and distributed via Code Project Open License (http://
www.codeproject.com).

THIS WORK IS PROVIDED "AS IS", "WHERE IS" AND "AS AVAILABLE", WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTIES OR CONDITIONS OR GUARANTEES. YOU, THE USER, ASSUME ALL RISK IN ITS USE, INCLUDING 
COPYRIGHT INFRINGEMENT, PATENT INFRINGEMENT, SUITABILITY, ETC. AUTHOR EXPRESSLY DISCLAIMS 
ALL EXPRESS, IMPLIED OR STATUTORY WARRANTIES OR CONDITIONS, INCLUDING WITHOUT LIMITATION, 
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, MERCHANTABLE QUALITY OR FITNESS FOR A 
PARTICULAR PURPOSE, OR ANY WARRANTY OF TITLE OR NON-INFRINGEMENT, OR THAT THE WORK (OR ANY 
PORTION THEREOF) IS CORRECT, USEFUL, BUG-FREE OR FREE OF VIRUSES. YOU MUST PASS THIS 
DISCLAIMER ON WHENEVER YOU DISTRIBUTE THE WORK OR DERIVATIVE WORKS. 

This product includes software developed by PJ Arends and distributed via Code Project Open License (http://
www.codeproject.com).

THIS WORK IS PROVIDED "AS IS", "WHERE IS" AND "AS AVAILABLE", WITHOUT ANY EXPRESS OR IMPLIED 
WARRANTIES OR CONDITIONS OR GUARANTEES. YOU, THE USER, ASSUME ALL RISK IN ITS USE, INCLUDING 
COPYRIGHT INFRINGEMENT, PATENT INFRINGEMENT, SUITABILITY, ETC. AUTHOR EXPRESSLY DISCLAIMS 
ALL EXPRESS, IMPLIED OR STATUTORY WARRANTIES OR CONDITIONS, INCLUDING WITHOUT LIMITATION, 
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, MERCHANTABLE QUALITY OR FITNESS FOR A 
PARTICULAR PURPOSE, OR ANY WARRANTY OF TITLE OR NON-INFRINGEMENT, OR THAT THE WORK (OR ANY 
PORTION THEREOF) IS CORRECT, USEFUL, BUG-FREE OR FREE OF VIRUSES. YOU MUST PASS THIS 
DISCLAIMER ON WHENEVER YOU DISTRIBUTE THE WORK OR DERIVATIVE WORKS. 

This product includes software developed by Erwin Tratar. This source code and all accompanying material is copyright (c) 1998-
1999 Erwin Tratar. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT EXPRESS OR IMPLIED WARRANTY. USE IT AT YOUR OWN 
RISK! THE AUTHOR ACCEPTS NO LIABILITY FOR ANY DAMAGE/LOSS OF BUSINESS THAT THIS PRODUCT MAY 



CAUSE.

This product includes software developed by Sam Leffler of Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM 
LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY 
THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

This product includes software developed by Guy Eric Schalnat, Andreas Dilger, Glenn Randers-Pehrson (current maintainer), 
and others. (http://www.libpng.org)

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed 
or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing 
Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, 
which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage.

This product includes software components distributed by the Cryptix Foundation.

THIS SOFTWARE IS PROVIDED BY THE CRYPTIX FOUNDATION LIMITED AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
CRYPTIX FOUNDATION LIMITED OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE

Copyright © 1995-2005 The Cryptix Foundation Limited. All rights reserved.

This product includes software components distributed by Sun Microsystems.

This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, 
REPRESENTATIONS AND WARRANTIES, INCLUDING ANYIMPLIED WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN AND ITS 
LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, 
MODIFYING OR DISTRIBUTING THE SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS 
LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, 
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE 
THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SUN HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Copyright (c) 1998 Sun Microsystems, Inc. All Rights Reserved.

This product includes software components distributed by Dennis M. Sosnoski.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 



MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 2003-2007 Dennis M. Sosnoski. All Rights Reserved

It also includes materials licensed under Apache 1.1 and the following XPP3 license

THIS SOFTWARE IS PROVIDED "AS IS'" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 2002 Extreme! Lab, Indiana University. All Rights Reserved

This product includes software components distributed by CodeProject. This software contains material that is © 1994-2005 The 
Ultimate Toolbox, all rights reserved.

This product includes software components distributed by Geir Landro.

Copyright © 2001-2003 Geir Landro (drop@destroydrop.com) JavaScript Tree - www.destroydrop.com/hjavascripts/tree/version 
0.96

This product includes software components distributed by the Hypersonic SQL Group.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE

Copyright © 1995-2000 by the Hypersonic SQL Group. All Rights Reserved

This product includes software components distributed by the International Business Machines Corporation and others. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Copyright (c) 1995-2009 International Business Machines Corporation and others. All rights reserved. 



This product includes software components distributed by the University of Coimbra.

University of Coimbra distributes this software in the hope that it will be useful but DISCLAIMS ALL WARRANTIES WITH 
REGARD TO IT, including all implied warranties of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. In 
no event shall University of Coimbra be liable for any special, indirect or consequential damages (or any damages whatsoever) 
resulting from loss of use, data or profits, whether in an action of contract, negligence or other tortious action, arising out of or in 
connection with the use or performance of this software.

Copyright (c) 2000 University of Coimbra, Portugal. All Rights Reserved.

This product includes software components distributed by Steve Souza.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS'" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Copyright © 2002, Steve Souza (admin@jamonapi.com). All Rights Reserved.

This product includes software developed by the OpenSymphony Group (http://www.opensymphony.com/.)"

Copyright © 2001-2004 The OpenSymphony Group. All Rights Reserved.

PANTONE (R) Colors displayed in the software application or in the user documentation may not match PANTONE-identified 
standards. Consult current PANTONE Color Publications for accurate color. PANTONE(R) and other Pantone LLC trademarks 
are the property of Pantone LLC. (C) Pantone LLC, 2011.

Pantone LLC is the copyright owner of color data and/or software which are licensed to Oracle to distribute for use only in 
combination with Oracle Documaker. PANTONE Color Data and/or Software shall not be copied onto another disk or into 
memory unless part of the execution of Oracle Documaker.

This product includes software developed by Dave Gamble and distributed via SourceForge.net (http://sourceforge.net/projects/
cjson/)

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR  IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,  FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THEAUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Copyright (c) 2009 Dave Gamble

This product includes software developed by the Zxing  Project.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Copyright (c) 2013 Zxing Project (https://github.com/zxing/zxing)



This product includes software developed by the Wintertree software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

The Sentry Spelling-Checker Engine Copyright (c) 1993 Wintertree (https://wintertree-software.com/dev/ssce/windows/
index.html )

Freemarker Copyright (c) 2003 The Visigoth Software Society. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE VISIGOTH SOFTWARE SOCIETY OR ITS CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO,PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Visigoth Software Society. For more 
information on the Visigoth Software Society, please see http://www.visigoths.org/

Copyright (c) 2000,2002,2003 INRIA, France Telecom ( http://asm.ow2.org/) All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright© 2001-2016 ej-technologies GmbH (https://www.ej-technologies.com/products/install4j/overview.html) All rights 
reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



This component is distributed with the following third party components:  (1) Third party components licensed under EPL v1.0; 
(2) JARGS (Stephen Purcell); JDOM (Brett McLaughlin & Jason Hunter); and (3) ORO (Apache Software Foundation).  Please 
see EPL v1.0 and applicable components (#2072, 2686, 2074) for restrictions/requirements.

Copyright 2001-2005 (C)  MetaStuff, Ltd.(http://www.dom4j.org ) All Rights Reserved.

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS "AS IS'' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL METASTUFF, LTD. OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE)ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

Little CMS Copyright (c) 1998-2011 (http://www.littlecms.com/) All Rights Reserved. 

 THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Marti Maria Saguer Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, 
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be 
included in all copies or substantial portions of the Software.

 Copyright (c) 2002-2007, Communications and Remote Sensing Laboratory, Universite catholique de Louvain (UCL), Belgium

Copyright (c) 2002-2007, Professor Benoit Macq

Copyright (c) 2001-2003, David Janssens

Copyright (c) 2002-2003, Yannick Verschueren

Copyright (c) 2003-2007, Francois-Olivier Devaux and Antonin Descampe

Copyright (c) 2005, Herve Drolon, FreeImage Team

All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



  

 Copyright (c) 2004-2013 QOS.ch (http://www.qos.ch/shop/index) All rights reserved.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files 
(the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do 
so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

  

The Code Project Open License (CPOL) 1.02 

Copyright © CodeProject, 1999-2016 (http://www.codeproject.com/info/cpol10.aspx) All Rights Reserved.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.

 

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper

Copyright (c) 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers (http://expat.sourceforge.net/) 

All Rights Reserved. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE.
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Chapter 1

INTRODUCTION

ABOUT THIS GUIDE
This guide provides the information you need to install and use the Control Panel, 
which gives you easy access to the tools you need to configure and coordinate the 
performance of Oracle products.

Here is a list of the other manuals that you might need to refer to when you work with 
the Control Panel.

• The Printcommander guide addresses using Printcommander to create device-
specific print data streams in the Windows NT environment.

• The Fontcommander guide addresses the use of Fontcommander to convert IBM 
AFP and Xerox Metacode fonts to Windows-compatible fonts.

WHAT IS THE CONTROL PANEL?
The Control Panel is a centralized hub that coordinates the operation and 
configuration of most Oracle products. As such, the Control Panel comprises several 
small applications, or "applets." This guide is arranged to discuss the operation of 
each applet in the order in which it’s displayed on the main window.

Use the Control Panel to perform many of the tasks required to configure and 
coordinate Oracle products.

Note When the UNIX operating system is mentioned, the term refers to Linux (Intel).

Note Please note that the images or screenshots that follow in the upcoming explanation of 
the topics may not resemble those as encountered in the actual installation, un-install or 
other related functions performed on the application.

To perform this task See

Object updating Using the Control Panel

Printer Definitions setup The Printer Definitions Object

Electronic Document Libraries maintenance (database-based) The Electronic Document Libraries 
object

Electronic Document Libraries maintenance (file-based) The File based EDL object

Production Definitions setup The Production Definitions object

Merge Definitions setup The Merge Definitions object

Documaker fp Job Submission The Documaker fp Job 
Submissions object

Output System Viewer The Output System Viewer Object
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System Requirements

The minimum hardware requirements to install and run the Control Panel are:

• 100%-compatible PC with a 486 microprocessor or faster (Pentium 
recommended)

• 25 MB of available hard drive space

• 16 MB of memory (32 MB and up recommended)

• Microsoft Windows 

• A high-capacity hard disk 

The minimum software requirements to install and run the Control Panel are:

• ODBC client for the following Windows databases:

• IBM DB2 5.0 or higher

• Microsoft SQL Server 6.5 for Windows or higher

• Oracle 8.1.7 or higher

• Sybase SQL AnyWhere 5.5 for Windows or higher

• Sybase 11.1 or higher

-or-

• Oracle 9.2 (Linux)

-or-

• Common Objects 11.3 (32-bit/64-bit version)

DOWNLOADING THE SOFTWARE
Control Panel application is available for download at the Oracle Software Delivery 
Cloud web site. 

The process of downloading software from OSDC includes following steps:

1. First, go to Oracle Software Delivery Cloud website.
http://edelivery.oracle.com/

2. Sign in with your Oracle account. If you do not have an Oracle account, you can 
register for an account here.

16- and 32-bit Database Definitions setup Using 16-bit database definitions

Printcommander NT Font Matching Table editor The Font Matching Table Editor 
Object

To perform this task See

http://edelivery.oracle.com
https://profile.oracle.com/myprofile/account/create-account.jspx?pid=edelivery&nexturl=https%3A//edelivery.oracle.com/osdc/faces/Home.jspx
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3. Search for the software by typing in the search bar and selecting it. For example 
enter 6.1.1.0.0 to search for the Oracle Documaker Docucreate products.

4. Select the platform from the 'Select platform' drop-down. 

5. The selected products are then listed under 'Download Queue'. Click the X 
(cross) which is adjacent to the product in case you want to remove individual 
files or click 'Remove All' in the lower left corner of the dialog if you want to 
remove all the listed items.

6. Click 'Continue' to proceed to next screen; you will see a list of the selected 
software for downloading.

7. Choose the individual software components for download and click 'Continue' if 
you wish to proceed or 'Return to Search' to review different software for 
downloading.

8. Read the license agreement carefully; mark the check box to agree with license 
agreements, and click 'Continue'.

9. Click 'Download' button to download the software or click the filename to 
individually download the files.

10. While you can save the file on any machine you choose, we recommend you 
save the file onto the machine where you plan to run it. You must unzip the file 
on the platform for which it was intended. The length of time it takes to 
download an application depends on the size of the download, your connection 
speed, and the amount of traffic on the site.

11. Once the Download has completed, click 'Return to Search' to search and 
download additional files or click 'Sign Out' to log off Oracle Software Delivery 
Cloud. 

INSTALLING THE CONTROL PANEL

To Install the Control Panel:

From the directory into which you downloaded the media pack, unzip the media 
pack. 

Click on the setup.exe located in Control Panels’ Disk1 directory.

...

The installation routine displays a window indicating the InstallShield Wizard’s 
progress, followed by the Welcome screen.
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12. Click on Next to continue with the installation or Cancel to quit the program.

The installation routine then displays the Choose Destination Location window, 
prompting you for the folder name/directory path into which you want to install 
the program.

13. Perform one of the following procedures:

14. Choose Next to continue with the installation if you haven’t already done so. 
You can also choose Back to return to the previous screen or Cancel to abort the 
routine.

The Select Program Folder window displays the folder where you will store the 
program files.

To Perform this action

Accept the default path the installation routine 
proposes

Choose Next.

Enter another path for the installation Click on Browse..., choose a new path, and then choose Next.

Note: The Destination Folder lists the last location to which the program was 
installed. If you’re re-installing the program to a different location, you should 
Cancel the routine, un-install the program from its previous location, and 
then install the program to the desired location.
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15. Perform one of the following procedures:

16. Choose Next to continue with the installation if you haven’t already done so. 
You can also choose Back to return to the previous screen or Cancel to abort the 
routine.

When the installation is complete, the Setup Complete window appears:

17. Choose Finish to complete the installation program and return to Windows.

To Perform this action

Accept the default program folder the installation 
routine proposes

Choose Next.

Select an existing folder for the installation Use the scroll bar to click on an existing folder; then choose Next.
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Chapter 2

USING THE CONTROL PANEL

NAVIGATING THE CONTROL PANEL
The Control Panel follows all Windows standards for launching, terminating, and 
otherwise manipulating icons and objects.

To Start the Control Panel

After you install the Control Panel in your Windows system, your Start menu 
Programs sub-menu shows the Docutoolbox folder.

• Click the Oracle Control Panel icon to display the Control Panel main window.

To Open an Object

You can use several methods to launch an object, involving single-, double-, and 
right-clicking on the object’s icon. 

• Double-click the appropriate icon in the main Control Panel window.

• Single-click the icon to highlight it, then choose Open from the File menu.

• Single-click the icon to highlight it, then choose the  (Open) icon from the 
Toolbar.
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• Right-click the icon, then choose Open from the pop-up menu

To Exit the Control Panel

• In the upper-right-hand corner of the Control Panel, click on the  (Close) 
button.

-or-

From the File menu, choose Close. 

The Control Panel closes and returns control to Windows.

CHANGING CONTROL PANEL APPLICATIONS 
(OBJECTS)
To keep your Control Panel up-to-date with the most recent versions of Oracle 
products, you can perform the following operations:

• Change the object application (drive/folder/filename) and caption for an 
object.

• Change the icon and icon description for an object.

• Add command line parameters to alter the behavior of an object.

Editing an Existing Control Panel Object

You can change the application path and caption of an object, as well as change the 
icon and icon description for an object in the Control Panel.

To Edit an Existing Control Panel Object

1. Single-click the object whose characteristics you want to change. This action 
highlights the object. 

2. From the File menu, choose Properties.

-or-

From the Toolbar, choose the  (Properties) icon.

Tip The Control Panel makes extensive use of pop-up menus, both here on the main 
window and in each of the individual object modules. Whenever possible, all menu 
options from the pull-down menus are replicated in the pop-up menus.



24

The Object Properties (edit) window appears.

3. Click an insertion point in the Object Application text box, and then perform 
one of the following:

4. Press TAB to reach the Object Icon text box, and then perform one of the 
following:

5. Press TAB to reach the Icon Description text box, and then type the description 
of the icon.

To edit Do this

The path for the Object Application Type the drive, folder, and file name of the object

The application to run instead of the 
current one

Choose Select a custom Application.

The Select an Application window appears.

Choose the desired application and click Open.

To use Do this

The default icon for the Object Ensure the Use a custom icon check box is unchecked.

A custom icon for the Object Select the Use a custom icon check box.

Choose Use a custom icon.

The Select a Custom Icon window appears.

Choose the desired icon and click Open.
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6. Press TAB to reach the Icon StatusBar Comments text box, and then type the 
description to be displayed in the status bar.

7. Choose OK to activate the changes. Otherwise, choose Cancel.

Tip If you need to activate a Merge or Production Definitions object without connecting to a database, you can add 
“space 1” (space followed by the number 1) as a command line argument after the executable file name in the 
Object Application text box (e.g., “C:\Oracle\DFXCPANL\MERGDEF.EXE 1”).
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Chapter 3

THE PRINTER DEFINITIONS OBJECT

Using Printer Definitions

The Control Panel - Printer Definitions object lets you define and update Print 
Definitions or virtual printers based on different configurations of the physical 
printers defined for your Windows environment. 

The Control Panel’s Print Definition is similar to the PRINTDEF PEDEF, which is 
required for IBM MVS or VSE versions of Documaker fp. You must specify an 
appropriate Print Definition before you can specify an Output Destination for a 
Production Definition.

To define or update a Print Definition, you must first start the Printer Definitions 
object.

Starting or Ending Printer Definitions

To Start Printer Setup

• In the Control Panel, double-click the  (Printer Definitions) icon.

The Printer Setup window displays.

Because you can use the Printer Setup window to add, modify, activate, rename, 
or delete a printer, this guide provides separate topics for these procedures.

To Go to

Add a printer (Print Definition) Adding A Printer 

Change the properties of a printer (Print Definition) Changing a Printer Definition 

Copying a printer Copying a Printer Definition 
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To Exit Printer Setup

From the File menu, choose Close.

-or-

In the upper-right-hand corner of the Printer Setup window, click on the  
(Close) button. 

Printer Setup closes and returns control to the Control Panel.

ADDING A PRINTER

The  (Add Resource) icon lets you specify a new virtual printer or Printer 
Definition. This type of definition contains printer control specifications and options 
for any of the following classes of printing resources: 

• Xerox Metacode

• IBM Advanced Function Presentation (AFP)

• Windows printers

• Printer Control Language (PCL)

• PostScript (PS)

• Rich Text Format (RTF)

• Adobe Portable Document Format (PDF)

• (PDF only writes PDF)

• (PDL reads and writes PDF)

• Portable Network Graphics (PNG)

• Microsoft PowerPoint Interface (PPT)

• Oracle Compound Document (OCD) data streams

To Add a New Printer

1. In the Printer Setup window, click on the  icon. 

Rename a printer Renaming a Printer Definition 

Delete a printer Deleting a Printer Definition 

Note The PDF and PDFL Printer Definition Languages are only available if you’re currently 
using Docupresentment.
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The Printer Setup - Add New window appears.

2. In the Name text box, type a name (up to 8 characters) for the virtual printer 
(Print Definition).

3. In the PDL drop-down list, select the name of a printer description language 
(i.e., print data stream) for the new printer.

4. If you chose any PDL other than Windows Print Driver, skip to Step 6..

5. In the Printer drop-down list, select the desired printer from the list of available 
Windows printers.

6. When you’ve completed the entries, click OK.

Print Setup saves the Print Definition with the name you specified, and then 
displays the Print Definition window.

Note If you’re using a Windows printer driver to print to a Xerox PostScript printer, choose 
Windows Print Driver. Then, select your destination printer from the Printer drop-down 
list.
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USING THE PRINT DEFINITION DIALOG AND TABS
The Print Definition window contains four tabs. You complete a Print Definition by 
specifying printing environment-related items in panels under these tabs.

To Use a Print Definition Tab

• Do any of the following:

To Close or Save the Printer Definitions Dialog

• Do one of the following: 

Using the Paper Tab

Use the first tab in the Print Definition window to specify

• Paper size and source, or custom sheet dimensions

• Portrait or Landscape page orientation

• None (simplex), Short Edge duplex (tumble), or Long Edge duplex print 
orientation

• The number of output copies

To Activate the Paper Panel

• If the Paper panel is not already showing in the Print Definition window, click 
on the Paper tab. 

To specify Go to this topic

Paper dimensions, processing, and handling 
options

Using the Paper Tab 

Processing options for Documaker fp and fonts Using the Setup Options Tab 

Printer device performance and configuration 
options

Using the Device Options Tab 

Advanced Options such as Xerox JDLs/DJDEs or 
AFP CopyGroups

Using the Advanced Options Tab 

To Do this

Apply the Printer Definition specifications you’ve provided without closing the 
window

Choose the Apply button.

Apply the specifications you’ve provided and return to the Printer Setup window Choose the OK button.

Return to the Printer Setup window without applying the specifications you’ve 
provided

Choose the Cancel button.
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The Paper panel displays.

Because the Paper panel contains several group boxes of specifications, this 
guide provides a separate topic for each group.

To Select the Paper Size and Source

1. Press TAB to reach the Paper Size and Source group box.

2. Select the correct paper size and source from the drop-down list box of tray 
definitions.

If the necessary paper size isn’t displayed, see To Specify the Tray Definition.

3. (PDFL only) Enable the Ignore Output Page Rotation check box if you want 
to display each page in a horizontal, right-reading fashion even if the document 
indicates that a page is rotated.

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.

If you need to specify Go to

Paper size and source To Select the Paper Size and Source 

Page orientation To Specify Page Orientation 

Simplex, duplex, or tumble 
printing

To Specify the Print Layout on the Page 

Closing or saving the Paper tab 
panel

To Close or Save the Printer Definitions Dialog 
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To Specify Page Orientation

1. Press TAB to reach the Orientation group box.

2. Choose one of the following:

• Portrait — displays the pages in a form in portrait orientation despite the 
presence of orientation comment records or landscape text.

• Landscape — displays the pages in a form in landscape orientation despite 
the presence of orientation comment records or portrait text.

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.

To Specify the Print Layout on the Page

1. Press TAB to reach the Duplex Printing group box.

2. Choose one of the following:

• None — forces printing on only one side of the page (e.g., Simplex).

• Short Edge — provides Duplex printing (front and back sides of the page) 
for portrait output or Tumble printing for landscape output.

• Long Edge — provides Duplex printing for landscape output or Tumble 
printing for portrait output.

• Allow mixed mode duplexing — provides the flexibility to dynamically 
switch between Duplex and Simplex mode, if possible. More specifically, if 
a sheet contains a printable front page, but a blank back page, the printer 
driver prints the page in Simplex mode. Then, the printer driver switches 
back to Duplex mode once a sheet with both a printable front and back is 
detected.

Note that the availability of this option depends on the printer you are 
defining. 

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.
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To Specify the Tray Definition

1. Choose the Tray Definition Setup button. 

The Tray Definitions window displays a list of tray definitions.

2. Do one of the following:

To Do this

Add a new tray definition to the list 1 Choose the Add button.

2 Type a new tray definition name.

3 Choose the OK button.

Edit an existing tray definition 1 Select the name of an existing tray definition from the list. The name 
displays

in the upper portion of the window.

2 Choose the Edit button.

-or-

Double-click on the tray definition.

Remove an existing tray definition 
from the list

1 Select the name of an existing tray definition from the list. The name 
displays

in the upper portion of the window.

2 Choose the Remove button.

3 Choose the Yes button in response to the confirmation message.

4 Choose the OK button to return to the Print Definition window.
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The Tray Listing window displays a list of trays within the tray definition.

3. Do one of the following:

Note Before you complete the following step, you need to know the names of the main and/
or auxiliary source paper trays for your printer. You can usually get these names from 
the Paper Source area of the printer setup window.

When specifying paper tray (cluster) names for Metacode printers, verify that cluster 
name is defined in the stock set in the JDE being used.

To Do this

Add a new tray to 
the list

1 Choose the Add button.

2 Type a new tray name or Cluster Name (the name or bin number assigned to the 
paper tray from which you want the printer to pull the paper).

3 Choose the OK button.

Edit an existing tray 1 Select the name of an existing tray from the list. The name of the tray displays 
beneath the Tray Definition name.

2 (Windows print driver for PostScript) If you’re using a Windows printer driver for a 
Xerox PostScript printer and you want to specify the tray (stock), enable the Insert 
PostScript media commands check box.

3 Choose the Edit button.
-or-
Double-click on the tray.

Change the name of 
an existing tray

1 Select the name of the Tray Definition.

2 Type a new Tray Definition name.

3 Choose the OK button.
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4. Enter the paper characteristics for your printer (see Using the Tray Dialog and 
Tabs).

5. If you’re ready to quit specifying paper settings, choose the OK button. Printer 
Setup returns you to the Tray Listing window.

6. If you want to continue specifying paper settings, repeat the procedure from Step 
3. Otherwise, choose the OK button. Print Definition returns you to the Tray 
Definitions window.

7. If you want to continue specifying tray definitions, repeat the procedure from 
Step 2. Otherwise, choose the OK button. Print Definition returns you to the 
Paper panel.

USING THE TRAY DIALOG AND TABS
The Tray window contains three tabs. You define a tray by specifying print -related 
items in panels under these tabs.

To Use a Tray Tab

• Do any of the following:

Using the Paper Tab

To Activate the Paper Panel

• If the Paper panel is not already showing in the Tray window, click on the Paper 
tab.

Remove an existing 
tray from the list

1 Select the name of an existing tray from the list. The name displays in the upper 
portion of the window.

2 Choose the Remove button.

3 Choose the Yes button in response to the confirmation message.

4 Choose the OK button to return to the Print Definition manager window.

To specify Go to this topic

The Tray name, number, and paper stock as defined on the printer. Using the Paper Tab 

Miscellaneous print options or AFP, Metacode, and PostScript 
printers

Using the Print Options Tab 

(AFP only) Front (Odd) and Back (Even) CopyGroup Overlays Using the CG Overlays Tab (AFP only) 

To Do this
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The Paper panel displays.

Note that the fields that you see on the Paper tab depend on the type of printer you 
are defining.

Because the Paper panel contains several specifications, this guide provides a 
separate topic for each.

Setting Applies to

Tray Name

Cluster Name

Copy Group Name

Metacode

AFP

All other PDLs

Tray Number All other PDLs

Paper Sizes

Paper List

Windows and PCL

All other PDLs

Paper Bin Windows and PCL

Custom Paper All PDLs except Windows and PCL

If you need to specify Go to

Tray Name
(Cluster Name/CopyGroup Name)

To Specify the Tray Name 

Tray Number To Specify the Tray Number 

Paper List (Paper Sizes) To Specify the Paper Stock 

Paper Bin To Specify the Paper Bin
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To Specify the Tray Name

• In the Tray Name (Cluster Name / Copy Group Name) text box, if the correct 
name isn’t already displayed, enter the name of the tray you’re defining (as 
established on the printer).

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.

To Specify the Tray Number

• In the Tray Number (Paper Bin) drop-down list box, use the mouse or arrow 
keys to select the number for the tray (as established on the printer).

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.

To Specify the Paper Stock

• In the Paper List (Paper Sizes) drop-down list box, use the mouse or arrow keys 
to choose a paper type or size.

If you chose User Defined from the list, see To Specify a Custom Paper Size.

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.

To Specify a Custom Paper Size

1. Choose User Defined from the Paper List drop-down list box.

2. Click the Custom Paper button.

The Paper Definition window appears.

IMPORTANT For some Metacode printing environments, use of newer FRMs requires an exact 
specification of paper size fields. For Documaker fp, you can specify exact values for the 
Dot Origin and Scan Origin that define the following paper sizes.
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3. Do the following:

4. If you’re ready to quit specifying paper settings, choose the OK button.

To Specify the Paper Bin

• In the Paper Bin drop-down list box, use the mouse or arrow keys to select the 
designation of the tray (as established on the printer).

If you want to close or save the Paper panel, go to To Close or Save the Printer 
Definitions Dialog.

Using the Print Options Tab

Use the second tab in the Tray window to specify

• Simplex or Duplex printing

• Tumble printing (AFP only)

• Paper Offsetting (AFP only)

• DJDE information (Metacode only)

Paper Size
Paper Width
(dots per inch)

Horizontal 
Location

Paper Height
(dots per inch) Vertical Location

8.5 — 11 2550 21 3300 100

8.5 — 14 2550 21 4200 0

17 — 11 5100 21 3300 100

A3 4962 21 3507 100

A4 2480 56 3508 46

B4 3036 21 4299 100

To choose Do this

A custom paper size for a non-Metacode printer

• -or-

a Metacode printer that doesn’t require exact 
specification of paper size fields.

1 In the Paper Width text box, type the value.

2 Press TAB to reach the Paper Length text box, then type the

value.

3 Click on either inches or millimeters as the unit of measure.

WARNING! Each Printer Definition references a particular Tray Definition. Since Documaker fp uses 
the first Tray Listing in a Tray Definition to establish sheet width, sheet length, and paper 
size, you should be careful when altering Tray Definitions.
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• Documaker fp User Options

• PostScript media commands (Windows print driver for PostScript only)

To Activate the Print Options Panel

• If the Print Options panel is not already showing in the Tray window, click on 
the Print Options tab.The Print Options panel displays.
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Because the Print Options panel contains several group boxes of specifications, 
this guide provides a separate topic for each group.

To Specify Simplex, Duplex, or Tumble Printing

• In the Printing group box, do one of the following: 

If you want to close or save the Print Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify Paper Offsetting (AFP only)

Paper Offsetting indicates whether the Copy Group being defined within this Tray 
Definition will offset the paper in the output bin.

• In the Paper Offsetting group box, click the Enable check box if paper 
offsetting is to occur. 

If you want to close or save the Print Options panel, go to To Close or Save the 
Printer Definitions Dialog.

If you need to specify Go to

Simplex, Duplex, or Tumble printing  To Specify Simplex, Duplex, or Tumble Printing

Paper Offsetting (AFP only) To Specify Paper Offsetting (AFP only) 

DJDE information (Metacode only) To Specify DJDE Information (Metacode only) 

Documaker fp User Options To Specify Documaker fp User Options 

PostScript media commands (Windows print driver for 
PostScript only)

To Specify PostScript Media Commands

Tip For Metacode and HP printers, these selections are only used as scoring criteria for the 
cross-matching of input trays to output trays. The Metacode environment does not 
determine whether a particular tray can print simplex or duplex, based on this 
parameter.

For AFP printers, these selections indicates how the Copy Group being defined within 
this Tray Definition will handle the print stream.

To specify Do this

Printing on only one side (front) of the page Select the Simplex Printing option button.

Printing on both sides of the page Select the Duplex Printing option button.

Printing head-to-toe (AFP only) Select the Tumble Printing option button.
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To Specify DJDE Information (Metacode only)

• In the Metacode Options group box, do one or more of the following: 

If you want to close or save the Print Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify Documaker fp User Options

• In the Documaker fp User Options group box, use the mouse to enable any 
combination of User options by clicking on the respective check boxes. 

You can use the Clear button to clear all Documaker fp User Options choices.

If you want to close or save the Print Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify PostScript Media Commands

The PostScript Media Commands allow you to specify the settings that create a 
PostScript print stream which can use different paper stocks from multiple sources 
on Xerox DocuTech & DocuPrint printers.

Using Xerox’s DocuPrint Print Service, the SetTray command defines the types of 
paper stock loaded in the available paper bins (trays). The SetTray command defines 
the current paper properties:

SetTray  n  Size:Type:Color:Weight

where:

Tip The JDL and JDE values are only used if you selected Allow JDE to change on the 
Advanced Options tab.

To specify Do this

A default JDL In the JDL Name text box, enter a new string value.

A default JDE In the JDE Name text box, enter a new string value.

A default Low Horizontal Pel In the Low Horizontal Pel text box, enter an exact location 
measurement.

A default Low Vertical Pel In the Low Vertical Pel text box, enter an exact location 
measurement.

Tip For Metacode and HP printers, these selections are used when you’re processing AFP 
input forms and generating another type of output print stream. These selections match 
the User Options (Copy Groups) in the VRF to the appropriate output tray.

For AFP printers, the USR# specified in the Rulebase is matched to the User number 
selected for this Copy Group by Documaker fp.

n the Tray number (e.g., 1)

Size the dimensions of the stock in the Tray (e.g., USLetter)

Type the type of stock (e.g., Plain, CoverStock)

Color the color of the stock (e.g., White, Yellow)

Weight the weight of the stock (e.g., 75)
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In the following commands, you should type in, or select from the drop-down list, 
the name that matches the corresponding SetTray parameter on your printer. The 
default value is either (None) or a blank.

•  In the PostScript Media Commands group box, do one or more of the 
following: 

If you want to close or save the Print Options panel, go to To Close or Save the 
Printer Definitions Dialog.

Using the CG Overlays Tab (AFP only)

Use the third tab in the Tray window to specify

• Front page CopyGroup Overlay (Odd)

• Back page CopyGroup Overlay (Even)

To Activate the CG Overlays Panel

• If the CG Overlays panel is not already showing in the Tray window, click on 
the CG Overlays tab. 

To specify the Do this

Media type In the Media Type combo box, type or select the name that matches the tray 
designation on your printer.

Media color In the Media Color combo box, type or select the name that matches the tray 
designation on your printer.

Media weight In the Media Weight text box, type the number that matches the tray designation 
on your printer.
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The CG Overlays panel displays.

The CopyGroup Overlays specified here represent the Overlays that a Copy 
Group pulls from an AFP resource library. If the AFP forms entering Documaker 
fp contain a Copy Group referencing Overlays and the Documaker fp output 
print stream isn’t AFP, you should enter the names of the Overlays referenced 
by that CopyGroup.

To Specify CopyGroup Overlays

• In either the Front page CopyGroup Overlay or Back page CopyGroup 
Overlay group boxes, do one of the following: 

To Do this

Add a new CopyGroup Overlay name 
to the list

1 Choose the Add button.

2 Type a new CopyGroup Overlay name.

3 Choose the OK button.

Edit an existing CopyGroup Overlay 1 Highlight the name of an existing CopyGroup Overlay from the list.

2 Choose the Edit button.

-or-

Double-click on the name.

3 Enter the modified name.
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If you want to close or save the CG Overlays panel, go to To Close or Save the 
Printer Definitions Dialog.

Using the Setup Options Tab

You can use the second tab in the Print Definition window to

• Specify Documaker fp normalization options

• Optimize lines and shading for smaller output

• Define a Logical page bottom for output that uses concatenated forms

• Specify the default chain name from the EDL

• Specify the preferred filename extension

• Indicate whether to use this print definition as an input PrintDef to 
Documaker fp

• Choose the appropriate in-line forms settings

• Specify a font section name for the Font Section

• Designate the current Common Font list for your setup

• Specify a font substitution table

• Select a directory containing printer font metrics (PFMs) for your device 
fonts

• Generate PFMs to match a screen font with a device font

To Activate the Setup Options Panel

• If the Setup Options panel is not already showing in the Print Definition window, 
click on the Setup Options tab. 

The Setup Options panel displays

Remove an existing CopyGroup 
Overlay from the list

1 Highlight the name of an existing CopyGroup Overlay from the list.

2 Choose the Remove button.

3 Choose the Yes button in response to the confirmation message.
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Because the Setup Options panel contains more than one group box of 
specifications, this guide provides a separate topic for each group.

If you need to See

Specify Documaker fp normalization To Specify Documaker fp Normalization

To rotate the text and graphics by 180 degrees.  Some 
specialized Documerge applic ations make use of this 
upsidedown printing.

To Specify Inverse Orientation

Specify lines and shading reductions To Specify Lines and Shading Reduction

Define the logical page bottom for printed output To Define the Logical Page Bottom

Specify the default chain name from the EDL To Specify the Default Chain Name

Specify the preferred extension of the output file To Specify the Preferred Filename Extension

Indicate whether to use this print definition as an input 
print definition

To Indicate the Input Definition Status

Choose the appropriate in-line form settings To Choose In-line Form Settings

Specify the common Font Section To Specify a Font Section Name

Select the current Common Fonts list To Choose the Common Fonts (Metacode, DCD, DTF)

(Printcommander)
Specify the location of the Font Matching Table

To Select a Font Table
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To Specify Documaker fp Normalization

• Select the Normalization check box to invoke Documaker fp normalization 
routines.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify Inverse Orientation

Select the Inverse Orientation checkbox if upside down metacode output is desired.   

To Specify Lines and Shading Reduction

Using lines and shading in your text can greatly enhance the readability of the 
document, but they also greatly enhance the file size, too. The Control Panel can take 
the vertical and horizontal line segments and attempt to reduce their numbers, 
thereby reducing the file size. The same procedure is applied to shading line 
segments.

• Select the Optimize Vert / Horiz lines and shading check box if you want the 
Control Panel to attempt to reduce the number of horizontal, vertical, and 
shading line segments.

(Printcommander)
Specify the location of the PFM directory

To Specify the PFM Directory

(Printcommander)
Generate PFM equivalent fonts for scalable fonts

To Generate Printer Font Metric (PFM) Files

(Printcommander)
Display the default device fonts

To View the Default Device Fonts

Close or save the Setup Options panel To Close or Save the Printer Definitions Dialog

If you need to See

Note If the Normalization check box is not checked, Documaker fp prints the document 
without invoking normalization routines.

Tip If normalization is enabled for a Metacode Printer Definition, the Font Section text box 
displays the name of the current Common Font list.

If normalization is disabled for a Metacode Printer Definition, the Font Section text box 
displays Metacode Printer,FILE:.
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If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Define the Logical Page Bottom

• (AFP, Metacode, DCD, EMF only) In the Logical Page Bottom group box, do 
one of the following:

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify the Default Chain Name

• In the Default Chain drop-down list box, select the appropriate default chain 
name for this printer definition. This chain name should represent the correct 
chains which will be retrieved from the EDL. 

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify the Preferred Filename Extension

• In the Preferred Extension text box, type the appropriate filename extension for 
output from this printer definition (e.g., file_name.extension).

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

Note Automatic is the default Logical Page Bottom setting. Use Manual only when the 
document contains concatenated forms or has Rulebase structure table overlays.

To Do this

Set the logical page bottom to the location 
of the lowest text or rule on the page

Under Logical Page Bottom, choose the Automatic option button.

TIP: The logical height specifies the height of all the forms that can fit on the page, 
whereas the physical height is the actual page height dimension (e.g., 11”, 14”). If 
forms don’t fill the entire physical page, the logical page bottom is above the 
physical page bottom.

Manually specify the logical page bottom 1 Under Logical Page Bottom, choose the Manual option button.

2 In the associated text box, enter an integer value, in inches, from the top

page margin to the bottom of the logical page.

Tip The correct default chain name should be displayed; however, you can always change 
the name, if necessary.
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To Indicate the Input Definition Status

• (N/A for PostScript, PowerPoint, or PDF) In the Input Definition group box, 
highlight the appropriate check box(es) to enable the feature. Depending on your 
situation, you may have one, both, or neither option(s) selected. 

• Standard — indicates that this printer definition (PrintDef) is the Standard 
Input data stream.

• In-Line — designates that you use in-line forms in your Documaker fp 
processing.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Choose In-line Form Settings

1. In the Documaker fp In-line Form Settings group box, select the Enable font 
indexing check box to enable the feature. 

The Font Indexing option specifies the particular column in the print data stream 
record where the font index byte is located.

2. Do one of the following:

3. In the Font index bits per byte text box, type the number of bits of the font 
index byte occupied by the font index.

4. In the Font index Offset text box, type the Offset value, from the beginning of 
each record, to the font index byte.

5. (Xerox Metacode only) In the Starting Horizontal Location text box, type an 
integer value representing the exact dot measurement. For more information, see 
To Specify a Custom Paper Size.

6. (Xerox Metacode only) In the Starting Vertical Location text box, type an 
integer value representing the exact dot measurement. For more information, see 
To Specify a Custom Paper Size.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

Tip For Documaker fp purposes, you should specify one printer definition, or PrintDef, as the 
Standard Input Definition by enabling the Standard check box (i.e., you should inform 
Control Panel which data stream should be considered the Standard Input data stream). 
This is the case regardless of whether the input and output data streams are of the same 
type (e.g., Metacode input to AFP output, AFP input to PCL output). Indicating a 
Standard Input data stream advises the Common Object PDL as to the type of print data 
stream being read (or input).

WARNING! You should only enable the In-Line check box if you use in-line forms.

If the first font in the font list is 
labeled as Do this

Font0 Select the Font Indexes relative to Zero option button.

Font1 Select the Font Indexes relative to One option button.
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To Specify a Font Section Name

• In the Font Section text box, type the name of the section in the ISI.INI file that 
contains the printer fonts. 

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Choose the Common Fonts (Metacode, DCD, DTF)

In the Setup Options panel, the Common Fonts combo box shows any Common 
Fonts that were created by Font Manager and is the Common Fonts entry in the 
ISI.INI file.

• In the Common Fonts drop-down list box, select the desired font you want to 
designate the Common Font.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Select a Font Table

1. (N/A for PostScript, PDF, and PNG) If not already checked, select the 
Generate PFMs check box.

-or-

Specify a PFM directory (see To Specify the PFM Directory).

2. Do any of the following:

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Specify the PFM Directory

The PFM directory is the repository for the Printer Font Metrics files (PFMs) that are 
referenced in the font table.

Tip If normalization is enabled for a Metacode Printer Definition, the Font Section text box 
displays the name of the current Common Fonts list.

If normalization is disabled for a Metacode Printer Definition, the Font Section text box 
displays Metacode Printer,FILE:.

To Do this

Specify the location of a font matching 
table

In the Font Table text box, type the directory path and file name of the font table 
file.

-or-
Click Browse and navigate the selection dialog to locate a font table.

Edit an existing font table Click Configure to launch the Font Matching Table Editor. For more information, 
see The Font Matching Table Editor Object.

Tip The PFM Directory text box and the Generate PFMs check box are mutually exclusive, 
meaning you can’t select both at the same time. This feature allows the use of PFM files 
on disk.
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• (N/A for PostScript, PDF, and PNG) In the PFM Directory text box, type the 
directory path of the PFM directory.

-or-

Click Browse and navigate the selection dialog to locate the proper directory.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To Generate Printer Font Metric (PFM) Files

(N/A for PostScript, PDF, and PNG) In general, mainframe printers, such as IBM 
AFP and Xerox Metacode, use printer-specific fonts, called device fonts. Windows, 
on the other hand, only uses scalable fonts, such as TrueType or ATM Type 1. The 
Generate PFMs feature creates in-memory PFMs on-the-fly in order to match a 
device font to a scalable one.

When you enable the Generate PFMs feature, the application that uses the PrintDef, 
such as Documaker fp, builds Printer Font Metrics files (PFMs) dynamically, based 
on the scalable (e.g., TrueType) fonts you’re using. Please note that this method 
could result in incorrect printing if the font metrics of the scalable font(s) don’t 
exactly match the metrics of the corresponding device font(s).

• Enable the Generate PFMs check box if you want to dynamically create PFMs; 
otherwise, leave the check box blank.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

To View the Default Device Fonts

The Default Device button displays a list of default fonts (in all orientations) to be 
substituted if a device font match can’t be found in the Font Matching Table.

1. Click Default Device to display the list.

Tip The Generate PFMs check box and the PFM Directory text box are mutually exclusive, meaning you 
can’t select both at the same time.

Example Suppose Documaker fp, which reads composed data streams (e.g., AFP or Metacode), 
uses a given PrintDef as its Input Printdef. If the 'PFM Directory' and 'Font Table' entries 
on the Setup Options tab are populated, then Documaker fp expects that the device 
fonts within the AFP or Metacode document(s) have corresponding PFM files on disk in 
the 'PFM Directory'. Furthermore, Documaker fp also expects the names of the PFMs to 
exactly match the device font names within the incoming AFP or Metacode data stream.
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The Default Device PFM window appears.

2. In the text box, make any necessary changes to the list of displayed font names.

3. Click OK to save the PFMs; otherwise, click Cancel to exit without saving.

If you want to close or save the Setup Options panel, go to To Close or Save the 
Printer Definitions Dialog.

Using the Device Options Tab

You can use the third tab in the Print Definition window to specify

• A color printing environment

• The dots per inch printing resolution

• The method for printing graphical output

• The color printing options

• (AFP only) The format for output data

• (DCD only) Whether to embed printing resources

• The locations of all the forms

To Activate the Device Options Panel

• If the Device Options tab panel is not already showing in the Print Definition 
window, click on the Device Options tab. 
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The Device Options panel displays.

Because the Device Options panel contains several group boxes of 
specifications, this guide provides a separate topic for each group.

To Specify the Printing Resolution

• In the Resolution (dpi) drop-down list box, use the mouse keys or arrow to 
select the desired printing resolution.

If you need to specify Go to

A printing resolution To Specify the Printing Resolution

How to print graphics To Specify Graphics Printing Capabilities

Color printing options To Specify Color Printing Options

(AFP) Record or stream output formats To Specify the Output File Data Format for AFP Printers

(DCD) Whether to embed printer 
resources

To Embed Printer Resources for DCD Printers

Documanage options for Docuflex Studio 
(Renditions)

To Specify Documanage Options

The location of all necessary printer 
resources

To Specify the Location of Printer Resources

Closing or saving the Device Options panel To Close or Save the Printer Definitions Dialog

WARNING! If it is an AFP printer, you can specify the 300 or 480 DPI resolution only if the printer 
supports one of these resolutions.

If it is a Metacode printer, you can select the 600 DPI resolution only if the printer 
supports this resolution.
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If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Graphics Printing Capabilities

1. In the Graphics group box, do one of the following:

2. Click the Draw lines with printer commands check box for routine printing or 
leave the check box cleared when the document makes extensive use of lines and 
shading. When checked, Printcommander uses printer commands to generate 
lines, boxes, and shading instead of using graphic images. The result is faster 
printing speeds and smaller output files.

3. (PCL only) Click the Compress Graphics check box if you want 
Printcommander to reduce the size of any graphics present in the print data 
stream. By compressing the graphics in your data stream, you reduce the time 
necessary for transferring the data stream to another location or application.

4. (AFP only) Click the Scale to fit Output check box if you want IBM’s 
InfoPrintManager to scale images to fit the resolution of the output printer (e.g., 
scaling upward a 300 dpi image destined for a 600 dpi printer).

5. (AFP only) Click the drop-down arrow beside Minimum Line Thickness to 
force lines to conform to a minimum thickness, in pels, for AFP output (e.g., 0 
to 5, with 5 being the thickest).

If Do this

Your data stream only contains text or your 
printer doesn’t support graphics

Select None.

Your data stream contains both text and 
graphics

Select Graphics Enabled.

Depending on the contents of your document, Printcommander takes advantage 
of a combination of printer fonts, printer commands for drawing lines (if the option 
is enabled), and graphic images. In most cases, the document prints faster and 
requires less storage space than if it were a single graphic image.

You want Printcommander to treat your 
print stream as graphics only, meaning it 
contains no text

Select Graphics Only.

The entire document is processed as a single graphic image.

TIP: If you select either None or Graphics Enabled, all converted fonts, 
signature fonts, and logo fonts display in your application’s font list.

Note This option is only available if you’ve selected Graphics Enabled.
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6. (PDF and PostScript only) In the Bitmap resolution text box, type the 
resolution of the graphical output comparable with the target printer.

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Color Printing Options

• In the Color Options group box, do one of the following:

To Activate Color Printing

1. Select the Color Enabled check box.

2. For the Highlight Color, choose one of the following colors from the drop-down 
list box:

• Red

• Blue

• Green

3. If you then need to match the Highlight Color name stored in the Control Panel 
with the InkColor setting on your printer, click the color box next to the 
Highlight Color drop-down list box.

a. The Change the Color Name window appears.

b. Type the InkColor name you want to assign to this color, and then click 
OK.

c. The displayed name of the color is changed and you’re returned to the 
Device Options panel.

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

If you’re printing in a See:

color environment To Activate Color Printing

monochrome
(black-and-white) environment

To Activate Monochrome Printing

Note Docuflex prints all non-black text and graphics with the highlight color you specify for this 
option. If you don’t specify a color, Docuflex defaults to BLUE.
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To Activate Monochrome Printing

• Do any of the following:

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify the Output File Data Format for AFP Printers

• In the Output File Type group box, do one of the following:

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Embed Printer Resources for DCD Printers

• In the Resources group box, enable the Embed Resources check box.

For more information about the embedding printer resources feature, see the 
Docuflex User Guide.

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Documanage Options

The Control Panel plays an important role in effecting Renditions for Docuflex 
composition. If the output Printer Definition contains a value for the Rendition key, 
the Docuflex composition engine can use both the Rendition Set and Rendition Key 
from Documanage to include the proper document in the Docuflex output 
printstream.

• In the Documanage group box, do one of the following:

Tip You can specify that this printer definition should print in monochrome, even if you’re 
producing output to a color printer.

If you Do this:

have color images that you want to render, or convert, to monochrome Click Color Rendering.

want any text to print in color (AFP only) Click Color Text.

If Do this

The Documaker fp output needs to be sent to a channel-attached AFP printer in a blocked 
data stream

Choose Data Record.

The printer uses the OS/2 or RS/6000 Print Services Facility (PSF/2 or PSF/6000) and 
Documaker fp output needs to be sent to a PC- or UNIX-attached AFP printer in an 
unblocked data stream

Choose Data Stream.

If you want to Do this:

(Not available for DCD)
Enable the Renditions feature in Docuflex 
and Documanage

1 In the Rendition key text box, type the RenditionKey value that you entered 
in Documanage.

2 Check Use renditions when producing output.
Note: The value you type here must match a RenditionKey in Documanage for 
the feature to work.
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For more information about using Renditions in Documanage and Docuflex, see 
the Docuflex documentation.

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify the Location of Printer Resources

• In the Printer Resource Location group box, do any of the following:

If you want to close or save the Device Options panel, go to To Close or Save 
the Printer Definitions Dialog.

Using the Advanced Options Tab

You can use the fourth tab in the Print Definition window to define advanced Printer 
Setup specifications such as AFP CopyGroups or Metacode DJDE identifiers. 

To Activate the Advanced Options Panel

1. If the Advanced Options panel is not already showing in the Print Definition 
window, click on the Advanced Options tab. 

Because the Control Panel changes the Setup options available in the Advanced 
Options panel to those required for the printer description language (PDL) you 
chose in step 3 of To Add a New Printer, this guide provides a separate topic for 
each of these PDLs.

(DCD only)
Enable historical Renditions

• Check the Retain rendition names when generating DCD box.

Docuflex acquires the current renditions of documents at the time of project 
composition and saves the information as a token in the DCD file.

If you want to Do this:

If you’re print data stream is Do this:

AFP
• -and-

you’re specifying where the AFP Overlays (.OVL) are 
stored

In the Overlay Directory text box, type the drive letter 
and directory containing the Overlays.
• -or-

Click Browse.

AFP
• -and-

you’re specifying where the AFP Page Segments 
(.PSG) are stored

In the Page Segment Directory text box, type the drive 
letter and directory containing the Page Segments.
• -or-

Click Browse.

Metacode or DCD
• -and-

you’re specifying where the Metacode Forms (.FRM) 
are stored

In the Forms Directory text box, type the drive letter 
and directory containing the Forms.
• -or-

Click Browse.

Metacode or DCD
• -and-

you’re specifying where the Metacode Images (.IMG) 
are stored

In the Images Directory text box, type the drive letter 
and directory containing the Images.
• -or-

Click Browse.
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2. Do one of the following:

To Specify Advanced Options for an AFP Print Definition

Following is an illustration of the Advanced Options panel for the AFP PDL. 

1. Enter as many of the following CopyGroup names (not to exceed eight 
characters each) as required for your AFP environment:

If you specified this PDL Go to:

IBM Advanced Function Presentation 
(AFP)

To Specify Advanced Options for an AFP Print Definition

Xerox Metacode To Specify Advanced Options for a Metacode Print Definition

Windows Print Driver To Specify Advanced Options for a Windows Printer

Printer Control Language (PCL) 
Printer

To Specify Advanced Options for a PCL Printer

PostScript To Specify Advanced Options for PostScript Output

RTF To Specify Advanced Options for RTF Output

PDF To Specify Advanced Options for PDF Output

PNG To Specify Advanced Options for PNG Output

PowerPoint To Specify Advanced Options for PowerPoint Output

To specify the CopyGroup to Enter its name in this text box

Define the auxiliary paper tray to the printer Aux Bin (Feeding)

Stagger documents for separation in the printer’s output bin Paper Offsetting

Enable both sides of a page to be printed so that it can be bound along its 
shorter edge

Tumble
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2. If you want one of the five Rulebase User CopyGroups to be the current 
CopyGroup, choose the option button for that User (1 – 5).

3. Do one of the following:

4. If your printer is set up to print G.O.C.A. images, click the G.O.C.A. capable 
check box.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Advanced Options for a Metacode Print Definition

Following is an illustration of the Advanced Options panel for the Metacode PDL.

Because the Advanced Options panel contains more than one group box of 
specifications, this guide provides a separate topic for each group.

Provide a combination of printing functions for a particular application as 
defined in your Rulebase

Rulebase User 1, 2, 3, 4, or 5

To specify the CopyGroup to Enter its name in this text box

If your printer can print Do this:

Image Raster data Click the Image Raster data check box.

I.O.C.A. Picture data Click the I.O.C.A. Picture data check box.

If you need to Go to

Define DJDE control card identifiers To Specify DJDE Control Card Identifiers

Specify horizontal and vertical printing offsets To Specify Printing Offsets 

Define special processing options such as allowing DJDEs to change, off-
line printing, additional DJDEs or fonts, and FRM requirements

To Define Special Processing Conditions 
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To Specify DJDE Control Card Identifiers

Control Card Identifiers control printing or screen formatting functions such as

• JDE start and end identifiers for form printing and screen formatting (DJDE ID 
and RSTACK).

• Paper positioning and handling identifiers for printed output (RAUX, ROFF, 
RPAGE).

Additionally, you can change the following Control Card Identifier formatting 
options:

• The data format (ASCII, EBCDIC, or Hex coding scheme). For example, DJDE 
ID and RSTACK values are typically EBCDIC formatted, while RAUX, ROFF, 
and RPAGE values are Hex formatted.

• The character string starting position (Offset). For example, a default Offset zero 
value indicates that the Control Card Identifier starts in column 1. Whereas an 
Offset value of 8 would indicate that it starts in column 9.

1. Type the Job Descriptor Library and Job Descriptor Entry names for which 
you’re specifying settings.

2. Change as many of the following as required:

Close or save the Advanced Options panel To Close or Save the Printer Definitions Dialog 

If you need to Go to

WARNING! You should only change the default DJDE values if one of the following conditions 
occurs:

• The Metacode printer you use requires Job Descriptor Entries which differ from the 
Xerox defaults.

• Different values are required to control the screen formatting of a particular form.

All values you enter must show as upper-case (capital) characters. If you are uncertain 
about how to change DJDE values, coding schemes, or offsets; please consult your 
system administrator or resident Xerox specialist.

If you need to change the Click an insertion point in the And then enter the new

DJDE identifier (ID) DJDE ID text box DJDE identifier

RSTACK character string that indicates the end of the JDE RSTACK text box End of JDE character string

RAUX character string that indicates the auxiliary paper tray 
to use

RAUX text box Auxiliary paper tray identifier

ROFF character string that activates page offsets for collating 
document sections in the printer output bin

ROFF text box Character string for the number of 
collating offsets

RPAGE character string used to request that a new DJE 
begins duplex printing on a right-hand page

RPAGE text box Starting page-face specification

WARNING! The data format you specify for each of the Control Card Identifiers must match the one 
used by your Metacode printer. If you are uncertain about which data format to select, 
please consult your system administrator or resident Xerox specialist.
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3. To change the data format for a Control Card Identifier, select the corresponding 
ASCII or EBCDIC, or Hex option button.

4. To change the starting position offset for a Control Card Identifier, click an 
insertion point in the corresponding Offset text box, and then type the new 
Offset value.

5. To change the starting position of DJDEs (for example, font references) in the 
Metacode print stream, click an insertion point in the Skip text box, and then 
type the new Skip value.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Printing Offsets

1. In the Low Horizontal Pel text box, type the starting printing position of your 
data, relative to the left margin of the page (i.e., the lower, left-hand corner of a 
portrait page).

2. In the Low Vertical Pel text box, type the starting printing position of your data, 
relative to the bottom margin of the page (i.e., the lower, left-hand corner of a 
portrait page).

3. In the Data record length text box, type the maximum length of the data record 
containing the In-line Form text.

4. In the Data record offset text box, type the offset value to the beginning of the 
print data.

To Define Special Processing Conditions

1. Do any of the following: 

2. If you need to specify a Common Fonts list or additional DJDE commands, 
choose the DJDE Setup command button.

Tip For more information on entering dots-per-inch measurements, see To Specify a 
Custom Paper Size.

To specify that Do this

The JDEs in the data streams of your forms can change as they print Select the Allow JDE to change 
check box.

Graphics in on-line format be converted to the format required for printing 
off-line

Select the Off-line Print 
Environment check box.

FORMS= — statements be replaced with
FORMS= NONE statements so that FRMs (Metacode print objects) won’t 
carry over on succeeding forms

Select the FRMs apply to only one 
form check box.
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The Control Panel - Initial DJDE Parameters window appears. 

Do any of the following:

3. Click the Use Additional DJDEs Once check box if you only want to use 
additional DJDE parameters once.

4. To keep your entries, choose the OK button. Otherwise, choose the Cancel 
button.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To specify Do this

The format of the initial DJDE 
packet

In the First DJDE packet group box, choose either the EBCDIC or ASCII option 
button.

A Common Fonts List In the Fonts text box, enter the font name(s) separated by commas.

Any additional DJDE 
commands

In the Additional DJDE Parameters text box, enter the set of DJDE printer 
control commands (that is, DJDE packet).
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To Specify Advanced Options for a Windows Printer

Following is an illustration of the Advanced Options panel for the Windows printer 
PDL.

1. Enable the check box if you want this printer definition to read printer settings 
from the Windows Control Panel (e.g., Start/Settings/Printers).

2. If you want to change the source printer for this printer definition, choose a 
different printer in the drop-down list box.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.



62

To Specify Advanced Options for a PCL Printer

Following is an illustration of the Advanced Options panel for the PCL printer PDL.

The "Un-Printable Area" is necessary when you’re using edge-to-edge-capable print 
stream forms, such as AFP or Metacode, as input and sending them to a non-edge-
to-edge printer, such as a laser printer.

1. In the Left, Top, Right, and Bottom text boxes, type the decimal measurement 
of the margin (from the edge of the paper) that is considered off-limits to the 
printer. Some laser printers can not print within one-quarter inch of the edge of 
the paper. If this is the case, you should type 0.25 in each box.

2. In the Units group box, select the option button of the unit of measurement for 
your margin measurements.

3. In the Input Options group box, click the drop-down arrow beside the Internal 
Resolution to choose the appropriate DPI measurement.

4. In the Lines per page, if the page size is not the standard size then enter the 
number of lines per page. The default is 60.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.
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To Specify Advanced Options for PostScript Output

Following is an illustration of the Advanced Options panel for the PostScript PDL.

1. In the Printer Type group box, specify the printer manufacturer’s name and 
model number.

2. In the Font Settings group box, enable the Embed Type 1 fonts check box if 
you want to use Type1 fonts when device fonts are missing or mismatched.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.
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To Specify Advanced Options for RTF Output

Following is an illustration of he Advanced Options panel for the RTF PDL.

1. In the Input Options group box, click the Process Mosaic Fields for Docuflex 
input check box if you want to convert Mosaic fields to Docuflex variable space 
definition (VSD) tags.

2. Click the Include Hidden Text check box if you want to include hidden text 
within RTF files imported into Docuflex.

3. The Exclude External Leading check box specifies whether to exclude the 
extra line spacing (leading) necessary to coincide with the leading that Microsoft 
Word uses—this method is disabled by default, meaning that Docuflex includes 
extra leading between rows of formatted text within a paragraph. When you 
enable this option, extra leading is not included between the rows of text within 
a paragraph and won’t match Word.

4. The Ignore Columns check box specifies whether to ignore column commands 
while reading RTF—this option is enabled by default. This option allows 
Docuflex to take an RTF document and format it into a multiple-column Page 
Frame.

When you disable the option, the incoming RTF document is built with a 
mixture of single- and multiple-columns. This action requires that the RTF be 
read into a single-column frame which then displays as multiple-column when 
necessary.

5. In the Page Margins group box, click the Ignore All Page Margins check box 
if you want to ignore ALL margins on the page.

-or-

Click one or more check boxes of the specific margins you want to ignore.
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6. In the Output Options group box, click the Zoom Percent drop-down arrow to 
specify the magnification you want to use when viewing an RTF file.

7. The Allow output to flow as much as possible check box specifies whether you 
want the document contents in the RTF to expand or contract as you edit the 
information—this option is enabled by default. If you disable this option, all 
document contents are absolutely positioned in text boxes to provide high 
document fidelity; however, any editing you perform must fit within the allotted 
space.

8. The Output Hyperlinks in a blue underlined format check box specifies 
whether you want to generate hyperlinks in the RTF as blue and underlined (as 
they appear in Microsoft Word)—this option is enabled by default. If you disable 
this option, all hyperlinks appear as you formatted them in Docuflex.

These settings apply when you’re generating an RTF printstream from content 
provided by a Docucorp Compound Document (DCD) memory image. Listed 
below are some considerations of which you should be aware:

• All processing is done in color mode (i.e., Monochrome dithering is not 
supported).

• The emitted RTF printstream conforms to the Microsoft Office Word 2003 
Rich Text Format (RTF) Specification, Version 1.8, published April 2004. 
The emitted printstream displays correctly using MS Word 2003 (Office 
2003, or Word 11), and on earlier Word versions to the maximum practical 
extent.

• Supports only features available in DCD.

• The view presented by Word 2003 from a generated RTF printstream will 
match that in the Docuflex Studio Preview window exactly, or as closely as 
possible. Features offered in the Stylized Content Editor, as displayed in the 
Docuflex Studio Preview window, are also supported.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.
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To Specify Advanced Options for PDF Output

Following is an illustration of the Advanced Options panel for the PDFx PDLs.

Because the Advanced Options panel contains more than one group box of 
specifications, this guide provides a separate topic for each group.

To Enable Transparent Color Masks

1. Click the Use transparent bitmap color masks check box if you want to use 
transparency bitmap color for transparency RGBs.

2. In the Red, Green, and Blue text boxes, type the color values you want to use 
for the mask. The color is displayed in the box to the right. Valid values are from 
0 - 255, with 0 being black and 255 being white.

-or-

Click Browse to select a standard color.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

Note The PDF and PDFL Printer Definition Languages are only available if you’re currently 
using Docupresentment.

If you need to Go to

(PDF only) Specify the color for bitmap color masks To Enable Transparent Color Masks

Choose encryption options To Specify Encryption Options

Choose processing options To Specify Processing Options

Close or save the Advanced Options panel To Close or Save the Printer Definitions Dialog 
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To Specify Encryption Options

• In the Encryption group box, select any applicable special processing setting for 
use in creating the PDF output.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Processing Options

• In the Processing group box, select any applicable encryption settings for use in 
creating the PDFx output.

Option Meaning

Allow Printing Print the document (possibly not at the highest quality level, depending on 
whether Allow High Quality Printing is also set). Check to enable; leave blank 
to disable.

Allow Modifications Modify the contents of the document by operations other than those controlled by 
Allow Annotations, Allow Form Field Editing, and Allow Doc Reassembly. 
Check to enable; leave blank to disable.

Allow Copying Copy or otherwise extract text and graphics from the document by operations 
other than that controlled by Allow Accessibility Extensions. Check to enable; 
leave blank to disable.

Allow Annotations Add or modify text annotations, fill in interactive form fields, and, if Allow 
Modifications is also set, create or modify interactive form fields (including 
signature fields). Check to enable; leave blank to disable.

Allow Form Field Editing Fill in existing interactive form fields (including signature fields), even if Allow 
Annotations is disabled. Check to enable; leave blank to disable.

Allow Accessibility Extensions Extract text and graphics (in support of accessibility to users with disabilities or 
for other purposes). Check to enable; leave blank to disable.

Allow Doc Reassembly Assemble the document (insert, rotate, or delete pages and create bookmarks or 
thumbnail images), even if Allow Modifications is diabled. Check to enable; 
leave blank to disable.

Allow High Quality Printing Print the document to a representation from which a faithful digital copy of the 
PDF content could be generated. When this option is disabled (and Allow 
Printing is enabled), printing is limited to a low-level representation of the 
appearance, possibly of degraded quality. Check to enable; leave blank to 
disable.

Note: The preceding Allow... descriptions were derived from the Adobe PDF Reference, 5th Edition.

Option Meaning
Embed Fonts Whether to embed Type 1 fonts that are legally embeddable. 

(Information is embedded only for the characters that are actually used 
in the document.)  Check to enable; leave blank to disable.

Optimize for the Web Places all information needed for the display of the first page at the front 
of the PDF output file. (This option does not benefit single-page output.) 
Check to enable; leave blank to disable.

Re-Generate Brushes (PDF only) Brushes produced by the Windows GDI are usually at too 
small of a resolution for printed output. This option causes regeneration 
of the brushes so that the PDF output matches the screen’s display of 
brush-filled regions. Check to enable; leave blank to disable.
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If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

To Specify Advanced Options for PNG Output

Following is an illustration of the Advanced Options panel for the PNG PDL.

• Enable the Always use the internal resolution defined by the image check box 
to extract image resolution information from the image itself. This feature is 
turned off by default.

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

Auto Close (PDFL only) Auto Close indicates that a single output file will contain 
one or many individual PDF documents. When unchecked, the output 
will be one PDF file with one or more transactions. When checked, the 
output will be a series of single-transaction PDF documents in the same 
file.

Option Meaning
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To Specify Advanced Options for PowerPoint Output

Following is an illustration of the Advanced Options panel for the PowerPoint PDL.

The PowerPoint Interface printer definition creates a PowerPoint Presentation file 
(slideshow) from Docuflex output. You have the option of making the PowerPoint 
slides the same size as the output page from Docuflex or the standard PowerPoint 
slide size (10” W x 7” H).

You can also scale the output to make sure it fits on the slide. As a starting point, the 
slide area is based on the Docuflex output’s “internally-calculated value”—the page 
size converted into millimeters. A percentage of 100 means that the slide area is 
equal to the page size of the output. You can scale this value up or down to customize 
the fit.

Horizontal and vertical scaling change only the slide area, not the image size. If your 
output is cropped (cut off) at the right or bottom edges, you can increase the slide 
area to eliminate the problem.

1. In the PowerPoint Slide Size group box, do one of the following:

2. In the Horizontal Scale Factor text box, type the percentage representing the 
amount by which you want to alter the PowerPoint slide in relation to the  output. 
The default value of 97 results in a slide area that’s three percent narrower than 
the internally-calculated value.

If you want to produce PowerPoint slides as Do this

standard PowerPoint slide size
(10” W x 7” H)

Click Use the Standard slide size.

size of the Docuflex output page size Click Use the Page size to determine the slide size.
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3. In the Vertical Scale Factor text box, type the percentage representing the 
amount by which you want to alter the PowerPoint slide in relation to the  output. 
The default value of 104 results in a slide area that’s four percent taller than the 
internally-calculated value.

4. In the Output path for PowerPoint slides text box, type the fully-qualified path 
name where you want to store the files.

-or-

Click Browse to select the appropriate directory.

5. The Output each slide as an image check box specifies whether you want to 
generate a single EMF-based image for each slide. By default, this option is 
disabled so that each slide consists of actual PowerPoint elements (such as 
shapes, tables, and text boxes) that you can edit.

6. Enable the Preserve working files for debugging check box if you want to save 
individual EMF files of each slide in the presentation file. Each EMF file 
includes the path name, file name with an appended sequential digit, and an 
extension of .EMF (e.g., slides1.emf, slides2.emf).

If you want to close or save the Advanced Options panel, go to To Close or Save 
the Printer Definitions Dialog.

The PowerPoint Interface (PPT) Printer Definition works in conjunction with 
Docuflex Studio output Channels. For more information about configuring Channels 
in Docuflex to produce PowerPoint Presentation files, see the Docuflex 
documentation.

If you want to close or save the Advanced Options panel, go to To Close or Save the 
Printer Definitions Dialog.

Note After you’ve specified the scaling factor, which adjusts only the slide area, Docuflex 
scales the image to fit. The larger of the Height or Width is adjusted to fit without 
cropping into the PowerPoint Slide area. The image is scaled equally in both dimensions 
to maintain proper appearance.

Tip The default value for this box is NOT to have a path specified. Therefore, all output is 
directed to the Windows Current Working Directory (which is usually where the Docuflex 
composition engine is running). If you want to specify a path, be aware of the following 
rules:

• The path you type into the Printer Definition is prefixed to the output file name you type 
in the Docuflex Studio Channel. If your Docuflex Channel already includes a fully-
qualified path name (e.g., C:\Oracle\Docuflex\PowerPoint\Slides.ppt, or 
\Output\Slides.ppt),
it takes precedence over the one you type here.

• The path must begin with a slash or backslash, or include a drive letter and colon (:). 
If the slash is the first character, the Docuflex composition engine uses the root level 
of the current disk drive (e.g., C:\outputdir, \outputdir).

• A trailing slash or backslash is optional; forward or backward slashes are permitted 
and you can mix them.

The folders you specify must exist prior to executing the Docuflex composition 
engine—they are NOT automatically created.
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CHANGING A PRINTER DEFINITION
The Printer Definitions object lets you change printer control specifications and 
options (Printer Definitions) for any of the following classes of printing resources:

• IBM Advanced Function Presentation (AFP)

• Xerox Metacode printers

• Docucorp Compound Document (DCD) data streams

• Docucorp text format

• Line Printers

• Printer Control Language (PCL)

To Change a Printer Definition

1. If the Printer Setup window doesn’t already show on your screen, perform the 
instruction(s) under To Start Printer Setup, and then return to this topic. 

2. To select the Printer Definition to change, click on the icon for that Printer 
Definition.

The darkened appearance of the icon indicates that it is selected.

3. From the Edit menu, choose Properties.

The Print Definition window appears. The Printer Definition name you selected 
and its associated PDL appear in the title bar.

Because the Print Definition window contains four panels that you can use to 
change Printer Definition specifications for four types of printers, this guide 
provides a separate topic for each panel.
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COPYING A PRINTER DEFINITION
You can copy a virtual printer / Printer Definition using the File>Save As command 
in the Printer Setup window. 

To Copy a Printer Definition

1. If the Printer Setup window doesn’t already show on your screen, perform the 
instruction(s) under To Start Printer Setup, and then return to this topic. 

2. To select the printer / Printer Definition to copy, click on the icon for that printer.

The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Save As.

The Save As window appears, showing the name of the printer you want to copy.

4. Type the name for the new Printer Definition.

5. Choose the OK button to save the new printer; otherwise, choose the Cancel 
button.

The virtual printer / Printer Definition you copied displays on the Printer Setup 
window.

RENAMING A PRINTER DEFINITION
You can rename a virtual printer / Printer Definition using the File>Rename 
command in the Printer Setup window. 

To Rename a Printer

1. If the Printer Setup window doesn’t already show on your screen, perform the 
instructions under To Start Printer Setup, and then return to this topic. 

To change Go to this topic

Paper dimensions, processing, and handling options Using the Paper Tab 

Printer device performance and configuration options Using the Device Options Tab 

Processing options for Documaker fp and fonts Using the Setup Options Tab 

Advanced Options such as Xerox JDLs/DJDEs or AFP 
CopyGroups

Using the Advanced Options Tab 
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2. To select the printer / Print Definition to rename, click on the icon for that 
printer.

The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Rename.

The menu closes and returns to the Printer Setup window where the selected 
printer name now shows in a text box with a cursor for editing.

4. Type a new name, and then press ENTER.

Printer Setup changes the name of the selected icon to the one you entered.

DELETING A PRINTER DEFINITION
You can remove a virtual printer / Printer Definition using the File>Delete command 
in the Printer Setup window. 

To Remove a Printer Definition

1. If the Printer Setup window doesn’t already show on your screen, perform the 
instruction(s) under To Start Printer Setup, and then return to this topic. 

2. To select the printer / Printer Definition to remove, click on the icon for that 
printer.

The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Delete.

-or-

Press DELETE.

The Remove Printer window appears, showing the name of the printer to 
remove.

4. To delete the Printer Definition, choose the OK button. Otherwise, choose the 
Cancel button.

The virtual printer / Printer Definition you selected disappears from the Printer 
Setup window.
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Chapter 4

The Electronic Document Libraries Object

USING ELECTRONIC DOCUMENT LIBRARIES (EDLS)
The Control Panel- Database EDL object lets you create and maintain Form Libraries and Library 
members. 

Starting or Ending EDL Setup

To Start EDL Setup

• In the Control Panel, double-click the  (Database EDL) icon. 

The Library Setup window displays.

The Electronic Document Libraries object opens the first library on the list. If you want to open a 
different Library, see To Open a Library.
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Because you can use the Library Setup window to add, modify, or delete a Library, member, or 
chain, this guide provides separate topics for these procedures.

To Exit EDL Setup

• From the File menu, select Close. 

-or-

In the upper-right-hand corner of the Library Setup window, click on the  (Close) button.

Library Setup closes and returns control to the Control Panel.

To Select the Database Interface

Electronic Document Libraries (EDLs) have typically been stored in a database (e.g., WATCOM, 
SQLAnyWhere, DB2). Control Panel gives you the option to store those EDLs in either of two places. 
You can continue to store them in a database or you can store them on a hard drive in a text file.

Use the Database Interface command to select the file type of your Library. You can use two types of 
Library interfaces:

• VLAM — your Library members and chains are stored in a VLAM database

• File-based — your Library members and chains are stored on your hard drive in flat files 
(text files)

Once you’ve saved this selection, other objects within the Control Panel use this setting to correctly 
interact with your Library.

1. From the File menu, select Oracle Database Interface.

To Go to

Select the interface type of your Library To Select the Database Interface 

Open a Library To Open a Library

Create a new Library To Create a New Library 

Delete a Library To Delete a Library 

Perform various Backup and Restore 
routines

Backing Up and Restoring Libraries 

Generate Reports and customize report 
Styles

Generating a Library Report 

View information about a Library To View Information about a Library 

Create a new Member To Create a New Member 

Add a Chain to a Member To Add a File to a Member 

Create a new revision of a Member To Create a New Revision 

Delete the contents of the Member, leaving 
the Member intact

To Delete the Contents of a Member 

Delete a Member To Delete a Member 

Rename a Member To Rename a Member

View information about a Member To View Information about a Member

Dump (Save) a Chain to a disk file To Save a Chain to a Disk File 

Delete a Chain To Delete a Chain 

Rename a Chain To Rename a Chain 



76

The Library Interfaces window appears.

2. Select the option button which identifies the correct interface to use with your Library.

3. In the Terminate access attempts after text box, type the length of time you want to wait to 
complete a successful connection with the data repository.

4. Click OK to save your selection. Otherwise, click Cancel.

Control Panel saves your selection and reports it to other objects.

To Open a Library

Use the Library>Open Library command to open a Library containing forms, members, and chains. 
You must open the Library to which you want to apply Library commands.

1. From the Library menu, select Open Library.

-or-

Select the proper Library from the Open a Library drop-down list box.

The Open Library window appears.

2. Do one of the following:

Library Setup opens the Library.

If the currently selected Library is Do this

The one containing the forms or documents 
you want process

Choose OK.

Not the one containing the forms or 
documents you want process

Click the arrow to the right of the drop-down list, and select the Library you want 
to access. Then choose OK.
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Creating a New Library
Use the Library>New Library command to set up a new Library. The name and description you enter 
for the new Library should indicate the type of library.

To Create a New Library

1. From the Library menu, select New Library..

-or-

From the Tool Bar, click on the  (New Library) icon.

The New Document Library window appears.

2. Press the TAB key to reach the Library Name text box, then type a name for the new Library (up 
to 8 characters).

3. Press the TAB key to reach the Description text box, then type a brief (up to 32 character) 
description that identifies the Library type and/or the Product associated with the Library.

4. (Optional) Press the TAB key to reach the Read text box, then type a Read Password (up to 8 
characters) for the new Library.

5. (Optional) Press the TAB key to reach the Write text box, then type a Write Password (up to 8 
characters) for the new Library.

WARNING! To ensure compatibility with all SQL-based databases, you must use the following 
conventions when naming Libraries:

• The first character of the Library name must be alphabetic.
• After the first character, other characters can be alphabetic, numeric, or the 

underscore character.
The Library name must not contain any embedded spaces.
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6. Press the TAB key to reach the Storage text box, then type the drive letter and path of the directory 
to hold the new Library’s chain files. If you’re unsure of the path, click Browse and the Select the 
directory for storing library data files window is displayed. Select the proper directory and 
choose Save.

9. Check to ensure that you have made the required entries, and then choose OK to save the changes 
or Cancel to exit.

Library Setup creates the library you specified.

To Delete a Library

Use the Library>Delete Library command to erase a library and all its members. 

1. From the Library menu, select Delete Library..

-or-

From the Tool Bar, click on the  (Delete Library) icon.

The Delete Library window appears.

2. Make sure the library name is correct.

3. Choose Yes to delete the Library. Otherwise, choose No.

If you chose Yes, Library Setup deletes the Library you specified.

Note To specify the path (drive and directory) with a variable format that allows different users 
to use different mappings for the same file spaces, you must do the following in step 6:

1. Create the directory to hold the Library chain files in the appropriate network 
directory file space (e.g., J:\EDL\CHAINS).

2. Define a variable name (place holder) for the Library’s path. The variable name 
must differ from any current drive mapping, and can be up to 32 characters in 
length.

3. For example, you can define the variable name: User1dir.

4. To complete step 6 using the variable format, type a dollar sign and a left-
parenthesis, the variable name you defined, and a right parenthesis.

5. To continue with the example, you must type $(User1dir) in the Storage text box.

6. In the [PCVLAM] section of the ISI.INI file, you must insert the variable name you 
defined in step B, an equals sign, and the actual drive mapping or file space 
definition for the drive or root directory where the directory you created in step A 
resides.

7. To continue with the example, in the [PCVLAM] section of the ISI.INI files, you must 
make the following entries:

8. user1dir=(whatever directory mapping points to the directory for the Library)

For example, User1dir=J:\EDL\CHAINS.

WARNING! If you delete a library, you will also automatically delete all its members. Be sure you 
want this to occur before deleting the library.
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Backing Up and Restoring Libraries

The Library Setup module contains several routines that control backing up, restoring, and exporting 
Libraries.

To Back Up and Restore Libraries

• From the Libraries menu, select Backup/Restore.

Because you can use the Backup/Restore menu to back up, restore, and export Libraries, this guide 
provides separate topics for each procedure.

To Back Up a Library

Use the Library>Backup Library command when you want to back up a Library to a file that can be 
read and restored by your host system’s VLAM software utility.

1. From the Library menu, select Backup/Restore, then select Backup Library.

-or-

From the Tool Bar, click on the  (Backup Library) icon.

The Select Backup File window appears.

2. In the Save In drop-down list box, use the mouse to select a folder in which to store the Backup.

3. In the File Name text box, type the name of the Backup File.

4. In the Save As Type drop-down list box, use the mouse to select the appropriate file type (VLAM 
Backup file should be selected).

5. To start backing up the Library, choose the Save button. Otherwise, choose the Cancel button. 
Library Setup backs up the Library.

6. It is possible to configure the restore to continue processing when it encounters an error. The 
“ContinueOnEDLConversionError” in VLM2FLAT.INI may be changed to “Y”.

For example:

c:\oracle\DFXCPANL>type VLM2FLAT.INI 
[VLM2FLAT] 
ContinueOnEDLConversionError=Y

This would allow more members in the backup to be restored, even though an error has occurred.

To See this topic

Back up the entire Library To Back Up a Library 

Edit Backup Styles to back up only those members 
meeting specific conditions

Editing Backup Styles 

Back up members based on Backup Styles To Perform a Selective Backup 

Restore the Library from a backup To Restore a Library 
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Editing Backup Styles

Use the Edit Backup Styles command to specify member names, and historical and identifying 
information to use in searching a Library for the appropriate members to back up. The Edit Backup 
Style command accomplishes the search by issuing standard SQL (Structured Query Language) 
commands to your VLAM database.

To Edit Backup Styles

• From the Libraries menu, select Backup/Restore, then select Edit Backup Styles....

The Edit Backup Style window appears.

Because you can use the Edit Backup Style window to view, create, modify, or delete Backup 
Styles, this guide provides separate topics for each procedure.

To Create a Backup Style

1. If you need to specify one or more selection conditions based on

• Member name (up to 32 characters)

• Author (up to 32 characters)

• Description (up to 32 characters)

do the following

If you need to See

Create a Backup Style To Create a Backup Style 

Modify a Backup Style To Modify a Backup Style 

View the selection criteria associated with a Backup Style To View a Backup Style 

Save a Backup Style To Save a Backup Style 

Delete a Backup Style To Delete a Backup Style 

Clear the current specifications and start entering settings for a 
new Style

To Clear a Backup Style 

Close the Backup Styles editor To Close the Backup Styles Editor 
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2. If you need to specify one or more selection conditions based on

• Revision (up to 5 digits)

• DTN (up to 5 digits)

do the following:

3. If you need to specify one or more selection conditions based on

• Creation Date (10 characters in MM/DD/YYYY format)

• Effective Date (10 characters in MM/DD/YYYY format)

• Mod. Date (10 characters in MM/DD/YYYY format)

do the following:

To Specify Do this

One or more selection 
conditions

• Press Tab to reach, or click on, the appropriate drop-down list box.
• Choose a serial condition for selection:

Matches (select all items matching the specified item)

Is Before (select all items before the specified item)

Is After (select all items after the specified item)

Does Not Match (select all items except the specified item)

• Enter the letters to define an item.
• TIP: If you don’t know the exact spelling for an item, or you want to extend the range of the 

search, you can include one or more of the following wildcards in your entry:
• * (place holder for any number of characters)
• ? (place holder for one character only)

To Specify Do this

One or more selection 
conditions

Press Tab to reach, or click on, the appropriate drop-down list box.

Choose a serial condition for selection:

• Equals (select all items equal to the specified item)
• Is Less Than (select all items less than the specified item)
• Is Greater Than (select all items greater than the specified item)
• Is Not Equal To (select all items except the specified item)
• Enter the numbers to define an item.

TIP: If you want to extend the range of the search, you can include one or more of the following 
wildcards in your entry:

* place holder for any number of characters)

? place holder for one character only)

To Specify Do this
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4. If you need to specify a selection condition based on

• Chain name (up to 4 characters)

do the following:

5. To specify a selection condition based on the latest revision or modification date, choose the Select 
only those members which check box and select one of the following:

• Are the latest revision (include only the last revisions for the members)

• Are not the latest revision (include all but the last revisions for the members)

• Were modified since last backup (include only members which have been modified but not 
backed up)

6. Do any of the following:

To Modify a Backup Style

1. If the desired Backup Style isn’t displayed in the Edit Backup Style window, see To View a 
Backup Style.

2. Make any necessary changes to the Backup Style. For more information about editing the Backup 
Style, see To Create a Backup Style.

This concludes the procedure for modifying a Backup Style.

One or more selection 
conditions

Press Tab to reach, or click on, the appropriate drop-down list box.

Choose a serial condition for selection:

• Is (only select the specified item)
• Is Before (select all items before the specified item)
• Is After (select all items after the specified item)
• Is Not (select all items except the specified item)
• Enter the numbers to define an item.

TIP: If you want to extend the range of the search, you can include one or more of the 
following wildcards in your entry:

* (place holder for any number of characters)

? (place holder for one character only)

To Specify Do this

A selection condition based on the 
Chain name

• Press Tab to reach, or click on, the Chain name drop-down list box.
• Choose a serial condition for selection:

Matches (select all items matching the specified item)

Does Not Match (select all items except the specified item)

• Enter the letters to define an item.
• TIP: If you don’t know the exact spelling for an item, or you want to extend the range 

of the search, you can include one or more of the following wildcards in your entry:
• * (place holder for any number of characters)
• ? (place holder for one character only)

If you need to See

Save a Backup Style To Save a Backup Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Backup Style 

Close the Backup Styles editor To Close the Backup Styles Editor 
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To View a Backup Style

1. In the Edit Backup Style window, choose the Load Style button.

The Load Backup Style window appears.

2. From the Style drop-down list box, use the mouse or arrow keys to choose a Style to load.

3. Choose the Ok button.

The selection conditions associated with the Style display in the Edit Backup Style window.

4. Do any of the following:

To Save a Backup Style

1. To save the Style, choose the Save Style button.

The Save Backup Style window appears.

2. In the Style drop-down list box, type a name for the Style.

3. Choose the Ok button. The Save Style Confirmation window appears.

4. Choose the Ok button. Library Setup saves the Backup Style.

5. Do any of the following:

To Delete a Backup Style

1. If the desired Backup Style isn’t displayed in the Edit Backup Style window, see To View a 
Backup Style.

2. In the Edit Backup Style window, choose the Delete Style button.

If you need to See

Modify a Backup Style To Modify a Backup Style 

Delete a Backup Style To Delete a Backup Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Backup Style 

Close the Backup Styles editor To Close the Backup Styles Editor 

If you need to See

Clear the current specifications and start entering 
settings for a new Style

To Clear a Backup Style 

Close the Backup Styles editor To Close the Backup Styles Editor 
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The Delete Backup Style window appears.

3. From the Style drop-down list box, use the mouse or arrow keys to choose a Style to delete.

4. Choose the Ok button. The Delete Style Confirmation window appears.

5. Choose the Ok button.

Library Setup deletes the Backup Style.

6. Do any of the following:

To Clear a Backup Style

• In the Edit Backup Styles window, choose the Clear button.

The Backup Styles editor clears all previous settings.

To Close the Backup Styles Editor

• In the Edit Backup Styles window, choose the Exit button.

Library Setup returns to the main Library Setup window.

To Perform a Selective Backup

1. From the Library menu, select Backup/Restore, then select Selective Backup....

The Load Backup Style window appears.

2. From the Style drop-down list box, use the mouse or arrow keys to choose a Style to load.

If you need to See

Clear the current specifications and start entering settings 
for a new Style

To Clear a Backup Style 

Close the Backup Styles editor To Close the Backup Styles Editor 
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3. Choose the Ok button. The Select Backup File window appears.

4. In the Save In drop-down list box, use the mouse to select a folder in which to store the Backup.

5. In the File Name text box, type the name of the Backup File.

6. In the Save As Type drop-down list box, use the mouse to select the appropriate file type (VLAM 
Backup file should be selected).

7. To start backing up the Library, choose the Save button. Otherwise, choose the Cancel button.

The Creating Backup window appears.

When the backup is complete, the Successful Backup window appears.

8. Choose the Ok button.

Library Setup returns to the main Library Setup window.

To Restore a Library

Use the Restore Library... command when you want to add members to a Library. The members must 
have been transferred from your host system’s VLAM EDL in a VLAM Backup format. 

1. From the Library menu, select Backup/Restore, then select Restore Library....

-or-

From the Tool Bar, click on the  (Restore Library) icon.



86

The Select Backup File window appears.

2. In the Look In drop-down list box, use the mouse to select a folder from which to restore the 
Backup.

3. In the File Name text box, type the name of the Backup File.

4. In the Files Of Type drop-down list box, use the mouse to select the appropriate file type (VLAM 
Backup file should be selected).

5. To start restoring the Library, choose the Open button. Otherwise, choose the Cancel button.

Library Setup places the members in the specified Library.

Generating a Library Report

Use the Generate Report command to produce reports that contain the following possible items of 
information about a Library and its members: 

• The Library name

• The member name and revision number

• Member description

• Document Type Number (DTN)

• Creation date

• Modification date and time

• Effective date

• Author

• Chains

To Generate a Library Report

• From the Library menu, select Generate Report.

Because you can use the Generate Report menu to print basic and custom reports, and define 
reporting styles, this guide provides separate topics for each procedure.

To Generate a Basic Library Report

1. From the Library menu, select Generate Report, then select Basic Report....

-or-

To See this topic

Print a basic (default) report To Generate a Basic Library Report 

Print a custom report To Generate a Custom Library Report 

Define and maintain custom reporting Styles To Edit Report Styles 
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From the Tool Bar, click on the  (Generate Report) icon.

The Basic Report File window appears.

2. In the Save In drop-down list box, use the mouse to select a folder in which to store the report.

3. In the File Name text box, type the name of the report.

4. In the Save As Type drop-down list box, use the mouse to select the appropriate file type (Text 
file should be selected).

5. To start generating the report, choose the Save button. Otherwise, choose the Cancel button.

Library Setup generates the basic Library report.

To Generate a Custom Library Report

1. From the Library menu, select Generate Report, then select Custom Report....

The Select Report Style window appears.

2. From the Style drop-down list box, use the mouse or arrow keys to choose a Style to load.

3. Choose the Ok button.

The Custom Report File window appears.
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4. In the Save In drop-down list box, use the mouse to select a folder in which to store the report.

5. In the File Name text box, type the name of the report.

6. In the Save As Type drop-down list box, use the mouse to select the appropriate file type (Text 
file should be selected).

7. To start generating the report, choose the Save button. Otherwise, choose the Cancel button.

Library Setup generates the custom Library report.

To Edit Report Styles

Use the Edit Report Styles command to specify which Library items you want to include, plus the 
sorting order for the items on the Library report.

• From the Library menu, select Generate Report, then select Edit Report styles....

The Edit Report Style window appears.

Because you can use the Edit Report Style window to view, create, modify, or delete report Styles, 
this guide provides separate topics for each procedure.

If you need to See

Create a Report Style To Create a Report Style 

Modify a Report Style To Modify a Report Style 

View the selection criteria associated with a Report 
Style

To View a Report Style 

Save a Report Style To Save a Report Style 

Delete a Report Style To Delete a Report Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Styles editor To Close the Report Styles Editor 
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To Create a Report Style

1. In the Edit Report Style window, do any of the following until the Desired Categories list box 
contains the desired items and sequence of items.

2. To specify a sort key, choose one of the items in the Sort on drop-down list.

3. To specify a sorting order, choose one of the following option buttons:

• Ascending order (from lowest to highest value)

• Descending order (from highest to lowest value)

4. To view a sample of the report, use the scroll bar in the Example list box.

To Do this

Insert a new item in an empty Desired 
Categories list box

• In the Available Categories list box, point to an item and press-and-hold-down 
the mouse button.

• The mouse pointer changes to a x (no-drop cursor) over the item.
• While continuing to hold down the mouse button, drag the cursor into the 

Desired Categories list box.
• The no-drop cursor changes to a placement cursor.
• Release the mouse button.
• The new item displays in the list box.

Insert a new item before a specific item in 
the Desired Categories list box

• In the Available Categories list box, point to an item and press-and-hold-down 
the mouse button.

• The mouse pointer changes to a x (no-drop cursor) over the item.
• While continuing to hold down the mouse button, drag the cursor into the 

Desired Categories list box until it is positioned directly on the existing item that 
the new item will precede.

• The no-drop cursor changes to a placement cursor.
• Release the mouse button.
• The new item displays in the list box before the existing item.

Append a new item after a specific item in 
the Desired Categories list box

• In the Available Categories list box, point to an item and press-and-hold-down 
the mouse button.

• The mouse pointer changes to a x (no-drop cursor) over the item.
• While continuing to hold down the mouse button, drag the cursor into the 

Desired Categories list box until it is positioned directly under the existing item 
that the new item will follow.

• The no-drop cursor changes to a placement cursor.
• Release the mouse button.
• The new item displays in the list box after the existing item.

Move an item in the Desired Categories 
list box

• In the Desired Categories list box, point to an item and press-and-hold-down the 
mouse button.

• While continuing to hold down the mouse button, drag the cursor to the desired 
position in the list.

• A solid bar displays between the two existing items where the current item will 
be placed.

• Release the mouse button.
• The current item displays in its new location.

Remove an item from the Desired 
Categories list box

• In the Desired Categories list box, select the item and choose the Delete button.
• The Report Styles editor removes the item from the Desired Categories list box.
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5. Do any of the following:

To Modify a Report Style

1. If the desired Report Style isn’t displayed in the Edit Report Style window, see To View a Report 
Style.

The display items and sorting criteria associated with the Style, along with a sample of the 
formatted report appear in the Edit Report Style window.

2. To view a sample of the report, use the scroll bar in the Example list box.

3. Make any necessary changes to the Report Style. For more information about editing the Report 
Style, see To Create a Report Style.

This concludes the procedure for modifying a Report Style.

To View a Report Style

1. In the Edit Report Style window, choose the Load Style button.

The Load Report Style window appears.

2. From the Style drop-down list box, use the mouse or arrow keys to choose a Style to load.

3. Choose the Ok button.

The selection conditions associated with the Style display in the Edit Report Style window.

If you need to See

Save a Report Style To Save a Report Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Styles editor To Close the Report Styles Editor 
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4. Do any of the following:

To Save a Report Style

1. To save the Style, choose the Save Style button.

The Save Report Style window appears.

2. In the Style drop-down list box, type a name for the Style.

3. Choose the Ok button.

The Save Style Confirmation window appears.

4. Choose the Ok button.

Library Setup saves the Report Style.

5. Do any of the following:

To Delete a Report Style

1. If the desired Report Style isn’t displayed in the Edit Report Style window, see To View a Report 
Style.

2. In the Edit Report Style window, choose the Delete Style button.

If you need to See

Modify a Report Style To Modify a Report Style 

Delete a Report Style To Delete a Report Style 

Clear the current specifications and start entering settings for a 
new Style

To Clear a Report Style 

Close the Report Styles editor To Close the Report Styles Editor 

If you need to See

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Styles editor To Close the Report Styles Editor 
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The Delete Report Style window appears.

3. From the Style drop-down list box, use the mouse or arrow keys to choose a Style to delete.

4. Choose the Ok button.

The Delete Style Confirmation window appears.

5. Choose the Ok button to delete the Style; otherwise, choose No to cancel.

Library Setup deletes the Report Style.

6. Do any of the following:

To Clear a Report Style

• In the Edit Report Styles window, choose the Clear button.

The Report Styles editor clears all previous settings.

To Close the Report Styles Editor

• In the Edit Report Styles window, choose the Exit button.

Library Setup returns to the main Library Setup window.

To View Information about a Library

Use the Properties command to view identifying and historical information for a Library. 

1. Highlight the Library name in the Forms Library panel.

2. From the Library menu, select Properties.

-or-

From the Tool Bar, click on the  (Library Properties) icon.

If you need to See

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Styles editor To Close the Report Styles Editor 
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The Library Properties window appears.

The Modification date and time shown in the window are the last date and time a member of the 
Library was modified.

The Data directory indicates the location where EDL member chain files are stored. It’s important 
that you have access to those member chain files in order to perform most of the EDL maintenance 
functions, such as backing up and restoring Libraries, or adding and deleting Library members.

3. When you’re finished viewing the information, choose OK.

To Create a New Member

Use the New Member... command to add a new form to the Library. 

1. Highlight the Library name in the Forms Library panel.

2. From the Library menu, choose Member, then choose New Member....

-or-

From the Tool Bar, click on the  (New Member) icon.

The New Member window appears.

3. Type a name for the new Member (up to 32 characters). Press the TAB key.

4. Type a brief (up to 36 characters) description that identifies the member within the Library. Press 
the TAB key.

5. Type the Document Type Number (DTN) of the member, up to 5 digits.

6. If required, type a Read Password (up to 8 characters) for the new Member. Press the TAB key. 
Re-type the password in the Verify text box.

7. If required, type a Write Password (up to 8 characters) for the new Member. Press the TAB key. 
Re-type the password in the Verify text box.

8. Type the Effective date of the member — the date on which you plan to begin using the member.

9. Check to ensure that you have made the required entries, and then choose OK to save the changes 
or Cancel to exit.

Tip Once you’re returned to the main dialog, you can press F2 to receive a display of the 
database name and driver information.
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Library Setup creates the Member you specified. At this point, the member is empty. That is, there 
are no items or chains associated with this member. Choose Add file to member to include an 
item or chain in this member.

Adding a File to a Member (Loading a Chain)

Use the Add File To Member... command to add new chains to a Library. As a standard convention, 
you should use the following chain names when adding new chains to a member:

• AFP — IBM AFP forms (.AFP file type)

• META — Xerox Metacode forms (.MET and .NOR file types)

• DCD — Docucorp Compound Document (.DCD file type)

• DTF — Docucorp (Docuword) Text Format (.DTF file type)

To load a new form, you must specify its DOS file source. This includes the file name and type, and the 
drive and directory (path) for the file.

To Add a File to a Member

1. If the chains of the current Member aren’t visible, click the left mouse button on the plus sign next 
to the name of the Library, then on the plus sign next to the name of the Member.

This action expands the tree-and-branch view of the Library, members, and chains.

2. Highlight the name of the Member in the Forms Library panel to which you want to add a new file.

3. From the Library menu, select Member, then select Add File to Member....

-or-

From the Tool Bar, click on the  (Add File To Member) icon.

The Enter an Item name window appears.

4. Type a name for the new chain (four characters maximum) and click OK.

The Select New Item For Member window appears.

5. In the Look In drop-down list box, use the mouse to select a folder from which to load the chain.
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6. In the File Name text box, type the name of the chain file.

7. In the Files Of Type drop-down list box, use the mouse to select the appropriate file type.

8. To start loading the chain, choose the Open button. Otherwise, choose the Cancel button.

Library Setup adds the item or chain to the member in the Library and associates it with the newly-
added chain name.

To Create a New Revision

Use the Create Revision... command to make a copy of an existing Member. The new revision contains 
all information about the original, but is assigned then next number in sequence (e.g., 
DecPage_12_1998(1) becomes DecPage_12_1998 (2)).

1. If the members of the current Library aren’t visible, click the left mouse button on the plus sign 
next to the name of the Library.

This action expands the tree-and-branch view of the Library and its members.

2. Highlight the Member name in the Forms Library panel.

3. From the Library menu, choose Member, then choose Create Revision....

-or-

From the Tool Bar, click on the  (Create Revision) icon.

Library Setup creates a new revision with the next number in sequence.

To Delete the Contents of a Member

Use the Empty Member... command to remove old, unused chains from a member. 

1. If the members of the current Library aren’t visible, click the left mouse button on the plus sign 
next to the name of the Library.

This action expands the tree-and-branch view of the Library and its members.

2. Highlight the Member name in the Forms Library panel.

3. From the Library menu, select Member, then select Empty Member....

-or-

From the Tool Bar, click on the  (Empty Member) icon.

The Empty Member window appears.

4. Verify that the member name is correct.

5. Choose Yes to delete the chains. Otherwise, choose No.

Library Setup empties the selected Library member, leaving the member itself in the Library.

To Delete a Member

Use the Delete Member... command to remove old, unused forms from a Library. 

1. If the members of the current Library aren’t visible, click the left mouse button on the plus sign 
next to the name of the Library.

Tip Typically, AFP, Metacode, and Docucorp Text Format (DTF) file types are Record-
Oriented file types, regardless of your operating platform. If you incorrectly identify the 
file type (e.g., you say the file is Stream-Oriented when in fact it’s Record-Oriented), 
Control Panel prompts you to convert the file.
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This action expands the tree-and-branch view of the Library and its members.

2. Highlight the Member name in the Forms Library panel.

3. From the Library menu, choose Member, then choose Delete Member....

-or-

From the Tool Bar, click on the  (Delete Member) icon.

The Delete member window appears.

4. Verify that the member name is correct.

5. Choose Yes to delete the member. Otherwise, choose No.

Library Setup deletes the selected Library member and all of its contents (chains).

To Rename a Member

Use the Rename Member... command to specify another name for a Library member.

1. If the members of the current Library aren’t visible, click the left mouse button on the plus sign 
next to the name of the Library.

This action expands the tree-and-branch view of the Library and its members.

2. Highlight the Member name in the Forms Library panel.

3. From the Library menu, select Member, then select Rename Member....

-or-

From the Tool Bar, click on the  (Rename Member) icon.

The current name for the member is highlighted, allowing you to change it.

4. Type a new name for the member and press ENTER.

Library Setup renames the Library member. The revision level for the member (stored in the 
member name) is automatically reset after the member is renamed.

To View Information about a Member

Use the Properties command to view identifying and historical information for a Member.

1. If the members of the current Library aren’t visible, click the left mouse button on the plus sign 
next to the name of the Library.

This action expands the tree-and-branch view of the Library and its members.

2. Highlight the Member name in the Forms Library panel.

3. From the Library menu, select Member, then select Properties.

-or-

From the Tool Bar, click on the  (Member Properties) icon.
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The Member Properties window appears.

The Items Contained: drop-down list box displays the Chains associated with that member, along 
with each Chain’s Description, DTN, and Effective Date.

The window also indicates whether the Chain is locked by another user. For more information 
about controlling and modifying access to the member, see To Specify Command Line 
Arguments.

4. Enter any necessary changes to the Description, DTN, and Effective Date fields, then choose 
Apply.

5. When you’re finished editing the information, choose OK. Otherwise, choose No.

To Specify Command Line Arguments

The EDL management object provides two command line arguments for greater control over member 
access and modification:

• Admin — enables the capability, within the Member Properties window, to unlock a given 
member.

• View — enables restricted menu and tool bar access to members (e.g., neither Members nor 
Chains can be added or modified).

1. View the Properties for the Docucorp Database EDL. For more information, see Editing an 
Existing Control Panel Object.

2. In the Object Application text box, type the desired command line argument after the name of the 
executable file. Be sure to separate the executable and the argument with a space (e.g., 
E:\Docucorp\Dfxcpanl\Librdef.exe Admin).

3. Click OK to save the changes.

Saving a Chain to a Disk File (Dumping a Chain)

Use the Save Chain As... command when you want to dump (extract and store) a chain of a member 
that resides in a Library. Library Setup dumps the chain into a disk file. If associated with the member, 
you can dump any of the following chains, one chain a time.

• META (Xerox Metacode) — contains the Metacode print stream for a form.

• AFP (IBM Advanced Function Presentation) — contains the AFP print stream for a form.

• IRF (Integrated Replacement File) — contains BPSD tag specifications for a Windows 
MetaFile form.

• IMF (Integrated MetaFile) — contains the information needed to display a form in Microsoft 
Windows.
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• DTF (Docucorp / Docuword Text Format) — contains the data stream of a form composed in 
Docuword.

For example, you can use the Save As command to extract a form’s Metacode chain for export to your 
host system Xerox printer.

To Save a Chain to a Disk File

1. If the chains of the current Library aren’t visible, click the left mouse button on the plus sign next 
to the name of the Library, then on the plus sign next to the name of the member. 

This action expands the tree-and-branch view of the Library, members, and chains.

2. Highlight the Chain name in the Forms Library panel.

3. From the Library menu, select Member, select Chain, then select Save Chain As....

-or-

From the Tool Bar, click on the  (Save Chain) icon.

The Save Chain As window appears.

4. In the Save In drop-down list box, use the mouse to select a folder into which to dump the chain.

5. In the File Name text box, type the name of the file to receive the chain.

6. In the Save As Type drop-down list box, use the mouse to select the appropriate file type:

Typically, AFP, Metacode, and Docucorp Text Format (DTF) file types are Record Oriented file 
types, regardless of your operating platform.

7. To start storing the chain, choose the Save button. Otherwise, choose the Cancel button.

Library Setup stores the form chain in the file you specified.

Deleting a Chain

Use the Delete Chain... command when you want to delete one or more of the chains of a form that 
resides in a Library. For a form member, you can delete any of the following chains: 

• META (Xerox Metacode) — contains the Metacode print stream for a form.

Tip Some of your Library members can be forms which originally came from your host 
system in a variable blocked record format. When you dump one of these members, you 
have the option of preserving the variable blocked record format or transferring the 
unformatted member.

If the EDL resides Choose

On the mainframe in a variable-blocked data stream Record oriented file

On a PC in an unblocked data stream Stream oriented file
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• AFP (IBM Advanced Function Presentation) — contains the AFP print stream for a form.

• IRF (Integrated Replacement File) — contains BPSD tag specifications for a Windows 
MetaFile form.

• IMF (Integrated MetaFile) — contains the information needed to display a form in Microsoft 
Windows.

• DTF (Docucorp / Docuword Text Format) — contains the data stream of a form composed in 
Docuword.

For example, you can delete the Metacode or AFP chain for a form if you no longer need it, because 
you always use a local HP printer. Thus, you only need the IMF and IRF chains.

To Delete a Chain

1. If the chains of the current Library aren’t visible, click the left mouse button on the plus sign next 
to the name of the Library, then on the plus sign next to the name of the member. 

This action expands the tree-and-branch view of the Library, members, and chains.

2. Highlight the Chain name in the Forms Library panel.

3. From the Library menu, select Member, select Chain, then select Delete Chain....

-or-

From the Tool Bar, click on the  (Delete Chain) icon.

Library Setup deletes the chain.

To Rename a Chain

Use the Rename Chain... command to specify another name for a Member’s chain. 

1. If the chains of the current Member aren’t visible, click the left mouse button on the plus sign next 
to the name of the member.

This action expands the tree-and-branch view of the member and its chains.

2. Highlight the Chain name in the Forms Library panel.

3. From the Library menu, select Member, select Chain, then select Rename Chain....

-or-

From the Tool Bar, click on the  (Rename Chain) icon.

The current name for the chain is highlighted, allowing you to change it.

4. Type a new name for the chain and press ENTER.

Library Setup renames the chain.

WARNING! You will NOT receive a deletion confirmation box; therefore, double check the chain 
name before choosing Delete.
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Chapter 5

THE FILE-BASED EDL OBJECT

USING FILE-BASED EDLS
The File-Based EDL object in the Control Panel lets you create and update Form 
Libraries stored in flat-file (non-VLAM database) formats.

Starting and Ending the File-Based EDL Object

The first time you start the File-Based EDL object, it prompts you to create a 
database file which serves as the root folder for all EDLs you will add to the 
database. The object also prompts you to create at least one EDL.

Once you've specified the database folder and created at least one file-based EDL, 
the File-Based EDL main window will appear the next time you start the object.

To Start the File-Based EDL Object

• In the Control Panel, double-click the  (File-Based EDL) icon.

If you have started the object for the first time, follow the instructions under Creating 
the Database and the First EDL to set up a File-based EDL database and create your 
first EDL.
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If you’ve already set up the database and your first File-based EDL,  go to Working 
in the File-Based EDL Main Window.

To Exit the File-Based EDL Object

• From the File menu, select Close. 

-or-

In the upper-right-hand corner of the File-Based EDL object window, click on 

the   (Close) button.

The File-Based EDL object closes and returns control to the Control Panel.

Creating the Database and the First EDL

Before You Create Your First File-Based EDL

Before you create your first EDL, you need to determine the following:

• The platform or operating system to use:

Windows

UNIX

You can establish EDLs that can be accessed on both platforms, but if you’re 
using UNIX, you need to set the File-based EDL interface to display UNIX 
directory information. See step 4 of the following procedure.

• Where to place the file-based database file — if you want the EDL database to 
be available to other users, then you must place the database file in a network 
directory to which those users have access rights.

• Where to place the Libraries you'll create and associate with the database — if 
you want the Libraries to be available to other users, then you must place the 
Library INI files in a network directory that

Has sufficient space to store the Libraries.

Has access rights for those users who will use the Libraries.

To Create the File-Based EDL Database and Your First Library 

1. When the following message displays, choose Yes.
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The Create a directory file... window appears.

Tip By default, the Create a directory file... dialog shows the folder where the Control Panel 
has been installed. If you want to, you can place the database in a different folder.

For example, if the database needs to be in a network folder for network access and the 
Control Panel installation is not in the appropriate network folder, then you can specify 
that folder in the following step.
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2. Do one or more of the following, as required:

The object creates the database file you specified, and it creates entries similar 
to the following in your system's ISI.INI file:

3. When the Empty Library Listing message displays, prompting you to define at 
least one EDL, choose OK.

The File-Based EDL main window displays.

If Do this

The incorrect folder shows in the Save in text box Click the arrow on the right of the Save in drop-down list, and then 
select the correct drive and/or folder.

The default file name isn't the one you want to use In the File name text box, type the name of the file to use as the EDL 
database.

The correct file type (*.ini) doesn't show in the Save 
as type drop-down list

Click the arrow on the right of the Save as type drop-down list, and then 
select the *.ini file type.

You want to create the database file using the current 
specifications

Choose the Save button.

[EDLINI]
EDLINI=C:\Oracle\DFXCPANL\EDLDir.ini
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4. If you want to create and maintain EDLs on a UNIX platform, set up the File-
based EDL interface for UNIX viewing. For details, see About Setting File-
Based EDL Preferences.

5. Define a new Library. For details, see To Create a Library.

Working in the File-Based EDL Main Window

After you've defined the EDL database and specified at least one Library, the next 
time you start the File-Based EDL object a window similar to the following displays.

Because you can use the File-Based EDL object window to add, modify, or delete a 
Library, Member, or Chain; this guide provides separate topics for these operations.

To Go to

Library Open a Library To Open a Library 

Operations See the path to the file-based EDL database file EDL Manager opens the Library, displays the EDL name in the 
left-hand work area, and displays information about any Library 
members in the right-hand work area.

Set the Docucorp Library interface To Set the Docucorp Library Interface

Close the File-Based EDL object To Exit the File-Based EDL Object

Create a new Library To Create a Library 

Delete a Library To Delete a Library

Import/restore a VLAM Library to a new or existing 
File-based EDL

About Importing/Restoring a Library

Automatically generate DCD chains when restoring 
Library members

To Generate DCD Chains from Other Chains During Library 
Restore

Back up an EDL To Back Up a File-Based EDL 
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To Open a Library

• In the File Based EDL main windows, click the arrow to the right of the Open a 
Library drop-down list, and select the Library you want to open.

-or-

In the Open a Library drop-down list text box, type the name of the Library and 
press ENTER.

-or-

From the Library menu, choose Open a Library...; in the dialog that displays, 
click the arrow  to the right of the Open a Library drop-down list, and then 
select the Library you want to open.

Create/Modify a Backup Style Editing Backup Styles

Specify the Chain directories for a Library About Specifying Library Chain Directories

Automatically open the last-used Library on startup About Setting File-Based EDL Preferences

Sort alphabetically the EDL Members About Setting File-Based EDL Preferences

Generate a Library Report Generating a Library Report 

View information about a Library To View Information about a Library

Member Create a new Member To Create a Member

Operations Add a Chain file to a Member To Add a Chain File to a Member

Create a new revision of a Member To Create a New Member Revision 

Empty the contents of the Member, leaving the 
Member intact

To Delete the Contents of a Member

Delete a Member To Delete a Member, Members, or a Range of Members

Rename a Member To Rename a Member

Find a Member To Find a Member

View information about a Member To View Information about a Member

Chain Dump a Chain To Dump a Chain

Operations Delete a Chain To Delete a Chain

Rename a Chain To Rename a Chain

View information about a Chain To View Information about a Chain

UNIX View Enable/disable UNIX interface items About Setting File-Based EDL Preferences

To Go to
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EDL Manager opens the Library, displays the EDL name in the left-hand work area, 
and displays information about any Library members in the right-hand work area.

To See and/or Change the File-Based Database Directory File 
(EDLDir.ini)

1. From the File menu, choose EDL Directory File. 

The EDL Directory File information window appears.

2. Do one of the following:

• View the location of the EDL Directory file, and then choose No.

-or-

• To change the path and/or name for the file when you’re finished viewing 
the current location, choose the Yes button.

Important The EDL directory file (EDLDir.ini in the illustration above), which is similar to a pcVLAM 
database, contains pointers to one or more defined EDLs. As you add any new EDLs, 
the File Based EDL object will automatically add their specifications to the current EDL 
Directory file.

Because the object can only access one EDL Directory file at a time,  you should not 
change the path or name for this file unless you

• Need forms that are not available in any of your current EDLs

-and-

• Are certain that the forms are available from another EDL Directory file setup for which 
you have directory access rights
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The  Open... Select a directory file ... window appears.

Do the following, as required:

The dialog closes and returns to the File Based EDL window.

To Set the Docucorp Library Interface

1. From the File menu, choose Docucorp Library Interface. 

If Do this

The incorrect drive or folder shows in the 
Look in text box

Click the arrow on the right of the Look in text box, and then select the drive and/
or folder where the EDL Directory file is located.

The correct folder doesn't show in the Look 
in list box

In the Look in list box, scroll to see more folders, or double-click a root folder to see 
its subfolders.

The correct EDL Directory file name 
doesn't show in the Look in list box

In the Look in list box, double-click the correct folder to see its contents.

The name of the EDL Directory file doesn't 
show in the File name text box

In the Look in list box, click to select the EDL Directory file and place it in the File 
name text box.

You want to load the EDL Directory file 
indicated by the current specifications

Choose the Open button.
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The Library Interfaces window appears.

2. Do one of the following:

To set the Library interface to Choose this option button

A pcVLAM populated SQL compliant database, such as Sybase or Oracle. VLAM database EDL

The proprietary file-based database which is populated with DOS path mappings to 
Library members and Chains.

File-based EDL
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3. If you want to specify the amount of time one or more Oracle applications can 
take to attempt to read a File-based EDL, type the time in seconds in the 
Terminate access attempts after text box.

The File-Based EDL object then sets the RetryTimes=key parameter in the 
[DATABASE INTERFACES] section of your isi.ini file. This parameter represents 
the number of attempts to make at opening a File-Based EDL that is locked. 
Each number represents about ½ second of actual time.

4. Choose OK to set the interface or Cancel to exit.

If you chose OK, the object sets the Control Panel's Library interface to the 
option you chose.

To Create a Library

1. From the Library menu, choose New Library....

-or-

From the Tool Bar, click on the  (New Library) icon.

-or-

Press CTRL + N.

The Add a new Library window appears.

Tip If you chose the File-based EDL option in step 2, you can specify the amount of time 
that the File Based EDL object and other applications (e.g., a VDR, the Documaker fp 
Server, etc.) can use to contend for access to a File-based EDL.

The more time you specify, the more time the application(s) will have to attempt access.  
If you specify less time,  the duration of an access attempt will be shorter, but there will 
also be a decreased probability of success.

If you chose the File-based EDL option in step 2, you can specify the amount of time 
that the File Based EDL object and other applications (e.g., a VDR, the Documaker fp 
Server, etc.) can use to contend for access to a File-based EDL.

The more time you specify, the more time the application(s) will have to attempt access.  
If you specify less time,  the duration of an access attempt will be shorter, but there will 
also be a decreased probability of success.

Note The following dialog shows items for working with UNIX-based Libraries. Unless you 
have the UNIX view turned on, the dialog you see will not have the UNIX-related items.

You need the UNIX view only if you’re working with a UNIX-based Oracle product that 
uses File-based EDLs. For details about turning the UNIX view on or off, see About 
Setting File-Based EDL Preferences.
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2. In the Library Name text box, type a name for a new Library (up to 8 
characters).

3. Press TAB.

The object automatically populates the Library File text box (and the Library 
File [UNIX]  text box if the UNIX View has been turned on) with default path(s) 
for the new Library INI file.

4. If you don’t want the Library file to be placed in the default path(s) shown as the 
result of step 3, do the following:

 

If Do this

You want to change the default Library 
File MS DOS path

In the Library File text box, enter the MS DOS path and file name to hold the EDL 
specifications — including the .ini extension for the file name.

-or-

Choose the Browse button, and then locate  the path and specify the file name to 
hold the EDL specifications. For details about using the Browse feature for Library 
files, see To Browse for the Location to Save a Library File.

You have the UNIX view turned on (you’re 
also setting up a UNIX path for the Library 
specifications)

Important:  If you changed the DOS path, you must also change the UNIX path 
to the equivalent directory structure.

In the Library File (UNIX) text box, enter the equivalent UNIX path and file name 
to hold the EDL — including the .ini extension for the file name.

Note The default Chain directory .../Chn stores Chain files of any type. Use this directory 
exclusively if you want a single directory to contain all of these files. You cannot delete 
the  .../Chn directory once you create it.
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5. Do the following:

6. If the Library name and path are correct, choose OK.

The object generates entries similar to the following (UNIX entries are also shown) 
in the database directory INI file:

Also, the object creates entries similar to the following in the Library INI file you've 
defined:

To Browse for the Location to Save a Library File

After you choose the Browse button, the Save As... Initialization file window 
appears.

To Do this

Specify a DOS directory to hold the EDL 
Chains

In the Chain Directory text box, enter the MS DOS directory path to hold the 
Chains.

-or-

Choose the Browse button, and then locate  the path to hold the Chains. For 
details about using the Browse feature for locating Chain directories, see To 
Browse for a Folder.

Specify a UNIX directory to hold the EDL 
Chains when you have the UNIX view 
turned on

Important:  The DOS path and the UNIX path for the Chain directories must 
have equivalent directory structures.

In the Chain Directory (UNIX) text box, enter the equivalent UNIX path to hold the 
Chains.

[EDL Directory]
EDLs=1
EDL1=MREDL_2
EDL1_INI=E:\FBEDLS2\mredl_2.ini
EDL1_ux_INI=/FBEDLS2/mredl_2.ini

[*MREDL_2*]
ChnDir=E:\FBEDLS2\
Chn_ux_Dir=/FBEDLS2/
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• Do the following, as required:

The dialog closes and the path and file name you've specified appear in the text box.

To Browse for a Folder

After you choose the Browse button, the Browse for Folder window appears.

• To locate the appropriate directory, navigate through your directory structure by 
doing as many of the following as required:

The dialog closes and the path you've specified displays in the text box.

To Do this

Specify a different folder to hold the Library Click the arrow on the right of the Save in drop-down list, and then select a 
different drive and/or folder.

Enter the name of the file to hold the 
Library

In the File name text box, type the name of the file (the dialog will automatically 
append the .ini extension to the name).

Save the Library file using the current 
specifications

Choose the Save button.

If Do this

The path to the directory doesn't appear in 
the browser

Click the left mouse button on the plus sign —  — next to the name of the 
appropriate domain to expand its contents.

The correct directory doesn't show in the 
browser

Click the left mouse button on the plus sign —  — next to the name of the 
appropriate drive and/or root directory to expand its contents.

The correct directory isn't highlighted in the 
browser

Click the left mouse button on the directory to highlight it.

You want to open the directory with the 
current specifications

Choose the OK button.
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To Delete a Library

Use the Library>Delete a Library command to erase a library and all its members.

1.  From the Library menu, select Delete a Library.

-or-

From the Tool Bar, click on the  (Delete Library) icon.

The Delete Library window appears.

2. Verify that the Library name is correct.

3. Choose Yes to delete the Library. Otherwise, choose No.

If you chose Yes, the object deletes the Library you specified.

About Importing/Restoring a Library

Use the Restore>Import a Library command when you want to restore a VLAM-
based mainframe or pcVLAM-based client/server Library that has been backed up 
with the Library>Backup/Restore>Backup Library command of the Control Panel's 
Electronic Document Libraries object (or equivalent function in another VLAM 
backup utility).

You can

• Import a new Library. This option lets you create a File-based EDL from a 
VLAM Library backup file when the File-based EDL is not already defined.

-or-

• Restore an existing Library. This option lets you load data from a VLAM 
backup file  to a File-based EDL if it is already defined.

Automatic DCD Chain Generation During a Restore

As you restore the Library, you can also generate DCD (Docucorp Compound 
Document) Chains from the META, AFP, or DTF Chains of the Library Members.

Because Oracle new-generation products use DCD Chains to convert between 
mainframe and Windows print-data streams, we recommend that you generate DCD 
Chains for all your File-based EDL members. 

WARNING! If you delete a library, you will also automatically delete all its members. Be sure you 
want this to occur before deleting the library.



114

File-Based EDL Restore Limitations

The data that you restore to a File-based EDL is constructed from a flat .ini file 
(libraryname.ini). The following list contains the fields that are present in the 
pcVLAM database table; however, these fields are NOT restored to a File-based 
EDL:

To Import to a New Library or Restore to an Existing Library

1. If you want to restore a backed up VLAM Library to an existing File-Based 
Library, you must already have that Library open before you proceed. For 
details about opening a Library, see To Open a Library.

2. From the Library menu, choose Backup/Restore Library, and then choose 
Restore/Import a Library... from the sub menu.

-or-

On the Tool Bar, click the  (Restore ... EDL ...) icon.

The Restore/Import a Library ... window appears..

DIRECTORY FLAGS SPARE

PDS_NAME DESC_ID INFO_ID

NEW_ROWID ARCV_TIME ARCV_DATE

RESERVED1 RESERVED2 RESERVED3

RESERVED4 RESERVED5 RESERVED6

LOCK_UID ROWID

Note The following dialog shows a tab for working with UNIX-based Libraries. Unless you 
have the UNIX view turned on, the dialog you see will not have the UNIX tab.

You need the UNIX view only if you’re working with a UNIX-based Oracle product that 
uses File-based EDLs. For details about turning the UNIX view on or off, see the two 
topics starting with About Setting File-Based EDL Preferences.
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3. Do one of the following:

4.  Under Backup File, do one of the following:

• Enter the path and backup file name — including the .vlm extension for the 
file name.

-or-

• Choose the Browse button.

To Choose this option button

Load data from a VLAM Library backup file to a previously opened 
File-based EDL

Restore an existing Library

Populate a new File-based EDL with data from a VLAM Library 
backup file

Import a New Library
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The Select a VLAM backup file... window appears.

Do any of the following, as required:

The dialog closes and the path and file name you've specified appear in the 
Backup File text box.

5. Do one of the following:

6. If you’re going to load data from a backup file to a previously opened File-
based EDL, go to step 8.

Otherwise, if you’re going to populate a new File-based EDL with data from a 
backup file, do one of the following:

If Do this

The incorrect drive or folder shows in the 
Look in text box

Click the arrow on the right of the Look in text box, and then select the drive and/
or folder where the backup file is located.

The correct folder doesn't show in the Look 
in list box

In the Look in list box, scroll to see more folders, or double-click a root folder to see 
its subfolders.

The correct backup file name doesn't show 
in the Look in list box

In the Look in list box, double-click the correct folder to see its contents.

The name of the backup file doesn't show 
in the File name text box

In the Look in list box, click to select the backup file and place it in the File name 
text box.

You want to load the backup file indicated 
by the current specifications

Choose the Open button.

To Do this

Load data from a backup file into a File-
based EDL you’ve already opened (Import)

Click on the drop-down arrow next to the Library Name text box, and select the 
name of the EDL from the list

Populate a new File-based EDL with data 
from a backup file (Restore)

In the Library Name text box, type the name of a new EDL (of up to eight 
characters)
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7. If you’re going to populate a new File-based EDL with data from a VLAM 
Library backup file, do one of the following:

8. If you want to change the default or existing directory for temporary files,  under 
Temp Directory, do one of the following:

• Enter the path for the directory to temporarily hold the Chain files.

-or-

• Choose the Browse button, and then locate the Temp Directory. For details 
about using the Browse feature, see To Browse for a Folder.

9. If you’re going to populate a new File-based EDL with data from a VLAM 
Library backup file, go to step 10.

Otherwise, if you’re going to load data from a VLAM Library backup file to a 
previously opened File-based EDL, do one of the following:

To Do this

Specify an EDL that has Windows naming 
conventions and is located in a Windows 
directory

In the Library File text box, enter the MS DOS path and file name for the EDL — 
including the .ini extension for the file name.

-or-

Choose the Browse button, and then locate  the path and file name for the EDL. 
For details about using the Browse feature for Library files, see To Browse for a 
Library File.

Specify an EDL that has UNIX naming 
conventions and is located in a UNIX 
directory

1 In the Restore/Import a Library ... dialog, choose the UNIX tab.

2 In the Library File text box, enter the UNIX path and file name for the EDL — 
including the .ini extension for the file name.

To Do this

Specify the Windows directory that holds 
the EDL Chains

In the Chain Directory text box, enter the MS DOS directory path for the Chains.

-or-

Choose the Browse button, and then locate the directory for the Chains. For 
details about using the Browse feature for locating Chain directories, see To 
Browse for a Folder.

Specify a UNIX directory that holds the 
EDL Chains

In the Chain Directory text box located on the UNIX tab, enter the UNIX directory 
path that contains the Chains.

Note Choose a drive for the Temp Directory that has sufficient space (300 MB or more) to 
contain all the temporary files.

If Do this

You don’t want to replace existing Library members with 
like-named members from the backup file

Deselect the Overwrite existing members check box.

You want to replace existing Library members with like-
named members from the backup file

Select the Overwrite existing members check box.
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10. Do one of the following:

11. If you want to automatically generate DCD Chains from  Metacode, AFP, or 
DTF Chains as the EDL is restored, perform the procedure under To Generate 
DCD Chains from Other Chains During Library Restore, before returning to this 
procedure.

12. To start restoring to the Library, choose the OK button. Otherwise, choose the 
Cancel button.

If you chose OK, the object restores the VLAM backup file you specified.

If Do this

Your restores have been successful and you want to lessen 
the time it takes to do the next restore

Deselect the Enable Tracing check box.

Your attempt to restore a backed up Library failed and you 
want to use a trace program to determine the cause

Select the Enable Tracing check box.

Accept the default trace log file path and name, or enter a path 
and name of your choosing in the Enable Tracing text box.

Tip When you restore a pcVLAM-based EDL into a File-based EDL, you have the option of 
automatically generating Docucorp Compound Document (DCD) Chains for Library 
members that already have the following Chains:

• Xerox Metacode (MET)

• IBM AFP (AFP)

• Docucorp Text Format (DTF)

Because Oracle new-generation products use DCD Chains to convert between these 
mainframe and Windows print-data streams, we recommend that you generate DCD 
Chains for all your File-based EDL members. For details, see the following step.
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To Browse for a Library File

After you choose the Browse button, the Open\Create... Initialization file ... window 
appears.

Do the any of the following, as required:

The dialog closes and the path and file name you've specified appear in the text box.

To Generate DCD Chains from Other Chains During Library Restore

1. In the Restore/Import a Library ... dialog, choose the Advanced Options tab.

2. Choose the Provide a DCD version of Metacode, AFP, or DTF forms check 
box.

To Do this

Specify a different folder for the Library Click the arrow on the right of the Look in drop-down list, and then select a 
different drive and/or folder.

Enter the name of the file to hold the 
Library

In the File name text box, type the name of the file (the dialog will automatically 
append the .ini extension to the name).

Open the Library file using the current 
specifications

Choose the Open button.

Important To automatically generate DCD Chains from Library-Member Metacode, AFP, or DTF 
Chains as you do a restore, you must have defined a Print Definition for each of the 
Chain types involved, including the DCD Chain.

For details about defining Print Definitions, see Using Printer Definitions.

The system on which you do the restore must also have access to the original 
ISI.INI file which was active when the Library Members were composed. This 
ISI.INI must contain the following: 

• All PFMs that were used to compose the EDL form Members

• All PrintDefinitions that were used to compose the EDL form Members
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The Advanced Options tab changes to resemble the following:

3. Click on the drop-down arrow next to the Input Printer Definition text box, and 
then select the name of a Metacode, AFP, or DTF Print Definition.

4. Click on the drop-down arrow next to the DCD Printer Definition text box, and 
then select the name of a DCD Print Definition.

5. If you want to change the name of the log file for the DCD conversion (the File-
based EDL object writes the file to the same directory that contains the isi.ini 
file), in the Processing Log file text box, enter a new DOS-formatted name for 
that file.

To Back Up a File-Based EDL

1. To back up a File-based EDL, you must already have that Library open before 
you proceed. For details about opening a Library, see To Open a Library.

2. Do any of the following

If Do this

You want to back up the entire Library, 
including all of its Chain types

-And-

You don’t want to change the name of the 
log file for the EDL backup

Go to step 3 following this table.

You want to back up one or more specific 
Chain types (META, AFP, DCD, or DTF), 
but not all Chain types

1 From the Tools menu, choose Options.
The Options dialog opens.

2 If it’s not already showing, choose the Backup tab.
The Backup tab changes to resemble the following:
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1. From the Library menu, choose Backup/Restore Library, and then choose 
Back Up a Library... from the sub menu.

-or-

On the Tool Bar, click the  (Backup an existing EDL ...) icon.

3 Choose the Select only specific chain identifier .... check 
box.

4 In the associated text box, enter one or more of the Chain 
identifiers you want to back up, separating each except the 
last with a space and comma. 

You want to change the name of the log 
file for the EDL backup

1 From the Tools menu, choose Options.
The Options dialog opens.

2 If it’s not already showing, choose the Backup tab as 
shown above.

3 In the Processing Log file text box, enter a new DOS-
formatted name for that file.
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The Select a file ... name of a backup file window appears.

2. Do the following, as required:

The dialog closes and the object performs a back up of the specified Library to 
the specified backup file, and then displays the following message:

3. Choose OK to complete the backup operation.

If Do this

The incorrect drive or folder shows in the 
Save in text box

Click the arrow on the right of the Save in text box, and then select the drive and/
or folder to hold the backup file.

The correct folder doesn't show in the Save 
in list box

In the Save in list box, scroll to see more folders, or double-click a root folder to 
see its subfolders.

The correct backup file name doesn't show 
in the Save in list box

In the Save in list box, double-click the correct folder to see its contents.

The name of the backup file doesn't show 
in the File name text box

In the Save in list box, click to select the backup file name and place it in the File 
name text box.

-or-

In the File name text box, type a name of eight characters or less for the backup 
file.

You’re ready to use the backup file 
indicated by the current specifications

Choose the Save button.
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Editing Backup Styles

Use the Library>Edit Backup Styles command to specify member names, and 
historical and identifying information to use in searching a Library for the 
appropriate members to back up. 

To Edit Backup Styles

• From the Library menu, select Backup/Restore Library, then select Edit 
Backup Styles....

The Backup Style Editor window appears.

Because you can use the Backup Style Editor window to view, create, modify, 
or delete Backup Styles, this guide provides separate topics for each procedure.

If you need to See

Create a Backup Style To Create a Backup Style 

Modify a Backup Style To Modify a Backup Style 

View the selection criteria associated with a Backup 
Style

To View a Backup Style 

Save a Backup Style To Save a Backup Style 

Delete a Backup Style To Delete a Backup Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Backup Style 

Close the Backup Style Editor To Close the Backup Style Editor 
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To Create a Backup Style

1. Click Add Style in the Backup Style Editor window.

The Add a new Backup style window appears.

2. Type the name of the backup style you want to create, and then click OK.

You’re returned to the Backup Style Editor dialog. For more information about 
modifying a backup style, see To Modify a Backup Style.

To Modify a Backup Style

1. If the desired Backup Style is displayed in the Backup Style Editor window, see 
To View a Backup Style.

2. If you need to specify one or more selection conditions based on

Member name (up to 32 characters)

Description (up to 36 characters)

do the following:

3. If you need to specify one or more selection conditions based on

Revision (up to 5 digits)

DTN (up to 5 digits each; you may enter multiple DTNs separated by 
commas)

To specify Do this

One or more selection 
conditions

Press TAB to reach, or click on, the appropriate drop-down list box.

Choose a serial condition for selection:

• Matches (select all items matching the specified item)
• Is Before (select all items before the specified item)
• Is After (select all items after the specified item)
• Does Not Match (select all items except the specified item)

Enter the letters to define an item.

TIP: If you don’t know the exact spelling for an item, or you want to extend the range of the 
search, you can include one or more of the following wildcards in your entry:

*  (place holder for any number of characters)

?  (place holder for one character only)
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do the following:

4. If you need to specify one or more selection conditions based on

Effective Date (10 characters in YYYY/MM/DD format)

Modification Date (10 characters in YYYY/MM/DD format)

do the following:

5. To specify a selection condition based on the latest revision, choose the Select 
only those members with the latest revision check box.

6. To specify a selection condition based on the chain files stored with a member, 
choose the Select only members with these chains check box and enter the 
chain(s) associated with this member. The chain name(s) consist(s) of up to four 
characters; you can enter multiple chain names, separated by commas.

7. Do any of the following:

This concludes the procedure for modifying a Backup Style.

To specify Do this

One or more selection conditions Press Tab to reach, or click on, the appropriate drop-down list box.

Choose a serial condition for selection:

• Equals (select all items equal to the specified item)
• Is Less Than (select all items less than the specified item)
• Is Greater Than (select all items greater than the specified item)
• Is Not Equal To (select all items except the specified item)

Enter the numbers to define an item.

TIP: If you want to extend the range of the search, you can include one or more of 
the following wildcards in your entry:

*  (place holder for any number of characters)

?  (place holder for one character only)

To specify Do this

One or more selection conditions Press Tab to reach, or click on, the appropriate drop-down list box.

Choose a serial condition for selection:

• Is (only select the specified item)
• Is Before (select all items before the specified item)
• Is After (select all items after the specified item)
• Is Not (select all items except the specified item)

Enter the numbers to define an item.

TIP: If you want to extend the range of the search, you can include one or more of 
the following wildcards in your entry:

*  (place holder for any number of characters)

?  (place holder for one character only)

If you need to See

Save a Backup Style To Save a Backup Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Backup Style 

Close the Backup Style Editor To Close the Backup Style Editor 
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To View a Backup Style

1. From the Style drop-down list box, use the mouse or arrow keys to choose a 
Style to view.

The selection conditions associated with the Style display in the Backup Style 
Editor window.

2. Do any of the following:

To Save a Backup Style

1. To save the Style, choose the Save Style button.

Library Setup saves the Backup Style.

2. Do any of the following:

To Delete a Backup Style

1. If the desired Backup Style isn’t displayed in the Backup Style Editor window, 
see To View a Backup Style.

2. In the Backup Style Editor window, choose the Delete Style button.

The Delete a Backup Style window appears.

3. Click Yes to delete the style; otherwise, click No to cancel.

Library Setup deletes the Backup Style.

If you need to See

Modify a Backup Style To Create a Backup Style 

Delete a Backup Style To Delete a Backup Style 

Clear the current specifications and start entering settings for a 
new Style

To Clear a Backup Style 

Close the Backup Style Editor To Close the Backup Style Editor 

If you need to See

Clear the current specifications and start entering settings for a 
new Style

To Clear a Backup Style 

Close the Backup Style Editor To Close the Backup Style Editor 
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4. Do any of the following:

To Clear a Backup Style

• In the Backup Style Editor window, choose the Clear Style button.

The Backup Style Editor clears all previous settings.

To Close the Backup Style Editor

• In the Backup Style Editor window, choose the Done button.

Library Setup returns to the main Library Setup window.

To Perform a Selective Backup

1. From the Library menu, select Backup/Restore Library, then select Selective 
Backup....

The Select a Backup Style window appears.

2. From the Style drop-down list box, use the mouse or arrow keys to choose a 
Style to use.

3. Choose the Ok button.

The Select a File ... window appears.

4. In the Save In drop-down list box, use the mouse to select a folder in which to 
store the Backup.

5. In the File Name text box, type the name of the Backup File.

6. In the Save As Type drop-down list box, use the mouse to select the appropriate 
file type (VLAM Backup file should be selected).

If you need to See

Clear the current specifications and start entering 
settings for a new Style

To Clear a Backup Style 

Close the Backup Style Editor To Close the Backup Style Editor 
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7. To start backing up the Library, choose the Save button. Otherwise, choose the 
Cancel button.

The Creating Backup window appears.

When the backup is complete, the Backup complete window appears.

8. Choose the Ok button.

Library Setup returns to the main Library Setup window.

About Specifying Library Chain Directories

Use the Library>Chain Directories command to update the directories that hold any 
of the following types of Chains:

• AFP (IBM Advanced Function Presentation)

• META (Xerox Metacode)

• DCD (Docucorp Compound Document)

• DTF (Docuflex text format)

You can specify both MS DOS- and UNIX-based directories to hold Chains. If you 
want to specify a UNIX directory path for a chain type, you must first specify the 
equivalent DOS directory path.

To Update Library Chain Directories:

Note The default Chain directory .../Chn stores Chain files of any type. Use this directory 
exclusively if you want a single directory to contain all of these files. You cannot delete 
the  .../Chn directory once you create it.
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1. To add, change, or delete an EDL Chain directory, you must already have that 
EDL open before you proceed. For details about opening a EDL, see To Open a 
Library.

2. From the Library menu, select Chain Directories....

-or-

From the Tool Bar, click on the  (Chain file directories) icon.

-or-

Press F4.

A Chain Directories assigned to... dialog, similar to the following displays.

Any Chains that have currently assigned directories appear in the Standard (MS 
DOS) and UNIX Chain Directories list boxes.

Note The following dialog shows a button for switching between DOS and UNIX directories. 
If you don’t have the UNIX view turned on, the dialog won’t have the Edit DOS/UNIX 
button.

You need the UNIX view only if you’re working with a UNIX-based Oracle product that 
uses File-based EDLs. For details about turning the UNIX view on or off, see the two 
topics starting with About Setting File-Based EDL Preferences.
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Because you can use the Chain Directories assigned to... dialog to add, modify, 
or delete a Chain directory, this guide provides separate topics for these 
procedures.

To Add a Chain Directory

1. If you have the UNIX view enabled, choose the Edit DOS button in the Chain 
Directories assigned to... window.

2. Choose the Add button.

The dialog changes into its Add mode (the Edit DOS view shows in the 
following example).

3. From the ID drop-down list (the list only shows those Chain types for which no 
current Chain directory exists), choose one of the following types of Chains:

AFP (IBM Advanced Function Presentation)

META (Xerox Metacode)

To do this for a Chain directory Go to

Add To Add a Chain Directory

Edit To Edit a Chain Directory

Remove To Remove a Chain Directory

Important Before you specify a UNIX directory path for a Chain type, you must first specify the 
equivalent DOS directory path.
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DCD (Docucorp Compound Document)

DTF (Docuflex text format)

4. Do the following:

5. If you're finished adding Chain directories, choose Done.

The object lists the new directory in the ... Chain Directories list box, and creates 
entries similar to the following in the Library INI file:

To Edit a Chain Directory

1. If you have the UNIX view enabled, choose the Edit DOS button in the Chain 
Directories assigned to... window.

2. In the list box of the Chain Directories assigned to... dialog, select the name of 
the Chain directory to change.

3. Choose the Edit button.

To Do this

(Required.) Specify a Windows path to hold the 
Chain type

• In the Directory text box, enter the MS DOS path where the Chains will be 
located -or-

• Choose the Browse button, and then locate the path to hold the Chains. 
For details about using the Browse feature to specify a Chain directory, 
see To Browse for a Folder.

• Ensure that you have specified the complete path, including the Chain 
type directory  (e.g.,...\ META\).

TIP: If you have not already created the Chain type directory, the object will 
create this directory for you.

• Choose the OK button.

(Optional, and you have the UNIX view turned 
on.) Specify a UNIX directory path to hold the 
Chain type

• Choose the Edit UNIX button.
• Choose the Add button.
• In the ID text box, enter the Chain type to store in the directory (i.e., AFP, 

META, DCD, or DTF).
• In the Directory text box, enter the complete UNIX directory path where the 

Chains will be stored.
• This path must be the UNIX equivalent of the DOS path you specified 

above. For example, if you entered E:\FBEDLS\MREDL\META\ for the 
DOS path, then you must enter /FBEDLS/MREDL/META/ as the UNIX 
path.

• Choose the OK button.

[*MREDL*]
ChnDir=e:\fbedls\mredl\
Chn_ux_Dir=/fbedls/mredl/
METADir=E:\FBEDLS\MREDL\META\
META_ux_Dir=/FBEDLS/MREDL/META/

Important If you want to change a UNIX directory path for a Chain type, you must also change the 
corresponding DOS directory path to the equivalent of the UNIX path.
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The dialog changes into its Edit mode (the Edit DOS view shows in the 
following example).

4. Do the following:

1. If you're finished changing Chain directories, choose Done.

The object lists the changed path(s) in the ... Chain Directories list box, and 
updates the entries in the Library INI file.

To Do this

(Required.) Edit the DOS path for the 
Chain type

• In the Directory text box, edit the DOS path where the Chains are stored.

-or-

• Choose the Browse button, and then locate the path for the Chains. For details about 
using the Browse feature to specify a Chain directory, see To Browse for a Folder.

• Ensure that you have specified the complete path, including the Chain type directory  
(e.g., ...\ META\).

• TIP:  If you have not already created the Chain type directory, the object will create 
this directory for you.

• Choose the OK button.

Edit the UNIX path for the Chain type. 
(You must have the UNIX view turned 
on.)

• Choose the Edit UNIX button.
• Choose the Edit button.
• In the Directory text box, edit the UNIX directory path where the Chains are stored.
• This path must be the UNIX equivalent of the DOS path you specified above. For 

example, if you edited the DOS path to read E:\FBEDLS\META\ , then you must edit 
the UNIX path to read /FBEDLS/META/.

• Choose the OK button.
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To Remove a Chain Directory

1. If you have the UNIX view enabled, and you want to delete a MS DOS directory 
for Chains, choose the Edit DOS button in the Chain Directories assigned to... 
window.

2. In the list box of the Chain Directories assigned to... dialog, select the name of 
the Chain directory to delete.

3. Choose the Remove button.

The following confirmation window appears.

4. To delete the Chain directory, choose the Yes button in response to the 
confirmation message; otherwise choose No.

A dialog similar to the following displays.

.The Copy Chain files... window appears when a Chain directory is edited or 
deleted and Chain files are present.

5. Select OK to continue or Cancel to escape the operation.

6. If you're finished deleting Chain directories, choose Done.

The object deletes directory in the ... Chain Directories list box, and removes the 
Chain directory entries in the Library INI file.

Important If you remove a DOS directory path for a Chain type, you should also remove the 
equivalent UNIX path.
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Generating a Library Report

Use the Library>Generate a Report command to produce reports that contain the 
following possible items of information about members: 

The Member names and revision numbers

Member descriptions

Effective dates

Modification date and times

Document Type Number (DTN)s

Chains

To Generate a Library Report

• From the Library menu, select Generate a Report....

Because you can use the Generate Report menu to print basic and custom 
reports, and define reporting styles, this guide provides separate topics for each 
procedure.

To Generate a Basic Library Report

1. From the Library menu, select Generate a Report..., then select Basic 
Report....

-or-

From the Tool Bar, click on the  (Generate Report) icon.

The Basic Report File window appears.

To See this topic

Print a basic (default) report To Generate a Basic Library Report

Print a custom report To Generate a Custom Library Report

Define and maintain custom reporting Styles To Edit Report Styles
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2. In the Save In drop-down list box, use the mouse to select a folder in which to 
store the report.

3. In the File Name text box, type the name of the report.

4. In the Save As Type drop-down list box, use the mouse to select the appropriate 
file type (Text file should be selected).

5. To start generating the report, choose the Save button. Otherwise, choose the 
Cancel button.

The object generates the basic Library report.

To Generate a Custom Library Report

1. From the Library menu, select Generate a Report, then select Custom 
Report....

The Select a Report Style window appears.

2. From the Style drop-down list box, use the mouse or arrow keys to choose a 
Style to use.

3. Choose the Ok button.

The Custom Report File window appears.

4. In the Save In drop-down list box, use the mouse to select a folder in which to 
store the report.

5. In the File Name text box, type the name of the report.

6. In the Save As Type drop-down list box, use the mouse to select the appropriate 
file type (Text file should be selected).

7. To start generating the report, choose the Save button. Otherwise, choose the 
Cancel button.

Library Setup generates the custom Library report.
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To Edit Report Styles

Use the Library>Edit Report Styles command to specify which Library items you 
want to include, plus the sorting order for the items on the Library report.

• From the Library menu, select Generate a Report, then select Edit Report 
Styles....

The Report Style Editor window appears.

Because you can use the Report Style Editor window to view, create, modify, or 
delete report Styles, this guide provides separate topics for each procedure.

To Create a Report Style

1. Click Add Style in the Report Style Editor window.

If you need to See

Create a Report Style To Create a Report Style 

Modify a Report Style To Modify a Report Style 

View the selection criteria associated with a Report 
Style

To View a Report Style 

Save a Report Style To Save a Report Style 

Delete a Report Style To Delete a Report Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Style Editor To Close the Report Style Editor 
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The Add a new Report style window appears.

2. Type the name of the report style you want to create, and then click OK.

You’re returned to the Report Style Editor dialog. For more information about 
modifying a report style, see To Modify a Report Style.

To Modify a Report Style

1. If the desired Report Style isn’t displayed in the Report Style Editor window, see 
To View a Report Style.

The display items and sorting criteria associated with the Style, along with a 
sample of the formatted report, are displayed in the Report Style Editor window.

2. To view a sample of the report, use the scroll bar in the Example group box.

3. In the Report Style Editor window, do any of the following until the Example 
group box contains the desired items and sequence of items.    

4. To specify a sort key, choose one of the items in the Sorting drop-down list.

5. To specify a sorting order, choose one of the following option buttons:

Ascending (from lowest to highest value)

Descending (from highest to lowest value)

6. To view a sample of the report, use the scroll bar in the Example list box.

To Do this:

Include a category in the Report Style 1 In the Fields group box, highlight the item you want to include in the Report 
Style.

2 Select the item by clicking in the check box.
The new item displays in the Example group box.

Adjust the sequence of categories in the 
Report Style

1 In the Fields group box, highlight the item whose order in the sequence you 
want to adjust.

2 If you want to promote the item (move it toward the top of the list), click the 
 arrow.

3 If you want to demote the item (move it toward the bottom of the list), click the 
 arrow.

The current item displays in its new location and the display in the Example 
group box is updated.

Remove a category from the Report Style 1 In the Fields group box, highlight the item you want to remove from the 
Report Style.

2 Remove the item by clicking in the check box.
The display in the Example group box is updated.
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7. Do any of the following:

To View a Report Style

1. From the Style drop-down list box, use the mouse or arrow keys to choose a 
Style to view.

The selection conditions associated with the Style display in the Report Style 
Editor window.

2. Do any of the following:

To Save a Report Style

1. To save the Style, choose the Save Style button.

Library Setup saves the Report Style.

2. Do any of the following:

To Delete a Report Style

1. If the desired Report Style isn’t displayed in the Report Style Editor window, see 
To View a Report Style.

2. In the Report Style Editor window, choose the Delete Style button. The Delete 
a Report Style window appears.

3. Click Yes to delete the Style; otherwise, click No to cancel.

Library Setup deletes the Report Style.

If you need to See

Save a Report Style To Save a Report Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Style Editor To Close the Report Style Editor 

If you need to See

Modify a Report Style To Modify a Report Style 

Delete a Report Style To Delete a Report Style 

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Style Editor To Close the Report Style Editor 

If you need to See

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Style Editor To Close the Report Style Editor 
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4. Do any of the following:

To Clear a Report Style

• In the Report Style Editor window, choose the Clear button.

The Report Style Editor clears all previous settings.

To Close the Report Style Editor

• In the Report Style Editor window, choose the Done button.

Library Setup returns to the main Library Setup window.

To View Information about a Library

Use the Library>Properties command to view identifying and historical information 
for a Library. 

1. Select the Library name in the Library panel.

2. From the Library menu, select Properties.

-or-

From the Tool Bar, click on the  (Library Properties) icon.

-or-

Press F8.

The Properties-Library window displays.

If you need to See

Clear the current specifications and start entering 
settings for a new Style

To Clear a Report Style 

Close the Report Style Editor To Close the Report Style Editor 

Note The following dialog shows an item for UNIX-based Libraries. Unless you have the UNIX 
view turned on, the dialog you see will not have the UNIX-related item.

You need the UNIX view only if you’re working with a UNIX-based Oracle product that 
uses File-based EDLs. For details about turning the UNIX view on or off, see About 
Setting File-Based EDL Preferences.
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3. When you’re finished viewing the information, close the window.

To Create a Member

Use the Library>New Member command to add a new form to the currently opened 
Library. 

1. From the Library menu, choose Member, then choose New Member.

-or-

From the Tool Bar, click on the  (New Member) icon.

-or-

In the left panel, select the EDL, and then press F5 or INSERT.

The New Member window appears.

2. Type a name for the new Member (up to 32 characters), and then press the TAB 
key.

3. Type a brief (up to 36 characters) description that identifies the Member within 
the Library, and then press the TAB key.

4. If today's date is not the effective date (the date on which you plan to begin using 
the Member) you want for the Member, type an effective date for the Member in
(MM-DD-YYYY format), and then press the TAB key.

5. Type one or more Document Type Numbers (DTN) for the Member, each can 
be up to 5 digits in length and can be separated by spaces and/or commas.

6. Check to ensure that you have made the required entries, and then choose OK to 
save the changes or Cancel to exit.

The object creates the Member you specified. At this point, the Member is 
empty. That is, there are no Chains associated with this Member.
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To Add a Chain File to a Member

Use the Library>Add file to Member command to add new Chains to a Member. As 
a standard convention, you should use the following Chain names when adding new 
Chains to a Member:

• AFP — IBM AFP forms (.AFP file type)

• MET — Xerox Metacode forms (.MET file type)

• DCD — Docucorp Compound Document (.DCD file type)

• DTF — Docuflex (Docuword) Text Format (.DTF file type)

To load a new form Chain, you must specify its DOS file source. This includes the 
file name, type, and the drive and folder (path) for the file.

1. If the members of the current Library aren’t visible, click the left mouse button 
on the plus sign —  — next to the name of the Library, and then select the 
Member to which you want to add a Chain file.

2. From the Library menu, select Member, then select Add file to Member

-or-

From the Tool Bar, click the (Add Chain to Member) icon.

-or-

In the left panel, select the Member, and then press F5 or INSERT.

The Add a new Chain to... window appears.

3. From the Chain ID drop-down list, choose the type of Chain that you want to 
add a file for:

AFP (IBM Advanced Function Presentation)

MET (Xerox Metacode)

DCD (Docucorp Compound Document)

DTF (Docuflex text format)

4. Do one of the following:

• Enter the path for the file that contains the Chain in the Chain File text box.
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-or-

• Choose the Browse button.

The Select a Chain file window appears.

5. Do the following, as required:

The dialog closes and returns to the Add a new Chain to... window, where the 
path and file name you've specified appear in the Chain file text box.

6. From the Chain Type drop-down list, choose one of the following:

• Stream oriented file (PC/UNIX) — for client-server formats like DCD and 
DTF.

• Record oriented file (mainframe) — Typically, AFP and Metacode file 
types are Record-Oriented file types, regardless of your operating platform.

7. Choose the OK button.

The object adds the Chain file to the Member.

To Create a New Member Revision

Use the Create a new revision command to make a copy of an existing Member. The 
new revision contains all information about the original, but is assigned then next 
number in sequence (e.g., DecPage_12_1998(1) becomes DecPage_12_1998 (2)).

1. If the members of the current Library aren’t visible, click the left mouse button 
on the plus sign —  — next to the name of the Library in the Library panel.

This action expands the tree-and-branch view of the Library and its members.

2. In the Library panel, select the Member name for which you want to create a new 
revision.

3. From the Library menu, choose Member, then choose Create a new revision.

If Do this

The incorrect drive or folder shows in the 
Look in text box

Click the arrow on the right of the Look in text box, and then select the drive and/
or folder where the Chain file is located.

The correct folder doesn't show in the Look 
in list box

In the Look in list box, scroll to see more folders, or double-click a root folder to see 
its subfolders.

The correct Chain file name doesn't show 
in the Look in list box

In the Look in list box, double-click the correct folder to see its contents.

The name of the Chain file doesn't show in 
the File name text box

In the Look in list box, click to select the Chain file to place it in the File name text 
box.

The correct file type for the Chain file 
doesn't show in the Files of Type drop-
down list

From the Files of Type drop-down list, choose the appropriate one of the following 
file extensions:

• AFP (IBM Advanced Function Presentation)
• MET (Xerox Metacode)
• DCD (Docucorp Compound Document)
• DTF (Docuflex text format)

You want to add the Chain file indicated by 
the current specifications

Choose the Open button.
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-or-

From the Tool Bar, click on the  (Create Revision) icon.

-or-

Press F9.

The object creates a new revision with the next number in sequence, and displays 
it in both the Library and Contents... panels..

To Delete the Contents of a Member

Use the Empty a Member command to remove old, unused Chains from a Member. 

1. If the members of the current Library aren’t visible, click the left mouse button 
on the plus sign —  — next to the name of the Library in the Library panel.

This action expands the tree-and-branch view of the Library and its members.

2. Highlight the Member name in the Library panel.

3. From the Library menu, select Member, then select Empty a Member

-or-

From the Tool Bar, click on the  (Empty Member) icon.

An Empty Member window similar to the following displays.

4. Verify that the Member name is correct.

5. Choose Yes to delete the contents. Otherwise, choose No.

If you chose Yes, the object empties the selected Library Member, leaving the 
Member itself in the Library.

To Delete a Member, Members, or a Range of Members

Use the Delete a Member command to remove old, unused forms from a Library. 

1. If the members of the current Library aren’t visible, click the left mouse button 
on the plus sign —  — next to the name of the Library in the Library panel.

This action expands the tree-and-branch view of the Library and its members.

2. Do one of the following:

To delete Do this

A single Member Select the Member in the Library panel.
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3. From the Library menu, choose Member, then choose Delete a Member.

-or-

From the Tool Bar, click on the  (Delete Member) icon.

-or-

Press F6 or DELETE.

Either the Delete Member or Delete multiple members ... window appears.

4. Verify that the reported Member name or number of members is correct.

5. Choose Yes to delete the Member(s). Otherwise, choose No.

The object deletes the selected Library Member(s) and Chains.

To Rename a Member

Use the Rename a Member command to specify another name for a Library Member.

1. If the members of the current Library aren’t visible, click the left mouse button 
on the plus sign —  — next to the name of the Library in the Library panel.

2. Highlight the Member name in the Library panel.

3. From the Library menu, select Member, then select Rename a Member

-or-

From the Tool Bar, click on the  (Rename Member) icon.

-or-

Press F7.

The object selects the current name for the Member, which allows you to change 
it.

4. Type a new name for the Member and press ENTER.

The object renames the Library Member. The revision level for the Member 
(stored in the Member name) is automatically reset after the Member is renamed.

A range of members at the same time Select the first or last Member in the range, and then hold down the SHIFT key 
while you select the last or first Member in the range (selects all members in the 
range).
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To View Information about a Member

Use the Member>Properties command to view or edit identifying and historical 
information for a Member.

1. If the members of the current Library aren’t visible, click the left mouse button 
on the plus sign —  — next to the name of the Library in the Library panel.

2. Highlight the Member name you want to see information about.

3. From the Library menu, select Member, then select Properties.

-or-

From the Tool Bar, click on the  (Member Properties) icon.

-or-

Press F4.

The Properties-Member window displays.

4. When you’re finished viewing or editing the information, close the window.

To Edit Do this

Description Delete the existing description, and enter the new description.

Effective Date 1 Press TAB until you are in the Effective Date field you need to edit.

2 Delete the existing month, day, and/or year.

3 Enter a new date.

4 Press TAB and repeat steps if you need to edit another field in the row.

Modification Date 1 Press TAB until you are in the Modification Date field you need to edit.

2 Delete the existing month, day, and/or year.

3 Enter a new date.

4 Press TAB and repeat steps if you need to edit another field in the row.

DTNs 1 Press TAB until you are in the DTNs field.

2 Delete the DTN.

3 Enter a new DTN.
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To Find a Member

Use the Options>Find command to search for and display the location of a particular 
Member. You can limit the action of the Find command to occurrences of the text 
that have the capitalization pattern specified in your entry. The Find command's 
action is limited to Member names.

1. From the Options menu, choose Find.

-or-

Press CTRL + F.

The Find window appears.

2. In the Member Name text box, type the name of the Member (up to 32 
characters) to find.

-or-

If you’re not sure of the complete Member name, you can try entering a string of 
characters that are part of the name, combined with one or more of the following 
wild card characters:

* (asterisk) to represent two or more characters

? (question mark) to represent one alphabetic character

# (pound sign) to represent a single number

For example, if you’re trying to find a Member, and you know it contains the 
string "Meta", then you could enter *Meta*, and the Find command will locate 
all Members that contain that string any where in the Member name, including 
Members with names such as  EndorseMeta, EndorseMetaOverlay, 
MetaDec, etc. 

3. In the Revision text box, type the revision number of the Member (up to 5 
characters) to find.

-or-

If you don’t know the revision number, you can enter a # (pound sign) wild card 
character in the Revision text box.

4. To find only words having the pattern of upper/lower case letters that you’ve 
specified, choose the Match Case check box.

5. Choose the Find button to begin searching.

The object finds the first instance of the string you specified, and displays it in 
both panes. It will also notify you when it has searched the whole EDL and 
cannot find the specified Member.

About Dumping a Chain

Use the Save As command when you want to dump (extract and store) a Chain of a 
form Member that resides in a Library. Library Setup dumps the Chain into a disk 
file. If associated with the form Member, you can dump any of the following Chains, 
one Chain at a time. 



Chapter 5 – 

147

• MET (Xerox Metacode) — contains the Metacode print stream for a form.

• AFP (IBM Advanced Function Presentation) — contains the AFP print 
stream for a form.

• DCD (Docucorp Compound Document) — contains document objects in a 
tree structure

• DTF (Docuflex / Docuword Text Format) — contains the data stream of a 
form composed in Docuword.

For example, you can use the Save As command to extract a form’s Metacode Chain 
for export to you host system Xerox printer.

To Dump a Chain

1. If the Chains from the current Library aren’t visible, click the left mouse button 
on the plus sign next to the name of the Library, then on the plus sign next to 
the name of the Member.

This action expands the tree-and-branch view of the Library, members, and 
Chain.

2. Click the right mouse button on the desired Chain, and choose Save As.

The Save As window appears.

3. In the Save In drop-down list box, use the mouse to select a folder into which to 
dump the Chain.

4. In the File Name text box, type the name of the file to receive the Chain.

5. In the Save As Type drop-down list box, use the mouse to select the appropriate 
file type.

Tip Some of your Library members can be forms which originally come from your host 
system in a variable blocked format. When you dump one of these members, you have 
the option of preserving the variable blocked record format or transferring them Member 
unformatted.
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Typically, AFP and Metacode file types are "Record Oriented file" types, 
regardless of your operating platform.

6. To start storing the Chain, choose the Save button. Otherwise, choose the Cancel 
button.

Library Setup stores the form Chain in the file type you specified.

About Deleting a Chain

Use the Delete a Chain command when you want to delete one or more of the Chains 
of a form that resides in a Library. For a form Member, you can delete any of the 
following Chains: 

• MET (Xerox Metacode) — contains the Metacode print stream for a form.

• AFP (IBM Advanced Function Presentation) — contains the AFP print 
stream for a form.

• DCD (Docucorp Compound Document) — contains document objects in a 
tree structure

• DTF (Docuflex / Docuword Text Format) — contains the data stream of a 
form composed in Docuword.

For example, you can delete the Metacode or AFP Chain for a form if you no longer 
need it because you always use a local HP printer. Thus, you only need the IMF and 
IRF Chains.

To Delete a Chain

1. If the Chains of the current Library aren’t visible, click the left mouse button on 
the plus sign —  — next to the name of the Library, then on the plus sign next 
to the name of the Member. 

This action expands the tree-and-branch view of the Library, members, and 
Chains.

2. Highlight the Chain name in the Library panel.

3. From the Library menu, select Member, select Chain, then select Delete a 
Chain.

-or-

From the Tool Bar, click on the  (Delete Chain) icon.

-or-

Press F6 or DELETE.
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A query dialog similar to the following displays to prompt you to verify the 
deletion.

4. Choose Yes to delete the Chain; otherwise, choose No.

If you chose Yes, the object deletes the Chain.

To Rename a Chain

Use the Rename a Chain command to specify another name for a Member’s Chain. 

1. If the Chains of the current Member aren’t visible, click the left mouse button on 
the plus sign —  — next to the name of the Member.

This action expands the tree-and-branch view of the Member and its Chains.

2. Highlight the Chain name in the Forms Library panel.

3. From the Library menu, select Member, select Chain, then select Rename a 
Chain.

-or-

From the Tool Bar, click on the  (Rename Chain) icon.

-or-

Press F7.

The object selects the current name for the Chain, which allows you to change it.

4. Type a new name for the Chain, and press ENTER.

The object renames the Chain.

To View Information about a Chain

Use the Chains>Properties command to view identifying and historical information 
for a Chain.

1. If the Chains of the current Library aren’t visible, in the Library panel, click the 
left mouse button on the plus sign —  — next to the name of the Library, then 
on the plus sign next to the name of the Member that contains the Chain for 
which you want to view information. 

This action expands the tree-and-branch view of the Library, members, and 
Chains.

2. Highlight the Chain name in the Library panel.

3. From the Library menu, select Member, select Chains, then select Properties.
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-or-

From the Tool Bar, click on the  (Chain Properties) icon.

-or-

Press F4.

The Properties-Chain window displays.

4. When you’re finished viewing the information, close the window.

Note The following dialog shows an item for UNIX-based Chains. Unless you have the UNIX 
view turned on, the dialog you see will not have the UNIX-related item.

You need the UNIX view only if you’re working with a UNIX-based Oracle product that 
uses File-based EDLs. For details about turning the UNIX view on or off, see About 
Setting File-Based EDL Preferences.
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ABOUT SETTING FILE-BASED EDL PREFERENCES
The Options window contains two tabs. You can customize certain settings for your 
Library by specifying items in panels under these tabs.

To Use an Option Tab

• Do any of the following:

Using the Preferences Tab

Use the Preferences tab in the Tools-Options menu to customize the File-based EDL 
objects for your working environment. You can set the following preferences:

• Always start-up opening the last Library that was accessed — selecting this 
option saves you the step of opening your working Library every time you start 
the object.

• Sort Library members by name — deselecting this option (by default, the 
object sorts EDL Member names alphabetically) causes the members to appear 
in the order that they were added to the Library.

• Enable fields and dialogs that are specific to UNIX users — selecting this 
option transforms text boxes and other window elements so that you can create 
and maintain File-based EDLs with correct UNIX directory syntax. Set this 
option only if you use Documaker fp for UNIX.

To Activate the Preferences Panel

• If the Preferences panel isn’t already showing in the Options window, click on 
the Preferences tab.

To specify Go to this topic

Viewing and platform preferences Using the Preferences Tab

Backup preferences Using the Backup Tab
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The Preferences panel displays.

To Set File-Based EDL Viewing and Platform Preferences

1. Do one of the following:  

2. Do one of the following: 

3. Do one of the following:

To let you display and update UNIX-related information, the object changes 
items (and therefore the associated procedures) for the following dialog boxes:

• Add a new Library — for details about adding a new UNIX-based Library, 
see To Create a Library.

To Do this

Open the last Library accessed the next 
time you start the object

Select the Always start-up opening the last Library that was accessed check 
box

Not open any Library on startup Deselect the Always start-up opening the last Library that was accessed 
check box

If you want to sort members Do this

Alphabetically Ensure that the Sort Library members by name check box is selected

Non-alphabetically Deselect the Sort Library members by name check box

To Do this

Enable UNIX items Select the Enable fields and dialogs that are specific to UNIX users check box

Disable UNIX items Deselect the Enable fields and dialogs that are specific to UNIX users check 
box
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• UNIX tab of Restore/Import a Library from a VLAM backup file ... — 
for details about restoring/importing UNIX-based Libraries, see To Import 
to a New Library or Restore to an Existing Library.

• Chain directories assigned to: — for details about assigning UNIX-based 
Chain directories, see About Specifying Library Chain Directories.

• Properties for members or Chains — for details about viewing UNIX-based 
Library and Chain properties, see To View Information about a Library, or 
see To View Information about a Chain.

4.  To set the options you selected and close the dialog, choose OK. Otherwise 
choose Cancel.

Using the Backup Tab

Use the Backup tab in the Tools-Options menu to customize the File-based EDL 
objects for your working environment. You can specify to create a log file with status 
information every time you create a backup copy of your Library.

To Activate the Backup Panel

• If the Backup panel isn’t already showing in the Options window, click on the 
Backup tab.

The Backup panel displays.

To Set File-Based EDL Backup Preferences

1. Enable the check box if you want to create a log file every time you make a 
backup copy of your Library. 

Note To start setting up UNIX Libraries, see .To Create the File-Based EDL Database and 
Your First Library
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This log file contains statistical information about your Library and is useful in 
troubleshooting problems you might encounter.

2. In the File text box, type the name you want to give to your log file.

3. To set the options you selected and close the dialog, choose OK. Otherwise 
choose Cancel.

The File-Based EDL object creates a log file the first time you back up your Library; 
thereafter, information is appended to the end of the log file. Doing so maintains a 
running information file about your Library.

To View the Log File

• You can use your favorite text editor to view the log file by double-clicking on 
it from the Windows Explorer.

THE VLAMUSER API (VLAMUSER.W32)
VLAMUSER is a DLL that lets you

• Access selected pcVLAM functions for maintenance of EDLs.

The functions within VLAMUSER.DLL integrate many low level pcVLAM 
function calls to give the calling application a higher level of access.

• Use pcVLAM with non-C++ calling applications

Earlier versions of pcVLAM were developed with C++, and most applications 
were not able to provide the proper C++ objects when calling functions from 
these older versions of pcVLAM. 

Limitations with File-Based EDL Support

File-Based EDL does not support the following functions:

File-Based EDL
Does Not Have Function effected Effect

AFP and Metacode conversion 
support

• LoadForm() and 
LoadFormEx() with a process type 
0 and 1 

• ConvertOneForm()
• ConvertAllForms()

Does not generate IMF or IRF Chains

AppInfo support • LoadForm()
• LoadFormEx()
• LoadPackage()
• LoadPackageEx()
• LoadChain()
• LoadChainEx()
• AlterMember()
• AlterMemberEx()

Ignores pass AppInfo data 

Password support • AlterMember()
• AlterMemberEx()

Ignores pass password data 
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Currently Supported Functions

Library modification date 
support

• GetLibraryModTime() 
• GetLibraryModTimeEx()

Does not function because there is no date data 
to look for

Backup and restore support • BackupLibrary()
• BackupLibraryEx()
• RestoreLibrary()

Does not restore or backup Library

SQL syntax parsing support "WHERE" query argument of 
GetMemberInfo()

Lists all members

File-Based EDL
Does Not Have Function effected Effect

Function Action

AlterMember Alters Member description, DTN, etc.

AlterMemberEx Same as AlterMember but with a long definition for the DTN argument

BackupLibrary Creates a VLAM Backup file

BackupLibraryEx Uses SQL WHERE clause to selectively include members in a VLAM Backup file

ConvertAllForms Converts all form members for screen display

ConvertOneForm Converts a form Member for screen display

DeleteChain Deletes a Chain of a Member in a Library

DeleteMember Deletes a Member from a Library

DumpChain Dumps a Chain of a Member in a Library to a DOS file

FindHighRevision Finds the highest existing revision for a Member

GetErrorMsgText Returns text message associated with error codes

GetFormCount Retrieves a list of the forms and returns the count

GetFormInfo Returns DOT height, number of pages and number of tags of a selected form

GetFormNameDesc Returns the Name, Revision, Description and DTN of a selected form

GetLibraryModTime Returns time and date that the Library was last modified

GetMemberInfo Fills list boxes with requested Member information

GetTagInfo Returns tag information of selected tag

InitVLAMUser Initializes a VLAM object; initializes a Library object and opens it with the requested 
name 

InitVLAMUserEx Same as InitVLAMUser but also accepts the support type and a boolean to indicate if 
the Library will be opened read only

LoadChain Loads a Chain to a Member in a Library

LoadChainEx Same as LoadChain but with a long definition for the DTN argument

LoadForm Loads an AFP or Metacode form to a Library (with or without conversion)

LoadFormEx Same as LoadForm but with a long definition for the DTN argument

LoadIDP Loads a Document Package to a Library

LoadMember Loads a Chain of a Member in a Library

LoadPackage Loads a Document Package to a Library
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Each VLAMUSER function is alphabetically listed and explained in the following 
pages.

AlterMember / AlterMemberEx

Alters Member description, DTN, effective date, application info, read, and write 
password fields. The AlterMemberEx function accepts a long integer argument for 
the DTN value.

LoadPackageEx Same as LoadPackage but with a long definition for the DTN argument

RestoreLibrary Restores members from a VLAM Backup file

SetLibrary Sets the active VLAM Library

SetLibraryEx Allows a new Library to open with a boolean read only indicator

TermVLAMUser Closes the open Library; destroys Library and VLAM objects

ValidatepPtrTbl Checks the validity of initialization information

Function Action

C Function 
Prototype

int AlterMember( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR Desc, int DTN, LPSTR EffDate, LPSTR AppInfo,
LPSTR ReadPassWord, LPSTR WritePassWord );

Visual Basic 
Declare
AlterMember

Declare Function AlterMember Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%, ByVal Desc$,
ByVal IntDTN%, ByVal EffDate$, ByVal AppInfo$, ByVal Action%,
ByVal ReadPassWord$, ByVal WritePassWord$) As Integer

Visual Basic 
Declare
AlterMemberE
x

Declare Function AlterMemberEx Lib "VLAMUSER.W32" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision As Integer,
ByVal Desc$, ByVal DTN As Long, ByVal EffDate$,
ByVal AppInfo$, ByVal Action As Integer,
ByVal ReadPassWord$, ByVal WritePassWord$) As Integer

Parameters
void* pPtrTbl FAR
void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR Desc
Address of NULL terminated string with description of Member

Int DTN
Integer Document Type Number for Member

LPSTR EffDate
Address of NULL terminated string with effective date for Member in MM/DD/YY format

LPSTR AppInfo
Address of NULL terminated string 80 character application information 

LPSTR ReadPassWord
Address of NULL terminated string 8 character Read Password. Pass "NOCHANGE" if this field should not be 
altered.

LPSTR WritePassWord
Address of NULL terminated string 8 character Write Password. Pass "NOCHANGE" if this field should not be 
altered.
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BackupLibrary

Creates a VLAM backup file containing the members in a Library.

BackupLibraryEx

Uses a SQL WHERE clause to selectively include members in a VLAM Backup 
file.

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int BackupLibrary( void *pPtrTbl, LPSTR BackupFile );

Visual Basic 
Declare

Declare Function BackupLibrary Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal BackupFile$) As Integer

Parameters void* pPtrTbl FAR
void pointer that was initially passed to InitVLAMUser

LPSTR BackupFile
Address of NULL terminated string naming DOS file to receive backed up members

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_BACKUP_FAILED(161)
Backup failed

Caution When coding this function, you must provide the correct SQL WHERE syntax and 
values, including the PC VLAM database column names, which you can get by 
executing the ISQL Select * from PCVLAM.edlname statement.

C Function 
Prototype

int BackupLibraryEx( void *pPtrTbl, char * BackupFile, char * 
WhereClause )

Visual Basic 
Declare

Declare Function BackupLibraryEx Lib "VLAMUSER.W32" (ByVal 
pPtrTbl&, ByVal BackupFile$, ByVal WhereClause$) As Integer

Parameters void* pPtrTbl FAR
void pointer that was initially passed to InitVLAMUser

LPSTR BackupFile
Address of NULL terminated string naming DOS file to receive backed up members
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ConvertAllForms  

Converts AFP or Metacode forms for screen display. If fNewFormsOnly is TRUE, 
then only those forms that have not already be converted for screen display will be 
converted.

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_BACKUP_FAILED(161)
Backup failed

Example Calls retcode = BackupLibraryEx( pPtrTbl&, gBackupFileName, "WHERE 
(NAME='Z123AB-94')" )
retcode = BackupLibraryEx( pPtrTbl&, gBackupFileName, "WHERE 
(NAME='Florida Restrictions') OR (NAME='Montana Changes')" )
recode = BackupLibraryEx( pPtrTbl&, gBackupFileName, "WHERE 
(MOD_DATE> [d'2000-01-23 00:00:00.000000'] )" )

C Function 
Prototype

int ConvertAllForms( void *pPtrTbl, int fNewFormsOnly );

Visual Basic 
Declare

Declare Function ConvertAllForms Lib "VLAMUSER.DLL" (ByVal 
pPtrTbl&,
ByVal NewFormsOnly%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

IInt fNewFormsOnly
Integer boolean value indicating which forms should be converted

Return Codes V_SUCCESS(0)
Success

V_WARNING(4)
Default fonts were used during conversion

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_NO_META_OR_AFP_CHAIN(133)
Member did not have a META or AFP Chain

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_INV_PFORMCVT(153)
Address of conversion object was not valid; be sure to call InitFormCvrt before converting form to screen 
format

V_ERR_FORMCVT_FAILED(154)
Conversion Failed; possibly invalid DJDE information if Metacode
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ConvertOneForm    

Converts an AFP or Metacode form specified by Member (Revision).

DeleteChain

Deletes the specified Chain of the Member specified by MemName (Revision).

C Function 
Prototype

int ConvertOneForm( void *pPtrTbl, LPSTR MemName, int Revision );

Visual Basic 
Declare

Declare Function ConvertOneForm Lib "VLAMUSER.DLL" (ByVal 
pPtrTbl&, ByVal memname$, ByVal MemRevision%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

Return Codes V_SUCCESS(0)
Success

V_WARNING(4)
Default fonts were used during conversion

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_NO_META_OR_AFP_CHAIN(133)
Member did not have a META or AFP Chain

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_INV_PFORMCVT(153)
Address of conversion object was not valid; be sure to call InitFormCvrt before converting form to screen 
format

V_ERR_FORMCVT_FAILED(154)
Conversion Failed; possibly invalid DJDE information if  Metacode

C Function 
Prototype

int DeleteChain( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR Chain );

Visual Basic 
Declare

Declare Function DeleteChain Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%, ByVal ChainName$)
As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR Chain
Address of NULL terminated string 4 character Chain name

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened
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DeleteMember

Deletes the Member specified by MemName(Revision).

DumpChain

Dumps the specified Chain of the Member specified by MemName(Revision) to the 
DOS file specified by DumpFile.

V_ERR_CHAIN_NOT_EXIST(113)
Chain does not exist

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int DeleteMember( void *pPtrTbl, LPSTR MemName, int Revision );

Visual Basic 
Declare

Declare Function DeleteMember Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_NOT_EXIST(103)
Member does not exist

V_ERR_MEM_NOT_DEL(130)
Member was not deleted

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int DumpChain( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR Chain, LPSTR DumpFile );

Visual Basic 
Declare

Declare Function DumpChain Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%, ByVal Chain$,
ByVal DumpFile$) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR Chain
Address of NULL terminated string 4 character Chain name

LPSTR ChainFile
Address of NULL terminated string with filename of DOS file with Chain data
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FindHighRevision

Finds the highest existing revision for the specified Member name.

GetErrorMsgText

Fills MsgBuf with NULL-terminated text message corresponding to iMsgNo. 
Returns length of message text — including terminating NULL — - MAX 128.

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened

V_ERR_CHAIN_NOT_EXIST(113)
Chain does not exist

V_ERR_CHAIN_NOT_DUMPED(132)
Chain was not dumped

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int FindHighRevision( void *pPtrTbl, LPSTR MemName, int *Revision 
);

Visual Basic 
Declare

Declare Function FindHighRevision Lib "VLAMUSER.DLL" (ByVal 
pPtrTbl&,
ByVal memname$, revision%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int* Revision
FAR Integer pointer for receiving revision level

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_NOT_EXIST(103)
Member does not exist

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int GetErrorMsgText( LPSTR MsgBuf, int iBufLen, int iMsgNo );

Visual Basic 
Declare

Declare Function GetErrorMsgText Lib "VLAMUSER.DLL"
(ByVal MsgBuf$, ByVal BufLen%, ByVal MsgNo%) As Integer

Parameters LPSTR MsgBuf
Address of  character buffer to receive NULL terminated error message text

int iBufLen
Integer size of MsgBuf / maximum number of characters that will be placed in MsgBuf
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GetFormCount

Retrieves a list of the forms in the opened Library. Returns the form count.

GetFormInfo

Acquires form and tag information from the selected Chain of the selected form. 
Returns the DOT height, number of pages, and number of tags. Supports retrieving 
information from the AFP, DCD, DTF, IRF or META Chain of a Member.

Return value The number of characters including the terminating NULL which were placed in the MsgBuf

C Function 
Prototype

int GetFormCount( void *pPtrTbl, int *Count );

Visual Basic 
Declare

Declare Function GetFormCount Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
count%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

int* Count
Address of integer variable to receive form count

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int GetFormInfo( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR Chain, LPSTR TempPath, int *DOTHeight,
int *Pages, int *NumTags );

Visual Basic 
Declare

Declare Function GetFormInfo Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal Revision%, ByVal Chain$,
ByVal TempPath$, DotHeight%, Pages%, NumTags%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR Chain
Address of NULL terminated string 4 character Chain name

LPSTR TempPath
Address of NULL terminated string with pathname where Chain file will be located for accessing tag 
information

int* DOTHeight
Address of integer variable to receive height of form; for DTF, DOTHeight and Pages will be -1 since those are 
not known until DTF has been formatted

int* Pages
Address of integer variable to receive page count of form

int* NumTags
Address of integer variable to receive tag count of form

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_NOT_EXIST(103)
Member does not exist
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GetFormNameDesc

Returns the Name, Revision, Description and DTN of the form at position "ndx" in 
the held list of forms filled by the immediate previous call to GetFormCount.

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened

V_ERR_INV_CHAIN(112)
Chain must be AFP, IRF, DCD, or META

V_ERR_CHAIN_NOT_EXIST(113)
Chain does not exist

V_ERR_CHAIN_NOT_DUMPED(132)
Chain was not dumped — Is TempPath valid? )

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_NOT_NORMALIZED(302)
Form is not normalized and does not have index packet

C Function 
Prototype

int GetFormNameDesc( void *pPtrTbl, int ndx, LPSTR Member,
int *Revision, LPSTR Description, long *DTN );

Visual Basic 
Declare

Declare Function GetFormNameDesc Lib "VLAMUSER.DLL" (ByVal 
pPtrTbl&,
ByVal ndx%, ByVal memname$, MemRevision%,
ByVal Desc$, DTN&) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

Int ndx
Index of requested form — 1 - FormCount )

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int* Revision
Address of integer variable to receive revision level of Member

LPSTR Description
Address of 37-character buffer to receive NULL terminated Member description

long* DTN
Address of long variable to receive DTN of Member

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_INVALID_INDEX(300)
Index is out of valid range — 1 - FormCount )
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GetLibraryModTime

Returns the date and time that the active Library was last modified. The date is 
returned in the format MM/DD/YY and the time is returned in the format 
HH:MM:SS.

C Function 
Prototype

int GetLibraryModTime( void *pPtrTbl, LPSTR DateBuf, LPSTR TimeBuf 
);

Visual Basic 
Declare

Declare Function GetLibraryModTime Lib "VLAMUSER.DLL"
(ByVal pPtrTbl&, ByVal ModDate$, ByVal ModTime$) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR DateBuf
Address of  9 character buffer to receive NULL terminated Library modification date

LPSTR TimeBuf
Address of  9 character buffer to receive NULL terminated Library modification time
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GetMemberInfo

Fills up to three list boxes with specified Member information for members matching 
the query. Each listbox is cleared before data is added. Passes a NULL handle for 
each unneeded list box.

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int GetMemberInfo( void *pPtrTbl, LPSTR Query, HWND hLB1, int 
Disp1,
HWND hLB2, int Disp2, HWND hLB3, int Disp3 );

Visual Basic 
Declare

Declare Function GetMemberInfo Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal QueryString$, ByVal hWnd1%, ByVal Display1%,
ByVal hWnd2%, ByVal Display2%, ByVal hWnd3%,
ByVal Display3%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR Query
Address of NULL terminated string  SQL query 

HWND hLB1
Handle to listbox to be filled

int Disp1
Display option to identify column(s) to be shown in list box

HWND hLB2
Handle to listbox to be filled

int Disp2
Display option to identify column(s) to be shown in list box

HWND hLB3
Handle to listbox to be filled

int Disp3
Display option to identify column(s) to be shown in list box

Display Options The display option passed for each list box must be the sum of one or more of the following:

V_DISP_NAME 1

V_DISP_REV 2

V_DISP_DESC 4

V_DISP_AUTHOR 8

V_DISP_CREATION_DATE 16

V_DISP_EFF_DATE 32

V_DISP_DTN 64

V_DISP_ACCESS_COUNT 128

V_DISP_LOCK_USERID 256
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GetTagInfo

Returns the tag information of the tag at position "ndx" in the tag count acquired by 
the immediate previous call to GetFormInfo.

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_NONE_MATCH_QUERY(155)
No members in Library match the query

C Function 
Prototype

int GetTagInfo( void *pPtrTbl, int ndx, LPSTR TagName,
int *Len, char *ReplChar, char *DELYN,
har *MandOpt, char *LineEnd );

Visual Basic 
Declare

Declare Function GetTagInfo Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal ndx%, ByVal TagName$, TagLen%, ByVal ReplChar$,
ByVal DELYN$, ByVal MandOpt$, ByVal LineEnd$) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

int ndx
ndex of requested tag — 1 - NumTags )

LPSTR TagName
Address of  31-character buffer to receive NULL terminated tag name

int* Len
Address of integer variable to receive number of replacement characters; for DTF, Len will be -1 since VSDs 
do not have a defined length

char* ReplChar
Address of char (1 byte) to receive the replacement character

char* DELYN
Address of char (1 byte) to receive delete indicator Y/N

char* MandOpt
Address of char (1 byte) to receive mandatory indicator M/O

char* LineEnd
Address of char (1 byte) to receive line end character

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_INVALID_INDEX(300)
Index is out of valid range — 1 - NumTags )

V_ERR_TAGS_NOT_INIT(301)
No call to GetFormInfo has been made
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InitVLAMUser

Initializes a VLAM object, initializes a Library object and opens it with the requested 
name. This function must be called before other functions are called so the calling 
application will have access to a valid Library. TermVLAMUser should be called when 
all processing is completed.

InitVLAMUserEx

Initializes a VLAM object, initializes a Library object, and opens it with the 
requested name. Compared to InitVLAMUser, InitVLAMUserEx accepts two 
additional parameters: the support type and a boolean to indicate if the Library will 
be read only. This function must be called before other functions are called so the 
calling application will have access to a valid Library. TermVLAMUser should be 
called when all processing is completed. 

C Function 
Prototype

int InitVLAMUser( LPSTR Library, LPSTR UserID, void **pPtrTbl );

Visual Basic 
Declare

Declare Function InitVLAMUser Lib "VLAMUSER.DLL" (ByVal 
LibraryName$,
ByVal UserIDName$, pPtrTbl As Long) As Integer

Parameters LPSTR Library
Address of NULL terminated string 8 character Library Name

LPSTR UserID
Address of NULL terminated string 8 character User ID

void** pPtrTbl
Address of  FAR void pointer for maintaining address of initialization information to be passed to other 
functions

Return Codes V_SUCCESS(0)
Success

V_ERR_LIB_NOT_EXIST(101)
Specified Library was not found

V_ERR_INV_PLIB(151)
Library object not initialized

V_ERR_INV_PVLAM(152)
VLAM object not initialized

C Function 
Prototype

short VUSR_EXPORT WINAPI InitVLAMUserEx( LPSTR Library, LPSTR 
UserID, void**pPtrTbl, short type, short fReadOnly );

Visual Basic 
Declare

Declare Function InitVLAMUserEx Lib "VLAMUSER.DLL" (ByVal 
LibraryName$,
ByVal UserIDName$, pPtrTbl As Long, ByVal sType As Integer, ByVal 
fReadOnly As Integer) As Integer

Parameters LPSTR Library
Address of NULL terminated string 8 character Library Name

LPSTR UserID
Address of NULL terminated string 8 character User ID

void** pPtrTbl
Address of  FAR void pointer for maintaining address of initialization information to be passed to other 
functions

sType
Support type values are: 100 (PCVLAM_TYPE) and 
200 (FILEBASED_TYPE)

fReadOnly
Integer boolean value indicating if the Library will be read only
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LoadChain / LoadChainEx

Loads a DOS file as the specified Chain in the specified Member. The Chain will be 
an unformatted Chain in the Member. The LoadChainEx function accepts a long 
integer argument for the DTN value.

Return Codes V_SUCCESS(0)
Success

V_ERR_LIB_NOT_EXIST(101)
Specified Library was not found

V_ERR_INV_PLIB(151)
Library object not initialized

V_ERR_INV_PVLAM(152)
VLAM object not initialized

C Function 
Prototype

int LoadChain( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR Chain, LPSTR ChainFile, LPSTR Desc, int DTN,
LPSTR EffDate, LPSTR AppInfo, int Action );

Visual Basic 
Declare
LoadChain

Declare Function LoadChain Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%, ByVal ChainName$,
ByVal ChainFile$, ByVal Desc$, ByVal IntDTN%, ByVal EffDate$,
ByVal AppInfo$, ByVal Action%) As Integer

Visual Basic 
Declare
LoadChainEx

Declare Function LoadChainEx Lib "VLAMUSER.W32" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision As Integer, ByVal ChainName$,
ChainFile$, ByVal Desc$, ByVal DTN As Long, ByVal EffDate$,
ByVal AppInfo$, ByVal Action As Integer) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR Chain
Address of NULL terminated string 4 character Chain name

LPSTR ChainFile
Address of NULL terminated string with filename of DOS file with Chain data

LPSTR Desc
Address of NULL terminated string with description of Member

Int DTN
Integer Document Type Number for Member

LPSTR EffDate
Address of NULL terminated string with effective date for Member in MM/DD/YY format

LPSTR AppInfo
Address of NULL terminated string 80 character application information 

Int Action
0 = Add new Member if MemName(Revision) does not exist
Replace MemName(Revision) if it does exist

1 = Add new Member (Fail if it already exists) Creates new high revision if Revision is 0
2 = Replace Member (Fail if it does not exist)
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LoadForm / LoadFormEx   

Converts and/or loads an AFP or Metacode form as the specified Member. The 
required actions are specified by the Action and Process parameters. The 
LoadFormEx function accepts a long integer argument for the DTN value.

Return Codes V_SUCCESS(0)
Success

V_ERR_MEM_EXISTS(102)
Member already exists and Add was specified

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_INV_ACTION(104)
Requested Action was not 0,1 or 2

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened

Return Codes
(cont)

V_ERR_INV_REVISION(111)
Revision was not one that exists or one more than the highest

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_CHAINFILE_NOT_EXIST(203)
ChainFile could not be found

C Function 
Prototype

int LoadForm( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR ObjFile, LPSTR Desc, int DTN, LPSTR EffDate,
LPSTR AppInfo, int Action, int Process );

Visual Basic 
Declare
LoadForm

Declare Function LoadForm Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%, ByVal DosFile$,
ByVal Desc$, ByVal IntDTN%, ByVal EffDate$, ByVal AppInfo$,
ByVal Action%, ByVal Process%) As Integer

Visual Basic 
Declare
LoadFormEx

Declare Function LoadFormEx Lib "VLAMUSER.W32" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision As Integer, ByVal DosFile$,
ByVal Desc$, ByVal DTN As Long, ByVal EffDate$, ByVal AppInfo$,
ByVal Action As Integer, ByVal Process As Integer) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR ObjFile
Address of NULL terminated string with path/name of  variable-blocked AFP or Metacode form

LPSTR Desc
Address of NULL terminated string with description of Member

Int DTN
Integer Document Type Number for Member

LPSTR EffDate
Address of NULL terminated string with effective date for Member in MM/DD/YY format

LPSTR AppInfo
Address of NULL terminated string 80 character application information 
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Int Action
0 = Add new Member if MemName(Revision) does not exist
Replace MemName(Revision) if it does exist

1 = Add new Member (Fail if it already exists) Creates new high revision if Revision is 0
2 = Replace Member (Fail if it does not exist)

int Process
0 = Convert to view, load object Chain

1 = Convert to view, do not load object Chain
2 = Do not convert to view, only load object Chain

Return Codes V_SUCCESS(0)
Success

V_WARNING(4)
Default fonts were used during conversion

V_ERR_MEM_EXISTS(102)
Member already exists and Add was specified

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_INV_ACTION(104)
Requested Action was not 0,1 or 2

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened

V_ERR_INV_OBJFILE(107)
File was not variable-blocked

V_ERR_INV_REVISION(111)
Revision was not one that exists or one more than the highest

V_ERR_INV_EXT(117)
Extension of Objfile was not .AFP, .DMG, .MET, or .NOR

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_INV_PFORMCVT(153)
Address of conversion object was not valid - be sure to call InitFormCvrt before converting form to screen 
format

V_ERR_FORMCVT_FAILED(154)
Conversion Failed - Possibly invalid DJDE information if  Metacode

V_ERR_OBJFILE_NOT_EXIST(201)
Objfile could not be found
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LoadIDP

Loads a Document Package as the specified Member. The Document Package and 
Data file might have been extracted from an existing Document Package Member or 
might be created by an application program. The DataFile entry within the IDP will 
be used to determine the DOS filename of the data.

LoadMember

Loads the specified Chain to the specified Member. The Member is created if 
necessary.

WARNING LoadIDP is obsolete and NOT recommended. It does not require a call to InitVLAMUser, 
but it suffers the overhead of constructing a VLAM object and a Library object each time 
it is called.

C Function 
Prototype

BOOL LoadIDP(LPSTR Library, LPSTR UserID, LPSTR DosFile,
LPSTR Member, int Revision);

Parameters LPSTR Library
Address of NULL terminated string 8 character Library Name

LPSTR UserID
Address of NULL terminated string 8 character User ID

LPSTR DosFile
Address of NULL terminated string with filename of IDP

LPSTR Member
Address of NULL terminated string 32 character Member name

int Revision
Integer revision level for Member — Revision = -1 means a new high revision should be created )

Return Codes TRUE(1)
Success

FALSE(0)
Failure

Error message dialogs are shown as errors occur.

WARNING LoadMember is obsolete and NOT recommended. It does not require a call to 
InitVLAMUser, but it suffers the overhead of constructing a VLAM object and a Library 
object each time it is called.

C Function 
Prototype

BOOL LoadMember(LPSTR Library, LPSTR UserID, LPSTR DosFile,
LPSTR Member, int Revision, LPSTR Chain, WORD MaxLrecl,
LPSTR Recfm, DWORD DTN, LPSTR Description);

Parameters LPSTR Library
Address of NULL terminated string 8 character Library Name

LPSTR UserID
Address of NULL terminated string 8 character User ID

LPSTR DosFile
Address of NULL terminated string with filename of IDP

LPSTR Member
Address of NULL terminated string 32 character Member name

int Revision
Integer revision level for Member — Revision = -1 means a new high revision should be created )

LPSTR Chain
Address of NULL terminated string 4 character Chain name
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LoadPackage / LoadPackageEx

Loads a Document Package as the specified Member. The Document Package and 
Data file might have been extracted from an existing Document Package Member or 
might have been created by an application program. The LoadPackageEx function 
accepts a long integer argument for the DTN value.

WORD MaxLrecl
Maximum length of records with Chain data

LPSTR Recfm
Address of NULL terminated string specifying variable or unformatted records, 'V' or 'U'

DWORD DTN
Document Type Number of Member

LPSTR Description
Address of NULL terminated string with description of Member

Return Codes TRUE(1)
Success

FALSE(0)
Failure

Error message dialogs are shown as errors occur.

C Function 
Prototype

int LoadPackage( void *pPtrTbl, LPSTR MemName, int Revision,
LPSTR IDPFile, LPSTR DataFile, LPSTR Desc, int DTN,
LPSTR EffDate, LPSTR AppInfo, int Action );

Visual Basic 
Declare
LoadPackage

Declare Function LoadPackage Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision%, ByVal IDPFile$,
ByVal DataFile$, ByVal Desc$, ByVal IntDTN%, ByVal EffDate$,
ByVal AppInfo$, ByVal Action%) As Integer

Visual Basic 
Declare
LoadPackageE
x

Declare Function LoadPackageEx Lib "VLAMUSER.W32" (ByVal pPtrTbl&,
ByVal memname$, ByVal MemRevision As Integer, ByVal IDPFile$,
ByVal DataFile$, ByVal Desc$, ByVal DTN As Long, ByVal EffDate$,
ByVal AppInfo$, ByVal Action As Integer) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR MemName
Address of NULL terminated string 32 character Member name

Int Revision
Integer revision level for Member

LPSTR IDPFile
Address of NULL terminated string with filename of IDP

LPSTR DataFile
Address of NULL terminated string with filename of Data; pass NULL or a NULL-string to indicate no data to 
be loaded

LPSTR Desc
Address of NULL terminated string with description of Member

Int DTN
Integer Document Type Number for Member

LPSTR EffDate
Address of NULL terminated string with effective date for Member in MM/DD/YY format

LPSTR AppInfo
Address of NULL terminated string 80 character application information 

Int Action
0 = Add new Member if MemName(Revision) does not exist
Replace MemName(Revision) if it does exist

1 = Add new Member (Fail if it already exists)Creates new high revision if Revision is 0
2 = Replace Member (Fail if it does not exist)
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RestoreLibrary

Restores a VLAM backup file containing the members in a Library.

Return 
Codes

V_SUCCESS(0)
Success

V_ERR_MEM_EXISTS(102)
Member already exists and Add was specified

V_ERR_MEM_NOT_EXIST(103)
Member does not exist and Replace was specified

V_ERR_INV_ACTION(104)
Requested Action was not 0,1 or 2

V_ERR_MEM_NOT_OPEN(106)
Member(Revision) could not be opened

V_ERR_INV_REVISION(111)
Revision was not one that exists or one more than the highest

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_IDPFILE_NOT_EXIST(203)
IDPFile could not be found

V_ERR_DATFILE_NOT_EXIST(203)
DataFile could not be found

C Function 
Prototype

int RestoreLibrary( void *pPtrTbl, LPSTR BackupFile, int fOverWrite 
);

Visual Basic 
Declare

Declare Function RestoreLibrary Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal BackupFile$, ByVal OverWrite%) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR BackupFile
Address of NULL terminated string naming DOS file to receive backed up members

int fOverWrite
nteger boolean indicating if members in the Library should be overwritten by members in the backup even if 
the members in the Library are newer

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

V_ERR_RESTORE_FAILED(161)
Restore failed
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SetLibrary

Opens a new Library without the overhead of an additional call to InitVLAMUser. 
The current Library will remain open if the new Library cannot be opened.  

SetLibraryEx

Opens a new Library without the overhead of an additional call to InitVLAMUser. 
The current Library will remain open if the new Library cannot be opened. 
Compared to SetLibrary, SetLibraryEx accepts an additional parameter which is a 
boolean to indicate if the Library will be read only.

C Function 
Prototype

int SetLibrary( void *pPtrTbl, LPSTR Library );

Visual Basic 
Declare

Declare Function SetLibrary Lib "VLAMUSER.DLL" (ByVal pPtrTbl&,
ByVal LibraryName$) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR UserID
Address of NULL terminated string 8-character User ID

Return Codes V_SUCCESS(0)
Success

V_ERR_LIB_NOT_EXIST(101)
Requested Library does not exist

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

short VUSR_EXPORT WINAPI SetLibraryEx( void *pPtrTbl, LPSTR Library, 
short fReadOnly );

Visual Basic 
Declare

Declare Function SetLibraryEx Lib "VLAMUSER.W32" (ByVal pPtrTbl As 
Long,
ByVal LibraryName$, ByVal fReadOnly As Integer) As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

LPSTR UserID
Address of NULL terminated string 8-character User ID

fReadOnly
Integer boolean value indicating if the Library will be read only

Return Codes V_SUCCESS(0)
Success

V_ERR_LIB_NOT_EXIST(101)
Requested Library does not exist

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid
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TermVLAMUser

Closes the open Library, destroys Library and VLAM objects. This should be called 
when all processing for the Library has been completed.

ValidatepPtrTbl

Checks the validity of initialization information. This function would normally only 
be used by VLAMUSER.DLL internally, not by application programs.

C Function 
Prototype

int TermVLAMUser( void *pPtrTbl );

Visual Basic 
Declare

Declare Function TermVLAMUser Lib "VLAMUSER.DLL" (ByVal pPtrTbl&)
As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

Return Codes V_SUCCESS(0)
Success

V_WARNING(4)
Library was not open

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid

C Function 
Prototype

int ValidatepPtrTbl( void *pPtrTbl );

Visual Basic 
Declare

Declare Function ValidatepPtrTbl Lib "VLAMUSER.DLL" (ByVal 
pPtrTbl&)
As Integer

Parameters void* pPtrTbl
FAR void pointer that was initially passed to InitVLAMUser

Return Codes V_SUCCESS(0)
Success

V_ERR_INV_PPTRTBL(150)
pPtrTbl did not specify address of valid initialization information

V_ERR_INV_PLIB(151)
Address of Library object was not valid

V_ERR_INV_PVLAM(152)
Address of VLAM object was not valid
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Chapter 6

THE PRODUCTION DEFINITIONS OBJECT

USING PRODUCTION DEFINITIONS
The Control Panel-Production Definitions object lets you define and update 
Production Definitions, which specify the processing resources for a single 
execution of a Documaker fp application. 

You must have defined the appropriate Merge Definitions, Groups, and Print 
Definitions before you can define a Production Definition.

The Production Definition window lets you specify the following:

Variable Replacement Files (VRFs) — Documaker fp reads VRFs for the input 
data it uses to assemble forms and produce Document Packages. You can specify one 
or more VRFs that contain the following information:

• A list of form names

• The variable data and the associated BPSD tag names

• A list of the Groups to receive variations of the Document Packages

• A sort key and sort Group (stored in the DMG.SKEY.groupname reserved 
tag)

Output Destinations — Documaker fp directs print stream output to one or more

• Print stream output disk files

• Printers

You define the file names or print drivers that specify these destinations.

Groups — Documaker fp uses Group names which identify, for example, the

• Persons

• Locations

• Professions

that will receive variations of the Document Packages produced for an application. 
You can select one or more Groups to receive Documaker fp output. These Groups 
are selected from the Groups defined in the current VRF; however, you can enter any 
Group name in this field. It’s your responsibility to enter a valid Group name to be 
processed.

Electronic Document Libraries (EDLs) — Documaker fp gets electronic form 
images from the EDL. You must specify the EDL that contains these forms. If your 
application uses Explicit forms from multiple EDLs, you must also specify those 
EDLs.
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Merge Set Start/Stop IDs — By default, Documaker fp prints all of the Merge Sets 
in a VRF. You can specify Start and Stop Merge Set IDs which will cause 
Documaker fp to print a range of Merge Sets instead. This option requires a 
DMG.MERGESET.ID Reserved Tag to be present in each MergeSet in the VRF 
being processed.

Starting or Ending Production Definitions Setup

To define or update a Production Definition, you must first start the Production 
Definitions object.

To Start Production Definitions Setup

• In the Control Panel, double-click the  (Production Definitions) icon. 

The Production Definition Setup window displays.

Because you can use the Production Setup window to add, modify, activate, 
rename, or delete a Production Definition, this guide provides separate topics for 
these procedures.

To Exit Production Definitions Setup

• In the upper-right-hand corner of the Production Definition window, click on the 
 (Close) button. 

-or-

From the File menu, choose Close.

Production Setup closes and returns control to the Control Panel.

To Go to

Add a new Production Definition Adding A New Production Definition 

Update a Production Definition Changing a Production Definition 

Copy a Production Definition Copying a Production Definition 

Rename a Production Definition Renaming a Production Definition

Delete a Production Definition Deleting a Production Definition 
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ADDING A NEW PRODUCTION DEFINITION

The  (Add Resource) icon lets you specify a new Production Definition. 

To Add a New Production Definition

1. In the Production Setup window, click on the  icon. 

The Production Definition Setup - Add New window appears.

2. In the Name text box, type a name of eight characters or less for the Production 
Definition.

3. When you’ve completed the entries, choose the OK button.

Production Definition Setup saves the Production Definition with the name you 
specified, and then displays the Production Definition window.
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Because the Production Definition dialog contains several group boxes of 
specifications, this guide provides a separate topic for each group.

To Specify VRFs for a Production Definition

1. From the Variable Replacement File group box, choose Add. 

The Open window appears.

2. In the Look In drop-down list box, use the mouse to select a folder in which the 
VRFs are stored.

3. In the File Name text box, type the name of the VRF.

4. In the Files Of Type drop-down list box, use the mouse to select the appropriate 
file type (VRF files should be selected).

5. To select the VRF, choose the Open button. Otherwise, choose the Cancel 
button.

The VRF you chose displays in the Variable Replacement File list box. Repeat 
the process as many times as necessary if you want to choose more than one 
VRF.

6. If you want to change the order of the VRFs when more than one is added, 
highlight the desired VRF and click on one of the arrow icons.

The selected VRF is moved appropriately.

To Go to this section:

Specify Variable Replacement Files 
(VRFs)

To Specify VRFs for a Production Definition 

Define Output Destinations To Specify Output Destinations for a Production Definition 

Specify Groups To Specify the Groups for a Production Definition 

Specify Electronic Document Libraries 
(EDLs)

To Specify the Libraries (EDLs) for a Production Definition 

Specify Merge Set Start/Stop IDs To Specify Merge Set Start/Stop IDs for a Production Definition 

Close or save the Production Definition To Close or Save the Production Definition Dialog 



180

7. If you want to sort Documaker fp output by a sort key and sort Group which have 
been stored in the DMG.SKEY.groupname reserved tag in the VRF, do as many 
of the following as required:

To Delete a VRF from a Production Definition

1. If you need to delete a VRF once you’ve added it, select that VRF in the Variable 
Replacement File list box, and then choose the Remove button. 

The VRF Delete window appears.

2. To delete the VRF, choose the Yes button. Otherwise, choose the No button.

If you choose Yes, the VRF you selected disappears from the Variable 
Replacement File list box. The VRF file is not deleted from your hard disk.

To Specify Output Destinations for a Production Definition

Before you can specify one or more Output Destinations for merged output, you 
must have specified appropriate Print Definitions. 

1. From the Output Destinations group box, choose Add.

-or-

Press INSERT.

To Do this

Sort the VRFs by Group 1 Select the Sort VRFs check box.

2 Type the sort Group in the Sort Groups text box.
-or-
Select the sort Group from the Sort Groups combo 
box.

Sort the Groups in ascending instead of 
descending order

Select the Ascending check box.

Tip The Production Definition lets you specify more than one Output Destination.

For example, by specifying multiple Output Destinations, you can route the merged 
output for different Groups to different network printers or print files on disk (output 
stack). You accomplish this by first defining an Output Destination for each network 
printer, and then associating each of the Output Destinations with a different Group or 
Groups.

You can also use multiple Output Destinations to route merged output for the same 
Group to multiple satellite printers throughout your networked enterprise or different print 
files on disk (output stacks).
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The Add window appears.

2. Type the name of the new Output Destination and click on OK.

The Output Destination window appears.

3. From the Print Definition drop-down list, choose a Print Definition.
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4. For the type of Print Definition you chose, do one of the following:

Production Setup returns to the Production Definition dialog, and the Output 
Destination you specified displays in the Output Destinations list box.

To Modify an Output Destination in a Production Definition

1. If you need to modify an Output Destination once you’ve added it, select the 
Destination in the Output Destination list box and choose the Update button.

-or-

Select the Destination and press ENTER.

To Do this

Route the output to the default Documaker 
fp Output System

-and-

You chose a Metacode or AFP Printer 
Definition

• Choose the Output System option button.
• Choose the OK button.

Override the default Documaker fp Output 
System destination so that you can 
manually route the output to a custom print 
spooler, queue, or file

-and-

You chose a Metacode or AFP Printer 
Definition

• Choose the Override Output System option button.
• In the File Name text box, enter a fully-qualified output file name.
• -or-
• Click on the Browse button to navigate to a specific file folder or file.
• Choose the OK button.

Send the output to a network queue for 
processing

-and-

You chose a Metacode or AFP Printer 
Definition

• Choose the Queues option button.
• From the Target Application drop-down list, select TextCreate/ImageCreate.
• Choose one of the following queue type option buttons:

• NetWare

• LAN Server

• TCPIP

• Local Disk

• Press Tab, and then type the queue name.
• Press Tab, and then type the name of the network server where the queue is 

located or click on Browse. For Local Disk queues, enter the fully-qualified path 
name of the local disk queue files.

• Choose the OK button.

(Windows) Send Documaker fp Output 
directly to a local printer

-and-

You chose a Windows Printer Definition

• In the MetaFiles/Print Drivers group box, select the My Computer option button.
• Choose a printer driver from the Print Drivers drop-down list.
• Choose the OK button.

(Windows) Send Documaker fp Output to 
a network server or shared resource

-and-

You chose a Windows Printer Definition

• In the MetaFiles/Print Drivers group box, select the Network printer server option 
button.

• Type the name of the network server or shared resource, then press Enter.

-or-

Click on the Browse button to locate the server or resource, then click on 
Enumerate.

• The available printer drivers from the server or resource are added to the list of 
print drivers.

• Choose a printer driver from the Print Drivers drop-down list.
• Choose the OK button.
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2. See "Step 3." on page 181. 

To Delete an Output Destination from a Production Definition

1. If you need to delete an Output Destination once you’ve added it, select the 
Destination in the Output Destinations list box and choose the Remove button. 

-or-

Select the Destination and press DELETE. The Destination Delete window 
appears.

2. To delete the Destination, choose the Yes button. Otherwise, choose the No 
button.

If you chose Yes, the Destination you selected disappears from the Output 
Destinations list box.

To Specify the Groups for a Production Definition

1. From the Production Definition’s Groups group box, choose Add. 

-or-

Press INSERT. The Add window appears.

2. Type the name of the new Group and click on OK.

-or-

From the Group Name drop-down list, choose a Group.

The Groups in the drop-down list are those which are present in the first Variable 
Replacement File listed for this Production Definition.

Before you can specify this in the 
Group window You must have defined

Merge Definition The appropriate Merge Definition. For more information, see To Add a New Merge 
Definition.

A Destination or Error Destination The appropriate Output Destination(s). For more information, see To Specify 
Output Destinations for a Production Definition.

-or-

A VRF that contains the DMG.DD.groupname or DMG.ERRDD.groupname 
reserved tags. For more information, see the Using Documerge 3.2.0 reference 
guide for more information.
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Production Definition Setup displays the Group window.

3. From the Merge Definition drop-down list, choose a Merge Definition.

4. To specify an Output Destination for Documaker fp output, either

Type a name for the Destination

-or-

From the Destination drop-down list, choose a destination.

5. To specify an Error Output Destination for Documaker fp output, either

Type a name for the Error Destination

-or-

From the Error Destination drop-down list, choose an Error Destination.

6. If you want to use the Documaker fp feature that lets you directly specify the 
contents of a BPSD tag, do the following:

a. Choose the Tags command button.

The Group: window appears.

b. Choose Add and type the BPSD tag name (up to 30 characters) that has the 
contents you want to change, or add a new BPSD tag.

WARNING! You complete the following step only if you want to replace a non-Reserved BPSD tag’s 
original contents, which currently are either blank or the data from a like-named data 
item that was input from a VRF.

Avoid modifying the contents of Documaker fp Reserved Tags. Modification of 
the contents of these tags can produce unpredictable processing results.
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c. Press TAB, and then type the new information that you want the tag to 
contain.

d. To enter data for additional tags, press OK again, and the repeat steps 2 
through 4

e. When you are finished specifying special tag contents and you want to keep 
the changes, choose the OK button. Otherwise, choose the Cancel button.

Production Definition Setup returns to the Group window.

7. To keep the Group you specified, choose the OK button. Otherwise, choose the 
Cancel button.

Production Setup returns to the Production Definition dialog, and the Group you 
specified displays in the Groups list box.

To Modify a Group in a Production Definition

1. If you need to modify a Group once you’ve added it, select the Group in the 
Groups list box and choose the Update button.

-or-

Select the Group and press ENTER.

2. See "Step 3." on page 183. 

To Delete a Group from a Production Definition

1. If you need to delete a Group once you’ve added it, select the Group in the 
Groups list box and choose the Remove button. 

-or-

Select the Group and press DELETE.  The Group Delete window appears.

2. To delete the Group, choose the Yes button. Otherwise, choose the No button.

Tip To change or delete tags from the Group, select the tag first and then press either Edit 
or Remove.
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If you chose Yes, the Group you selected disappears from the list box.

To Specify the Libraries (EDLs) for a Production Definition

1. From the Electronic Document Libraries group box, choose Add. 

-or-

Press INSERT.  The Add window appears.

2. Type the name of the new EDL and click on OK.

-or-

From the Library Name drop-down list, choose a Library (recommended).

3. To keep the Library you specified, choose the OK button. Otherwise, choose the 
Cancel button.

Production Setup returns to the Production Definition dialog, and the Library 
you specified displays in the Electronic Document Libraries list box. Any EDLs 
you chose are used when this Production Definition is processed by Documaker 
fp.

To Delete a Library from a Production Definition

1. If you need to delete a Library once you’ve added it, select that Library in the 
Electronic Document Libraries list box, and then choose the Remove button. 

-or-

Select the Library and press DELETE.  

The EDL Delete window appears.

2. To delete the Library, choose the Yes button. Otherwise, choose the No button.

If you chose Yes, the Library you selected disappears from the list box. The 
Library itself isn’t deleted, only the reference to it from within this Production 
Definition.

3. If you want to close the Production Definition dialog, choose OK. Otherwise 
choose Apply.

To Specify Merge Set Start/Stop IDs for a Production Definition

1. In the Start text box of the Merge Set Start/Stop IDs area, type the Merge Set 
ID value with which you want Documaker fp to start processing. 

If you leave the field blank, the entire file is processed. This is the typical 
situation.

2. Press TAB, and then type the Merge Set ID value with which you want 
Documaker fp to stop processing.

If you leave the field blank, processing continues until the end of the file.
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3. If you want to close the Production Definition dialog, choose OK. Otherwise 
choose Apply.

To Close or Save the Production Definition Dialog

• Do one of the following: 

CHANGING A PRODUCTION DEFINITION
The Production Definitions object lets you change Production Definition 
specifications and options. 

To Change a Production Definition

1. If the Production Definitions window doesn’t already show on your screen, 
perform the instruction(s) under “Definitions Setup” on page To Start Merge 
Definition Setup, and then return to this topic. 

2. To select the Production Definition to change, click on the icon for that 
Production Definition.

The darkened appearance of the icon indicates that it is selected.

3. From the Edit menu, choose Properties.

The Production Definition window appears. The Production Definition name 
you selected displays in the title bar.

Because the Production Definition dialog contains several group boxes of 
specifications, this guide provides a separate topic for each group box.

WARNING! You must specify a DMG.MERGESET.ID Reserved Tag in each Merge Set in the VRF 
to be processed in order for the Merge Set Start/Stop ID capability to work properly.

To Do this

Apply the specifications you’ve provided without closing the Production Definition 
dialog

Choose the Apply button.

Apply the specifications you’ve provided and return to the Production Definition 
Setup window

Choose the OK button.

Return to the Production Definition Setup window without applying the 
specifications you’ve provided

Choose the Cancel button.

To Go to this section

Specify Variable Replacement Files (VRFs) To Specify VRFs for a Production Definition 

Define Output Destinations To Specify Output Destinations for a Production Definition 

Specify Groups To Specify the Groups for a Production Definition 

Specify Electronic Document Libraries (EDLs) To Specify the Libraries (EDLs) for a Production Definition 

Specify Merge Set Start/Stop IDs To Specify Merge Set Start/Stop IDs for a Production 
Definition 

Close or save a Production Definition To Close or Save the Production Definition Dialog 
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COPYING A PRODUCTION DEFINITION
You can copy a Production Definition using the File>Save As command in the 
Production Definitions Setup window. 

To Copy a Production Definition

1. If the Production Definitions Setup window doesn’t already show on your 
screen, perform the instruction(s) under To Start Production Definitions Setup, 
and then return to this topic. 

2. To select the Production Definition to copy, click on the icon for that printer.

The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Save As.

The Save As window appears, showing the name of the Production Definition 
you want to copy.

4. Type the name for the new Production Definition.

5. Choose the OK button to save the new Production Definition; otherwise, choose 
the Cancel button.

The Production Definition you copied displays on the Production Definition 
Setup window.

RENAMING A PRODUCTION DEFINITION
You can rename a Production Definition using the Edit>Rename command in the 
Production Definitions window. 

To Rename a Production Definition

1. If the Production Definitions window doesn’t already show on your screen, 
perform the instruction(s) under “Definitions Setup” on page To Start Merge 
Definition Setup, and then return to this topic. 

2. To select the Production Definition to rename, click on the icon for that 
definition.

The darkened appearance of the icon indicates that it is selected.

3. From the Edit menu, choose Rename.

The menu closes and returns to the Production Setup window where the selected 
Production Definition name now shows in a text box with a cursor for editing.

4. Type a new name, and then press ENTER.

Production Setup changes the name of the selected icon to the one you entered.
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DELETING A PRODUCTION DEFINITION
You can remove a Production Definition using the Edit>Delete command in the 
Production Definitions window. 

To Remove a Production Definition

1. If the Production Definitions window doesn’t already show on your screen, 
perform the instruction(s) under “Definitions Setup” on page To Start Merge 
Definition Setup, and then return to this topic. 

2. To select the Production Definition to remove, click on the icon for that 
definition.

The darkened appearance of the icon indicates that it is selected.

3. From the Edit menu, choose Delete.

-or-

Press DELETE.

The Remove Production Definition window appears, showing the name of the 
Production Definition to remove.

4. To delete the Production Definition, choose the OK button. Otherwise, choose 
the Cancel button.

The Production Definition you selected disappears from the Production 
Definitions window.
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Chapter 7

THE MERGE DEFINITIONS OBJECT

USING MERGE DEFINITIONS
The Control Panel-Merge Definitions object lets you define and update merge 
definitions, which control the

• Quantity

• Format

• Content

of the Document Packages that Documaker fp will produce for one or more Groups 
(recipients).

You must specify an appropriate merge definition before you can select Group(s) to 
process in a Production Definition. The Documaker fp for Windows Merge 
Definition is similar to the MERGEDEF PEDEF which is required for IBM MVS or 
VSE versions of Documaker fp.

In the Merge Definition dialog, you can specify

• General options such as

• The number of copies of a Document Package (for a Group)

• Verification of the occurrence of Mandatory BPSD tags

• Verification of non-blank data in Mandatory BPSD tags

• Special Processing options such as

• Produce ID Comments in the Document Package data stream using the 
contents of the DMG.MERGESET.ID Reserved Tag. (These comments 
don’t automatically appear in the Document Package produced by 
Documaker fp.)

This option is required if you plan to generate indexing values in Documaker fp 
output for use by Documanage.

• Left-Zero-Fill of Reserved Tags (required for certain types of finishing 
equipment)

• Separation of Output Packages for using the automatic stapling feature of 
Metacode printers

• A Dash Code ON value for automatically generating OMR marks with 
Documaker fp

• A Dash Code OFF value for automatically generating OMR marks with 
Documaker fp

• Page Margin options that include settings for top and bottom margins
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This feature adjusts the page margins when printing to PCL printers from 
Documaker fp via a Windows Print Driver.

• Concatenation separation options that include

• The amount of vertical space to allow between concatenated images

• Selection of a form name and revision number to use as a separator for 
concatenated images.

• Banner page options for selecting or specifying the form and revision number to 
use as a separator page at the beginning of an output stack for a given recipient 
(Group)

• Trailer page options for selecting or specifying the form and revision number to 
use as a separator page at the end of an output stack for a given recipient (Group)

• Messages/Errors options that include

• Writing errors to a Message File in addition to including error messages in 
the output destination

Starting or Ending Merge Definitions

To define or update a Merge Definition, you must first start the Merge Definitions 
object.

To Start Merge Definition Setup

• In the Control Panel, double-click the  (Merge Definitions) icon. 

The Merge Definitions window displays.
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Because you can use the Merge Definitions window to add, modify, activate, 
rename, or delete a Merge Definition, this guide provides separate topics for 
these procedures.

To Exit Merge Definition Setup

• In the upper-right-hand corner of the Merge Definitions window, click on the  
(Close) button. 

-or-

From the File menu, choose Close.

Merge Definitions closes and returns control to the Control Panel.

ADDING A MERGE DEFINITION

The  (Add Resource) icon lets you specify a new merge definition. 

To Add a New Merge Definition

1. In the Merge Definitions window, click on the  icon. 

The Merge Definitions - Add a Merge Definition window appears.

2. In the Name text box, type a name of eight characters or fewer for the Merge 
Definition.

3. When you’ve completed the entries, choose the OK button.

To Go to

Add a new Merge Definition Adding a Merge Definition 

Update a Merge Definition Changing a Merge Definition 

Copy a Merge Definition Copying a Merge Definition 

Rename a Merge Definition Renaming a Merge Definition 

Delete a Merge Definition Deleting a Merge Definition 
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The system saves the merge definition with the name you specified, and then 
displays the Merge Definition window.

USING THE MERGE DEFINITION DIALOG AND TABS
The Merge Definition window contains two tabs. You complete a Merge Definition 
by specifying data merging-related items in panels under these tabs.

To Use a Merge Definition Tab

• Do any of the following:

To Close or Save the Merge Definition Dialog

• Do one of the following:

To specify Go to this topic

Page margin, banner and trailer page, and concatenated form 
options

Using the Page Setup Tab 

Special processing options, such as dash codes and messaging Using the Processing Tab 

To Do this

Apply the specifications you’ve provided without closing the Merge 
Definition dialog

Choose the Apply button.

Apply the specifications you’ve provided and return to the Merge 
Definitions window

Choose the OK button.

Return to the Merge Definitions window without applying the 
specifications you’ve provided

Choose the Cancel button.
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Using the Page Setup Tab

Use the first tab in the Merge Definition window to specify

• General page information

• Page margins

• Banner and Trailer pages

• Separation distances between concatenated forms

To Activate the Page Setup Panel

• If the Page Setup panel is not already showing in the Merge Definition window, 
click on the Page Setup tab. 

The Page Setup panel displays.

Because the Merge Definition dialog contains several group boxes of 
specifications, this guide provides a separate topic for each group.

To specify Go to this section

The number of copies for a Group or 
verification of Mandatory Tags

To Specify General Options for a Merge Definition

The page margins To Set Page Margins in a Merge Definition

A banner page To Specify a Banner Page in a Merge Definition

A trailer page To Specify a Trailer Page in a Merge Definition

A space or form for separating concatenated 
forms

To Specify a Concatenation Separation in a Merge Definition

Closing or saving the Merge Definition To Close or Save the Merge Definition Dialog
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To Specify General Options for a Merge Definition

• Do one of the following:

To Set Page Margins in a Merge Definition

• Do one of the following:

To Specify a Banner Page in a Merge Definition

• Do one of the following:

If you want to Do this

Override the VDR-generated number of copies

-or-

Produce more than the one default copy

In the Number of Copies text box, type a 1- to 5-digit number 
which is not greater than 32,767. 

Verify that Mandatory Tags are present in the VRF being 
processed.

Choose the Mandatory Tags-Present option button.

Verify that Mandatory Tags are present in the VRF being 
processed and contain non-blank characters

Choose the Mandatory Tags-Non-Blank option button.

Tip Use any of these options to accommodate the non-printable areas of a page when 
creating output via a Windows Print Driver.

If you want to override the default Do this

Top page margin (vertical distance from top edge of sheet to top of first 
printed line)

In the Top Margin text box, type a new decimal 
value. Be sure to select the unit of measure. 

Bottom page margin (vertical distance from bottom edge of sheet to 
bottom of last printed line)

Use this option to inform Documaker fp to maintain space at the bottom 
of the page for “footer” Overlays.

In the Bottom Margin text box, type a new decimal 
value. Be sure to select the unit of measure.

Left page margin (horizontal distance from left edge of sheet to left edge 
of printed text)

In the Left Margin text box, type a new decimal 
value. Be sure to select the unit of measure.

Right page margin (horizontal distance from right edge of sheet to right 
edge of printed text)

In the Right Margin text box, type a new decimal 
value. Be sure to select the unit of measure.

WARNING! If this Merge Definition is for a Document Package that contains Overlays, the bottom 
margin must be set to zero for the Overlays to work correctly.

To Do this

Directly enter the form name and revision 
number

In the Banner-Form and -Revision text boxes, type a form name and revision 
number. 
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To Specify a Trailer Page in a Merge Definition

• Do one of the following:

To Specify a Concatenation Separation in a Merge Definition

• If you want to override the (default) absence of space that Documaker fp inserts 
between forms when it places more than one form on a page, do one of the 
following:

Select from a Library, the name and 
revision number of a form that Documaker 
fp will use as a banner page.

• If you haven’t already, you must open the Library that contains the form.
• Choose the Select a Form... command button.
• The Member Listing window appears.
• Select the applicable library from the Open a Library drop-down list box.

-or-

• Type the desired library name and press Enter.
• Select a form from the list box, enter a password if required, and then choose 

OK.
• The Merge Definition window shows the form name and revision number in the 

Banner-Form and -Revision text boxes.

To Do this

Directly enter the form name and revision 
number

In the Trailer-Form and -Revision text boxes, type a form name and revision 
number. 

Select from a Library, the name and 
revision number of a form that Documaker 
fp will use as a trailer page.

• If you haven’t already, you must open the Library that contains the form.
• Choose the Select a Form... command button.
• The Member Listing window appears.
• Select the applicable library from the Open a Library drop-down list box.

-or-

• Type the desired library name and press ENTER.
• Select a form from the list box, enter a password if required, and then choose 

OK.
• The Merge Definition window shows the form name and revision number in the 

Trailer-Form and -Revision text boxes.

To Do this

Specify an amount of vertical space for 
Documaker fp to place between 
concatenated forms

In the Space Amount text box, type a new decimal value. Be sure to select the 
unit of measure. 

Enter the name and revision number for a 
form (usually, a rule, breaking line or other 
spacing element) that Documaker fp will 
place between concatenated forms

In the Form and Revision text boxes, type a form name and revision number.

Select from a Library, the name and 
revision number of a form (usually, a rule, 
breaking line or other spacing element) 
that Documaker fp will place between 
concatenated forms

• If you haven’t already, you must open the Library that contains the form.
• Choose the Select a Form... command button.
• The Member Listing window appears.
• Select the applicable library from the Open a Library drop-down list box.
• Select a form from the list box, enter a password if required, and then choose 

OK.
• The Merge Definition dialog shows the form name and revision number in the 

Concatenation Separation-Form and -Revision text boxes.
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Using the Processing Tab

Use the second tab in the Merge Definition window to specify

• Special processing settings

• Message and error controls

To Activate the Processing Panel

• If the Processing panel is not already showing in the Merge Definition window, 
click on the Processing tab. 

The Processing panel displays.

Because the Merge Definition dialog contains several group boxes of specifications, 
this guide provides a separate topic for each group.

To specify Go to this section

Finishing options such as ID comments, 
Reserved Tag Left-Zero Fill, Document 
Package binding, and Dash Code ON/OFF 
values

To Specify Special Processing Options for a Merge Definition 

Processing and message options for errors 
detected by Documaker fp

To Specify Messages/Errors in a Merge Definition 

Closing or saving the Merge Definition To Close or Save the Merge Definition Dialog 
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To Specify Special Processing Options for a Merge Definition

• Do one of the following:

To Specify Messages/Errors in a Merge Definition

• Do one of the following:

CHANGING A MERGE DEFINITION
The Merge Definitions object lets you change Merge Definition specifications and 
options. 

To Change a Merge Definition

1. If the Merge Definitions window doesn’t already show on your screen, perform 
the instruction(s) under To Start Merge Definition Setup, and then return to this 
topic. 

2. To select the Merge Definition to change, click on the icon for that Merge 
Definition.

If you want to Do this

Produce comments in the Document Package data stream using the contents 
of the DMG.MERGESET.ID Reserved Tag (these comments don’t print in the 
Document Package produced by Documaker fp).

This option is required if you plan to generate indexing values in Documaker 
fp output for use by Docusave or Imagecreate.

Select the Produce ID Comments check box

Right-justify the data in, and left-zero-fill, the Reserved Tags used by certain 
types of finishing equipment

Select the Reserved Tag Left Zero Fill check 
box

Staple each output Document Package produced by a Xerox Metacode 
printer which has the automated stapling option.

This option is required for archiving Documaker fp DCD output. This option is 
also recommended for all other print streams. Separating output Document 
Packages places each output document Document Package into the archive 
queue separately rather than accumulating all document Document Packages 
in a single queue job.

Select the Separate Output Packages check 
box.

Specify a character (usually the underscore or other line composition 
character) to use as the Dashcode ON value

• In the Dashcode ‘ON’ Value text box, type the 
character.

• In the associated drop-down list box, choose 
ASCII, EBCDIC, or HEX (ASCII is 
recommended).

Specify a character (usually the space or other non-printing character) to use 
as the Dashcode OFF value

• In the Dashcode ‘OFF’ Value text box, type the 
character.

• In the associated drop-down list box, choose 
ASCII, EBCDIC, or HEX (ASCII is 
recommended).

If you want to Do this

Route the error messages that Documaker fp produces to a message 
file that you can view using the Output System object

Select the Errors to Message File check box. 

Override the default 60 lines of message text that Documaker fp will 
print per page

In the Message Lines/Page text box, type the number 
of lines.
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The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Properties.

The Merge Definition window appears. The Merge Definition name you 
selected displays in the title bar.

Because the Merge Definition dialog contains two panels that you can use to 
change Merge Definition specifications, this guide provides a separate topic for 
each panel.

COPYING A MERGE DEFINITION
You can copy a Merge Definition using the File>Save As command in the Merge 
Definitions window. 

To Copy a Merge Definition

1. If the Merge Definitions window doesn’t already show on your screen, perform 
the instruction(s) under To Start Merge Definition Setup, and then return to this 
topic. 

2. To select the Merge Definition to copy, click on the icon for that printer.

To change Go to this topic

Page margin, banner and trailer page, and concatenated 
form options

Using the Page Setup Tab 

Special processing options, such as dash codes and 
messaging

Using the Processing Tab 
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The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Save As.

The Save As window appears, showing the name of the Merge Definition you 
want to copy.

4. Type the name for the new Merge Definition.

5. Choose the OK button to save the new Merge Definition; otherwise, choose the 
Cancel button.

The Merge Definition you copied displays on the Merge Definition Setup 
window.

RENAMING A MERGE DEFINITION
You can rename a Merge Definition using the File>Rename command in the Merge 
Definitions window. 

To Rename a Merge Definition

1. If the Merge Definitions window doesn’t already show on your screen, perform 
the instruction(s) under To Start Merge Definition Setup, and then return to this 
topic. 

2. To select the Merge Definition to rename, click on the icon for that definition.

The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Rename.

The menu closes and returns to the Merge Definitions window where the 
selected Merge Definition name now shows in a text box with a cursor for 
editing.

4. Type a new name, and then press ENTER.

Merge Definitions changes the name of the selected icon to the one you entered.

WARNING! You must also edit any Production Definitions whose Groups referenced the old Merge 
Definition, as this action doesn’t automatically change any Production Definitions.
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DELETING A MERGE DEFINITION
You can remove a Merge Definition using the File>Delete command in the Merge 
Definitions window. 

To Remove a Merge Definition

1. If the Merge Definitions window doesn’t already show on your screen, perform 
the instruction(s) under To Start Merge Definition Setup, and then return to this 
topic. 

2. To select the Merge Definition to remove, click on the icon for that definition.

The darkened appearance of the icon indicates that it is selected.

3. From the File menu, choose Delete.

-or-

Press DELETE.

The Remove Merge Definition window appears, showing the name of the Merge 
Definition to remove.

4. To delete the Merge Definition, choose the OK button. Otherwise, choose the 
Cancel button.

The Merge Definition you selected disappears from the Merge Definitions 
window.
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Chapter 8

THE DOCUMAKER FP JOB SUBMISSION OBJECT

USING DOCUMAKER FP JOB SUBMISSION
The Control Panel contains a facility to submit jobs to be processed by Documaker 
fp. The Documaker fp Job Submission routine sends the input data defined by the 
chosen Production Definition to the Documaker fp queue. 

The Documaker fp Job Submission object lets you specify

• Job Description — The name for this job. This description will be displayed in 
the Output System Viewer when viewing the message and report files generated 
for this job.

• Production Definition — Documaker fp reads a Production Definition, which 
specifies the processing resources for a single execution of a Documaker fp 
application.

• Variable Replacement File (VRF) — Documaker fp reads a VRF for the input 
data it uses to assemble forms and produce Document Packages.

• Queues — The type and location of the queue to which you’re submitting a job.

• Directories — The locations of the working, external printing objects, and 
communications directories.

• Advanced Options — The size of the paper to which Documaker fp error 
messages are printed.

The routine then creates the job and places it in the Job Queue to await processing 
by Documaker fp.

Starting or Ending Documaker fp Job Submission

To submit a job to Documaker fp, you must first start the Documaker fp Job 
Submission object.

To Start Documaker fp Job Submission

• In the Control Panel, double-click the  (Documaker fp Job Submission) icon. 
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The Merge Execution Setup window appears.

To Exit Documaker fp Job Submission

• In the upper-right-hand corner of the Merge Execution dialog, click on the  
(Close) button. 

Documaker fp Job Submission closes and returns control to the Control Panel.

USING THE JOB SUBMISSION DIALOG AND TABS
The Merge Execution Setup window contains several tabs. You complete a Job 
Submission by specifying Documaker fp-related items in panels under these tabs. 

To Use a Job Submission Tab

• Do any of the following:

To specify Go to this topic

Production Definition and Variable Replacement File 
(VRF)

Using the Job Submission Tab 

Queue type and information Using the Queues Tab 

Working directories to use Using the Directories Tab 

Select a paper size for Documaker fp error processing Using the Advanced Options Tab 
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Using the Job Submission Tab

Use the first tab in the Merge Execution Setup window to

• Specify the desired Production Definition

• Choose the correct Variable Replacement File (VRF)

• Submit a Production Definition for Documaker fp processing

To Activate the Job Submission Panel

• If the Job Submission panel is not already showing in the Merge Execution Setup 
window, click on the Job Submission tab. 

The Job Submission panel displays.

Because the Job Submission panel contains two group boxes of specifications, this 
guide provides a separate topic for each group.

If you need to Go to

Select a Production Definition To Select a Production Definition 

Select a Variable Replacement File (VRF) To Select a Variable Replacement File 

Submit a Production Definition job to 
Documaker fp

To Submit a Documaker fp Job 
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To Select a Production Definition

The Production Profile Listing selection box on the right-hand side of the window 
shows all of the Production Definitions you defined in the Production Definitions 
object. 

• In the Production Profile Listing selection box, use the mouse to highlight the 
desired Production Definition. The name is listed in the Production Definition 
text box on the left-hand side.

To Select a Variable Replacement File

The Contents of selection box on the right-hand side of the window shows all of the 
VRFs you defined for the selected Production Definition (see previous step).

• Do one of the following:

To Submit a Documaker fp Job

1. Supply all information listed in the Warning Message above. 

2. To send the job to Documaker fp, click on Submit.

WARNING! Upon submitting the job, the Control Panel checks to make sure that this Production 
Profile exists in the DOCUMERG.INI file. The Control Panel will abort the Submit 
process if the profile doesn’t exist.

Tip If you want to select more than one VRF and have them concatenated for the current 
Production Definition, enable the Select all VRFs check box.

To Do this

Use a VRF other than the one(s) displayed 
in the Contents of selection box

In the Variable Replacement File text box, type the fully-qualified path and file 
name of a valid (existing) VRF.

-or-
Click on the Browse button and choose a valid Variable Replacement File.

Use a VRF listed in the Contents of 
selection box

In the Contents of selection box, use the mouse to highlight the desired VRF.

WARNING! In order to submit a Documaker fp job, you must supply the following information:

• Queue Type

• Queue Name

• Server Name

• The items on the Job Submission panel

For more information on the queue and server information, see Using the Queues Tab.
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The Documaker fp Job Submission window appears.

3. Type the name or description of the job you’re submitting. This user-defined 
name should uniquely identify this particular job and is displayed later in the 
Output System viewer. 

4. Click on OK to submit the job.

The Control Panel places the job in the Documaker fp job queue, where it awaits 
processing by Documaker fp.

After the job has been successfully placed into the queue, the Control Panel 
displays a Merge Submit confirmation window.

5. Click on OK to confirm the job submission.

Using the Queues Tab

Use the Queues tab in the Merge Execution Setup window to specify

• A queue type

• Various queue characteristics

To Activate the Queues Panel

1. If the Queues panel is not already showing in the Merge Execution Setup 
window, click on the Queues tab. 
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The Queues panel displays.

2. Do one of the following:

To Specify a Queue Type

1. In the Queue Type group box, select the appropriate option button for your 
queue type: 

• NetWare

• LAN Server

• TCP/IP

• Local Disk

2. If you’re finished specifying the queue type, click on APPLY.

If you need to Go to

Specify the queue type To Specify a Queue Type 

Enter queue information To Enter Queue Information 
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To Enter Queue Information

1. In the Queue Name text box, type the Queue Name as it is to be defined in 
Documaker fp. 

2. Press TAB to reach the Server Name text box.

3. Enter the Documaker fp network Server Name where the queue is located.

-or-

Click on Browse to locate the server.

4. If you’re finished specifying queue information, click on APPLY.

Using the Directories Tab

Use the Directories tab in the Merge Execution Setup window to specify the various 
directory names for the Control Panel, Output System Viewer, and Documaker fp 
Job Submission object to use. 

To Activate the Directories Panel

• If the Directories panel is not already showing in the Merge Execution Setup 
window, click on the Directories tab. 

Tip For Local Disk queues, the queue name is a user-defined, eight (8)-character name that 
will be used as the disk queue file name. For other queue types, the queue name is the 
name that was assigned by the network administrator (typically) when the queue was 
created.

Tip For Local Disk queues, the server name is the fully-qualified path or location where the 
disk queue files will reside. For other queue types, the server name is the actual Server 
name or ID on which the queue resides.
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The Directories panel displays.

To Enter Directory Path Names

1. In the Working text box, type the drive letter and directory name of the directory 
that will hold Documaker fp files. 

-or-

Click on Browse.

2. Press TAB to reach the External Print Objects text box, then type the drive 
letter and directory name of the directory holding converted External Print 
Object files.

-or-

Click on Browse.

3. Press TAB to reach the 32-bit Rulebase text box, then type the drive letter and 
directory name of the directory containing the Documaker fp 32-bit Rulebase 
files.

-or-

Click on Browse.

4. Press TAB to reach the 16-bit Communications text box, then type the drive 
letter and directory name of the directory holding the Client Server 
Communication files.
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-or-

Click on Browse.

This directory is the location where output, message, and report files will reside. 
These files are also used by the Output System object.

5. If you’re finished specifying directory information, click on APPLY.

Using the Advanced Options Tab

Use the Advanced Options tab in the Merge Execution Setup window to specify 
the size of the paper on which Documaker fp error situations will be printed.

To Activate the Advanced Options Panel

1. If the Advanced Options panel is not already showing in the Merge Execution 
Setup window, click on the Advanced Options tab. 

The Advanced Options panel displays.

2. Do one of the following:

If you need to See

Specify Documaker fp job processing parameters To Indicate the Use of the Output System

Designate error sheet paper stock To Select the Paper Size
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To Indicate the Use of the Output System

The Use the Output System check box controls whether Documaker fp should 
attempt to connect to an output system database. By default, Documaker fp routes all 
output to an output system stored in a database.

If you’re using Documaker fp, but don’t employ a database output system, you 
should disable this option. If you forget to disable this option, Control Panel issues 
appropriate error messages, since Documaker fp can’t locate a working database.

1. Enable the Use the Output System check box if you want Documaker fp to 
route all output to a database.

2. In the Cache Forms drop-down list box, select whether you want to store 
common forms (i.e. ones that are re-used within the same job) for quicker 
retrieval and processing:

• ALL (Default) — all forms are to be cached

• SOME — you want some forms, up to a certain size, kept in the cache

This choice states that only forms smaller than a certain byte size are left in 
the cache between jobs.

• NONE — no forms are cached

This choice states that every form is removed from the cache after each job. 
This option could actually speed up certain jobs where you know that none 
of your forms are reused, since Documaker fp won't be spending time 
searching the cache for forms that aren't there.

3. In the Maximum allowable size text box, type the maximum file size, in bytes, 
of files to be cached, up to seven digits. Any forms that meet or exceed this file 
size are to be removed from the cache after each job is processed. Oracle 
recommends a starting file size of 100,000 bytes.

4. In the Log File text box, type the directory path and file name of the file you 
want to create that contains a log of all the Documaker fp Job Submission queues 
that are successfully processed.

5. In the Error File text box, type the directory path and file name of the file you 
want to create that contains a log of all the Documaker fp Job Submission queues 
that aren’t successfully processed.

6. If you’re finished enabling the output system, click on APPLY.

Tip The Output System option only applies to Documaker fp users.

Note If you choose to have only some forms cached, you must also specify the maximum 
allowable file size of the forms (see next step).
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To Select the Paper Size

The Paper Size specifies the size of the paper to use when printing Documaker fp 
error messages.

1. In the Paper Size drop-down list box, use the mouse or arrow keys to select the 
paper size.

2. If you’re finished specifying the paper size, click on APPLY.
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Chapter 9

THE OUTPUT SYSTEM VIEWER OBJECT

USING THE OUTPUT SYSTEM VIEWER
The Output System Viewer displays a listing of pertinent information about 
Production Definition jobs that have been processed by the Documaker fp server. 

For each job you submit, the Output System Viewer provides the following items of 
information:

• Date — the date you submitted the job.

• Time — the time (in 24-hour format) you submitted the job.

• File Type — can be one of the following:

• Merged Output — contains the Documaker fp Document Packages output 
from the Documaker fp Server. This is the native print data stream (either 
AFP or Metacode).

• Message Log — contains any error or other types of processing messages 
Documaker fp generated as the result of the merge.

• Form Statistics — contains the Library and Member Names, Revision 
number Chain, Use Count, and File Size for all forms used in creating the 
output.

• Dest. — the Output Destination name specified in the Production Definition for 
this output.

• File Size — the number of bytes in the file.

• User ID — the userid of the account from which the Documaker fp job was 
submitted.

• Description — the text you entered in the Job Description window, which 
displays when you execute the Documaker fp Job Submission object. For more 
information about the Submit command, see .

Starting or Ending the Output System Viewer

Before you can view the contents of a Documaker fp output file, you must first start 
the Output System Viewer.

To Start the Output System Viewer

• Choose the  (Output System) icon from the Control Panel main window. 
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The Output System Viewer window displays.

To Close the Output System Viewer

• From the File menu, choose Exit and you’re returned to the Control Panel main 
window. 

USING THE OUTPUT SYSTEM DIALOG AND TABS
The Output System window contains two tabs. You can customize the Output 
System Viewer by specifying viewing-related items in panels under these tabs. 

To Use an Output System Tab

• Do any of the following:

Using the Output System Tab

Use the first tab in the Output System window to

• View a Documaker fp job

• Delete a Documaker fp job

• Copy a Documaker fp job

To Go to this topic

View, Delete, and Copy jobs from within the Viewer Using the Output System Tab

Specify options pertaining to the Viewer Using the Options Tab 
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• Refresh the list of Documaker fp jobs

To Activate the Output System Panel

• If the Output System panel is not already showing in the Output System window, 
click on the Output System tab. 

The Output System panel displays.

Because the Output System panel contains several operational buttons, this 
guide provides a separate topic for each button.

To View Output File Contents

The File>View command lets you see the contents of a Documaker fp output file by 
loading the file into, and starting, a text viewing application. 

1. Select the output file to view in the Output System.

2. From the File menu, choose View an Entry.

-or-

If you need to Go to

View information about a Documaker fp job To View Output File Contents

Delete a Documaker fp job To Delete an Output File

Copy a Documaker fp job To Make a Text File Copy of an Output File

Refresh the listing of Documaker fp jobs To Manually Refresh the List

Set a timer to automatically refresh the 
listing

To Automatically Refresh the List
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From the Tool Bar, press the  (View) icon.

-or-

Highlight the row and press ENTER.

Windows displays an ASCII text representation of the file you chose for 
viewing.

3. From the File menu, choose Close.

-or-

In the upper-right-hand corner of the application viewing window, click on the 

 (Close) button.

To Delete an Output File

Use the File>Delete command to erase a selected file from the Output System and 
permanently eliminate the file. You will be asked to confirm the deletion before the 
Output System Viewer deletes the file. 

1. Select the output file to delete in the Output System viewer.

2. From the File menu, choose Delete an Entry.

-or-

From the Tool Bar, press the  (Delete) icon.

-or-

Highlight the row and press DELETE.
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The Delete Confirmation window appears.

3. To delete the file, choose Yes. Otherwise, choose No.

If you chose Yes, the Output System deletes the file from the list of output files.

To Make a Text File Copy of an Output File

The File>Copy command lets you save an Output System file as a text file. 

1. Select the output file to copy in the Output System viewer.

2. From the File menu, choose Copy an Entry.

-or-

From the Tool Bar, press the  (Copy) icon.

The Save As window appears.

3. In the Save In drop-down list box, use the mouse to select a folder in which to 
store the copy.

4. In the File Name text box, type the name of the text file.

5. In the Save As Type drop-down list box, use the mouse to select the appropriate 
file type (Text file should be selected).

6. To start creating the text file, choose the Save button. Otherwise, choose the 
Cancel button.

The Output System Viewer copies the output file and places it in the folder you 
specified.
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To Manually Refresh the List

Use the View>Refresh command to re-display the active Output System viewer, 
showing any new jobs that the Control Panel has processed since you opened or last 
refreshed the window. 

From the View menu, choose Refresh.

-or-

From the Tool Bar, press the  (Refresh) icon.

The Output System viewer shows any newly-created output files.

To Automatically Refresh the List

• Click on the Enable Refresh Timer check box to refresh the list at the 
frequency you specified in the Options tab (To Set the Refresh Timer). 

Using the Options Tab

Use the second tab in the Output System window to specify

• The text viewing application to use when viewing information about a job

• The frequency at which the Object System Viewer listing should be refreshed

• The order in which the list should be sorted

• The column on which the sort order should be based

To Activate the Options Panel

• If the Options panel is not already showing in the Output System window, click 
on the Options tab. 
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The Options panel displays.

.Because the Options panel contains several group boxes of specifications, this 
guide provides a separate topic for each group.

To Select the Text Viewing Application

Select any Windows-compatible text editor to view the information about a 
Documaker fp job.

1. Press TAB to reach the Text Viewing group box.

2. In the Application text box, type the executable file name of the text editor.

-or-

Click on Browse to select the file name.

If you’re finished specifying the text viewing application, click APPLY.

If you need to Go to

Select the Text Viewing Application for viewing 
information about a Documaker fp job

To Select the Text Viewing Application 

Set (in minutes) the frequency at which to refresh 
the listing of Documaker fp jobs

To Set the Refresh Timer 

Select the Sort Order of the Documaker fp jobs To Select the Sort Order 

Choose the column on which to base the Sort 
Order

To Select the Sort Column 

Adjust the size of the column display To Adjust the Width of the Display Columns
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To Set the Refresh Timer

Set up an automatic timer to refresh the Output System Viewer listing every certain 
number of minutes.

1. Press TAB to reach the Data Refresh group box.

2. In the Timer text box, enter the frequency at which you’d like the list refreshed.

If you’re finished specifying the refresh rate, click APPLY.

To Select the Sort Order

Choose the order in which the Output System Viewer listing is sorted (e.g., none, 
ascending, or descending).

1. Press TAB to reach the Sort Ordering group box.

2. Click on the option button representing your preference.

If you’re finished specifying the sort order, click APPLY.

To Select the Sort Column

Choose the column(s) on which to sort the Output System Viewer listing.

1. Press TAB to reach the Sort Column group box,

2. Click on as many columns as necessary to properly sort the output listing.

If you’re finished specifying the sort columns, click APPLY.

To Adjust the Width of the Display Columns

Choose to automatically adjust the width of the columns to fit the display area of the 
window.

• Enable the Automatically size columns to fit the display check box if you want 
the Output Viewer to adjust the size of the columns when you resize the window.

If you’re finished specifying the sort order, click APPLY.

Tip The Sort Column choices act as a “starting” and “ending” point for your sorting criteria. 
If you choose Columns 1 and 5, for example, your sorting choice includes all five 
columns.
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Chapter 10

THE DATABASE DEFINITIONS OBJECT

USING 16-BIT DATABASE DEFINITIONS

To manage the VLAM database for the Documerge 1.x, Rulecommander 1.x, and 
Docusolve 1.x Libraries that contain forms, the Control Panel can use any of the 
following 16-bit database client connections: 

• WATCOM SQL client/network server database engine, version 4.0 or higher.

If you use the WATCOM Network Server for a database, the WATCOM Client 
must be installed on your workstation.

• WATCOM stand-alone database engine, version 4.0 or higher.

• DB2, version 2.1 or higher.

To communicate with a DB2 database, DOS Client Application Enabler, 
version 2.1 or higher must be installed on your workstation.

• Sybase version 10.x or 11.x, and Sybase Open Server Net Library for Windows, 
release 1.0.2x or 1.0.3x.

If you use the Sybase Open Net Library for Windows, the Sybase Open Net 
Client, release 1.0.2 or higher must be installed on your workstation.

USING 32-BIT DATABASE DEFINITIONS

Supported Databases

To manage the VLAM database for the Documaker fp 3.x Libraries that contain 
forms, the Control Panel can use any of the following 32-bit database client 
connections:

• ODBC client for the following Windows databases:

• IBM DB2 5.0 or higher

• Microsoft SQL Server 6.5 for Windows or higher

• Oracle 8.1.7 or higher

• Sybase SQL AnyWhere 5.5 for Windows or higher

• Sybase 11.1 or higher

Note When installing Control Panel on a 64-bit OS, use the 32-bit Database. The 16-bit 
database will not work on a 64-bit OS.
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-or-

• Oracle 9.2 (Linux)

-or-

For information regarding compatible versions of the databases, see the Docucorp 
Library Interfaces Reference Guide.

ODBC Client

The Control Panel contains an ODBC driver that allows connections to currently-
supported databases via an ODBC client.

Because of the many variations in levels of support provided by "databases" with 
ODBC drivers, the current release of pcVLAM only allows ODBC connections to 
databases already supported by existing database drivers (e.g., DB2, MS SQL, 
Oracle, SQL AnyWhere, and Sybase). Since the Control Panel includes an ODBC 
interface to a wide variety of popular databases, you can use your current version of 
the program for a longer period of time before you need to upgrade.

While ODBC allows access to a variety of databases, it doesn’t guarantee identical 
features and syntax on each platform. You should thoroughly test new platforms to 
make certain that the Control Panel functions as expected with your database.

Before You Start Setting Up the Database

Before you start the setup procedure, you must know the following information: 

• The user ID(s) required to access the database server for the VLAM database

• The password(s) required to access the database server for the VLAM database

• The name of the VLAM database

• The name of the database engine or client

• Extended connection information for specific versions of database client 
software

• The Data Source Name (DSN) of the ODBC driver on the client machine

All these items have been defined by a database administrator. If you don’t know the 
items, contact that person.

Note When you create an SQL Anywhere database for use as an EDL, you have to set up the 
database to ignore trailing blanks in string comparisons. You must specify this setting 
when you initially create the database. This setting is turned OFF by default, and you 
need to turn it ON.

Note Depending on the database, user IDs and passwords can be case-sensitive. Be sure 
you know the exact representation of these items before you begin specifying the 
databases to the Control Panel.
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Starting Database Definitions

The Control Panel contains the necessary tools to enter specifications for either 16- 
or 32-bit databases, as can be seen by looking at the two icons listed on the main 
Control Panel window.

Because you can use the Control Panel window to specify settings for either 
database, this guide provides separate topics for each procedure.

Exiting Database Definitions

To Exit Database Setup

• From the File menu, choose Close.

-or-

In the upper-right-hand corner of the Database Setup window, click on the  
(Close) button.

Database Setup closes and returns control to the Control Panel.

To specify settings for Go to this topic

32-bit databases Setting Up 32-bit Databases 

16-bit databases Setting Up 16-bit Databases 
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SETTING UP 32-BIT DATABASES

The setup routine for 32-bit databases contains four modules. Each module is similar 
in design, but some of the modules don’t use all of the fields visible in their dialog 
boxes.

To Access 32-bit Database Setup Routines

• Double-click the  (32-bit Database Definitions) icon from the Control Panel 
main window.

The Docucorp 32-bit Database Setup window appears.

Because you can access any of the setup modules from the dialog, this guide 
provides separate topics for each module.

WARNING! Control Panel no longer includes 32-bit Database Definition icons for Documerge and 
Rulecommander. Therefore, on a new installation, the Docucorp 32-bit Database 
Setup dialog (seen below) will not display these two icons. The icons will not be 
removed from legacy installations, however, to preserve any current settings.

To specify settings for Go to this topic

PC VLAM Using the PC VLAM Panel 

Documerge Using the Documerge Panel 

Rulecommander Using the Rulecommander Panel 

Output System Using the Output System Panel 
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Using the PC VLAM Panel

The PC VLAM window contains one tab panel. You define a PC VLAM database 
by specifying database-related items in the tab. 

To Activate the PC VLAM Panel

• Double-click the  (PC VLAM) icon.

The 32-bit Database Setup window appears.

Because you can define multiple PC VLAM settings, this guide provides 
separate topics for each procedure.

To specify the Go to this topic

Database driver To Specify the Database Driver 

Database To Specify the Database 

Database engine or server To Specify the Database Engine or Server

Extended connection information To Specify the Extended Connection Information 

User ID and password To Specify the User ID and Password 

Log file of processing information To Specify the Log File 

Related database from which to copy settings To Copy the Settings from Another Database 

Closing or saving the Database Setup dialog To Close or Save the Database Setup Dialog 
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To Specify the Database Driver

1. Press TAB to reach the Database Driver drop-down list, then select or type the 
name of your database:

DB2 (version 5.0)

-or-

MS_SQL (Microsoft SQL Server, version 6.5)

-or-

ODBC (version 1.0)

-or-

ORACLE (version 8.1.7 or 9.2)

-or-

SQL_AnyWhere (Sybase, version 5.5)

-or-

SYBASE (client, version 11.1 or 12.5.1)

2. If this is a new item, you can click on Add to List to add it to the list. You can 
remove an item by selecting it from the list and clicking on Remove from List.

If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Specify the Database

1. Press TAB to reach the Database drop-down list, then select or type the name of 
the database or data source. 

2. If this is a new item, you can click on Add to List to add it to the list. You can 
remove an item by selecting it from the list and clicking on Remove from List.

If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Specify the Database Engine or Server

1. Press TAB to reach the Database Engine/Server drop-down list, then do one of 
the following:

Note If you’re specifying an ODBC client, select ODBC from the Database Driver drop-down 
list, then select or type the name of the data source (Data Source Name or DSN) in the 
Database drop-down list.

The ODBC client should have already been configured and assigned a DSN in the Data 
Sources (ODBC) applet of the Windows Control Panel

To specify the database engine for Do this

DB2 Leave blank

Microsoft Type the name (eight characters or fewer) of the server

ODBC Leave blank
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2. If this is a new item, you can click on Add to List to add it to the list. You can 
remove an item by selecting it from the list and clicking on Remove from List.

If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Specify the Extended Connection Information

1. Press TAB to reach the Extended Connect Information drop-down list, then 
select or type the appropriate value.

2. If this is a new item, you can click on Add to List to add it to the list. You can 
remove an item by selecting it from the list and clicking on Remove from List.

If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Specify the User ID and Password

1. Press TAB to reach the User ID text box, and then type the ID specified for the 
database (typically PCVLAM).

2. Press TAB to reach the Password text box, and then type the password required 
to access the database (typically PCVLAM).

ORACLE Leave blank

Sybase SQL AnyWhere Choose DBENG50.EXE %d for local database files

-or-

Choose DBCLIENT.EXE -x IPX %d for the database server

SYBASE Type the name (eight characters or fewer) of the server

For this version of the client Type

DB2 5.0 Client Version=5.0

Microsoft SQL Client Version=6.5

ODBC Version=1.0

Oracle 8.1.7 Client Version=8.1.7

SQL AnyWhere Client Version=5.5

Sybase 11.1 Client (16-bit connection only) Version=11.1.1

Oracle 9.2 Client (Linux) Version=9.2

Note Oracle 9.2 is not currently available for use with Windows. As a result, the drivers only 
come into play when using the Docucorp Database EDL maintenance applet for 
pcVLAM (database) EDLs, and the Output System applet for viewing the Output 
System.

Tip You might not need to specify the User ID and Password fields for the ODBC client in 
the PC VLAM tab, since you can sometimes enter these items while configuring the data 
source (DSN).
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If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Specify the Log File

1. Click on the Enable Logfile check box to establish and maintain the log file.

2. Press TAB to reach the Enable Logfile text box, then type the drive letter, path, 
and file name of the log file or click on Browse.

If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Copy the Settings from Another Database

• Press TAB to reach the Copy Settings From drop-down list. You can speed your 
setup time by selecting an existing database setup and clicking Copy.

If you want to close or save the PC VLAM panel, go to To Close or Save the 
Database Setup Dialog.

To Close or Save the Database Setup Dialog

• Do one of the following:

Tip The Logfile is the fully-qualified path where a step-by-step progress listing is stored.

To Do this

Apply the Database Definition specifications you’ve provided without closing the 
window

Choose the Apply button.

Apply the specifications you’ve provided and return to the Database Setup window Choose the OK button.

Return to the Database Setup window without applying the specifications you’ve 
provided

Choose the Cancel button.
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Using the Documerge Panel

The Documerge window contains one tab panel. You define a Documerge database 
by specifying database-related items in the tab.

To Activate the Documerge Panel

• Double-click the  (Documerge) icon.

The 32-bit Database Setup window appears.

Because you can define multiple Documerge settings, this guide provides 
separate topics for each procedure.

WARNING! The Documerge panel only applies to legacy installations.

To specify the Go to this topic

Database driver To Specify the Database Driver 

Database To Specify the Database 

Database engine or server To Specify the Database Engine or Server 

Extended connection information To Specify the Extended Connection Information 

User ID and password To Specify the User ID and Password 

Related database from which to copy settings To Copy the Settings from Another Database 

Closing or saving the Database Setup dialog To Close or Save the Database Setup Dialog 
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Using the Rulecommander Panel

The Rulecommander window contains one tab panel. You define a Rulecommander 
database by specifying database-related items in the tab.

To Activate the Rulecommander Panel

• Double-click the  (Rulecommander) icon.

The 32-bit Database Setup window appears.

Because you can define multiple Rulecommander settings, this guide provides 
separate topics for each procedure.

WARNING! The Rulecommander panel only applies to legacy installations.

To specify the Go to this topic

Database driver To Specify the Database Driver 

Database To Specify the Database 

Database engine or server To Specify the Database Engine or Server 

Extended connection information To Specify the Extended Connection Information 

User ID and password To Specify the User ID and Password 

Related database from which to copy settings To Copy the Settings from Another Database 

Closing or saving the Database Setup dialog To Close or Save the Database Setup Dialog 
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Using the Output System Panel

The Output System window contains one tab panel. You define an Output System 
database by specifying database-related items in the tab.

To Activate the Output System Panel

• Double-click the  (Output System) icon.

The 32-bit Database Setup window appears.

Because you can define multiple Output System settings, this guide provides 
separate topics for each procedure.

To specify the Go to this topic

Database driver To Specify the Database Driver 

Database To Specify the Database 

Database engine or server To Specify the Database Engine or Server 

Extended connection information To Specify the Extended Connection Information 

User ID and password To Specify the User ID and Password 

Communications directory To Specify the Communications Directory 

Log file of processing information To Specify the Log File

Related database from which to copy settings To Copy the Settings from Another Database 

Closing or saving the Database Setup dialog To Close or Save the Database Setup Dialog 
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To Specify the Communications Directory

• Press TAB to reach the Communications Directory text box, and then type the 
drive letter and path or click on Browse to locate the directory.

If you want to close or save the Output System panel, go to To Close or Save the 
Database Setup Dialog.

SETTING UP 16-BIT DATABASES
The setup routine for 16-bit databases contains three modules. Each module is 
similar in design, but some of the modules do not use all of the fields visible in their 
dialog boxes.

To Access 16-bit Database Setup Routines

• Double-click the  (16-bit Database Definitions — icon from the Control 
Panel main window.

The Docucorp 16-bit Database Setup window appears.

Because you can access any of the setup modules from the dialog, this guide 
provides separate topics for each module.

Tip The Communications Directory is the fully-qualified path where Documerge message 
and statistics files are stored. These files are manipulated through the Output System 
object viewer.

Note When installing Control Panel on a 64-bit OS, use the 32-bit Database. The 16-bit 
database will not work on a 64-bit OS.

To specify settings for Go to this topic

PC VLAM Using the PC VLAM Panel 

Documerge Using the Documerge Panel 

Rulecommander Using the Rulecommander Panel 
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Chapter 11

THE FONT MATCHING TABLE EDITOR OBJECT

USING THE FONT MATCHING TABLE EDITOR
The Control Panel - Font Matching Table Editor object eases the task of editing a 
Font Matching Table that establishes a substitution relationship between Windows 
scalable fonts and device, or printer, fonts. This substitution relationship is critical 
when creating printer-specific data streams (e.g., IBM AFP or Xerox Metacode) 
because Windows doesn’t employ device fonts and AFP and Metacode printers do 
not recognize scalable fonts.

Starting or Ending the Font Matching Table Editor

To Start the Font Matching Table Editor

• In the Control Panel, double-click the  (Font Matching Table Editor) icon

The Font Matching Editor window appears.

To Exit the Font Matching Table Editor

• Choose Exit from the File menu.

-or-
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In the upper-right-hand corner of the Font Matching Editor window, click on the 
 (Close) button.

The Font Matching Table Editor closes and returns control to the Control Panel.

USING THE FONT MATCHING EDITOR DIALOG AND TABS
The Font Matching Editor window contains general-purpose menu options and two 
tabs. You edit a font matching table by specifying printing environment-related 
items in panels under the tabs.

To Use a Font Matching Editor Function

• Do any of the following:

Using the File Menu

Use the File menu options to

• Create a table

• Open a table

• Close a table

• Save a table

• Save a table with a new name

• Use existing PFMs to create a table

• Open a recently-used table

• Exit the Font Matching Editor

Because the File menu controls several maintenance functions of the Font Matching 
Editor, this guide provides a separate topic for each area.

To Go to this topic

Edit a font table (open, edit, save, close, etc.) Using the File Menu

Add, delete, find, and view fonts Using the Table Tab

Specify the sort order and sort column options Using the Options Tab

If you need to Go to

Create a table Creating a Font Matching Table

Open a table To Open a Table

Close a table To Close a Table

Save a table To Save a Table

Save a table with a new name To Save a Table with a New Name

Use existing PFMs to create a table Creating a Font Matching Table

Open a recently-used table To Open a Recent File
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Creating a Font Matching Table

The Font Matching Table editor lets you create a table that matches the TrueType or 
Adobe screen fonts that you use to compose your documents with the exact AFP or 
Metacode device-fonts that you want to use to print the documents.

Because the table editor offers two methods to create a Font Matching Table, we 
address each method in a separate topic:

To Create a Font Matching Table Using PFM Migration

1. Choose PFM Migration from the File menu.

Exit the Font Matching Editor To Exit the Font Matching Table Editor

If Go to

You want to save time by automatically creating and populating 
table rows with Windows fonts  and corresponding device font 
PFMs

-and-

your system has AFP or Metacode device font PFMs that have 
been specified in a Metacode or AFP Printer,FILE font 
section of the ISI.INI file

-and-

you know the name of a Print Definition which specifies that font 
section

To Create a Font Matching Table Using PFM 
Migration

You want to insert the Windows font and corresponding PFM font 
information in one row at a time

-and-

your system has AFP or Metacode device font PFMs that have 
been specified in a Metacode or AFP Printer,FILE  
font section of the ISI.INI file

To Create a Font Matching Table Using Add 
Item

If you need to Go to
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The Migrate PFMs to a Font table dialog appears.

2. From the Select a Font Section from a Print Definition drop-down list box, 
choose the Print Definition that specifies the appropriate AFP or Metacode font 
section.

3. In the Enter the name of Table file to create text box, type the path and file 
name of the table file to create (the editor will automatically append the .tbl file 
type to the name).

-or-

To browse for the correct directory path, choose the Browse button. The Enter 
the name ... dialog appears.
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Do the following, as required:

4. If you want to display the table upon completion of the migration 
(recommended), select the Display the table upon completion check box.

5. Choose Ok.

The Editor attempts to assemble the fonts specified in the Metacode or AFP 
Printer,FILE Font Section into a Font Matching Table labeled with the name 
you specified.

To Do this

Specify a different folder to hold the table Click the arrow on the right of the Save in drop-down list, and then select a 
different drive and/or folder.

Specify a different type for the table Click the arrow on the right of the Save as type drop-down list, and then select a 
different (AFP or Metacode) table type.

Enter the name of the file to hold the table In the File name text box, type the name of the file (the editor will automatically 
append the .tbl extension to the name).

Save the table file using the current 
specifications

Choose the Save button.
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If all fonts specified in the Font Section don’t reside in the same directory, the 
editor will display the following dialog:

This dialog shows the different directories where the font PFMs reside, and 
prompts you to choose one of the directories to hold all of the fonts, including 
those fonts that the editor will transfer from the other directories.

6. If the editor displays the dialog shown above, select one of the directories shown 
in the list box, and then choose the Copy Fonts to a new Destination button.

The Editor moves the font files to the directory you specified, and changes the 
path statements for the font files in the Metacode or AFP Printer,FILE Font 
Section to reference the new directory.
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The editor creates the Font Matching Table you specified, and displays a 
message similar to the following:
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The editor then displays the newly populated table, which is similar to the 
following:

You can now edit any font matching rows that need to be corrected. For instructions, 
go to Using the Table Tab.

Windows font column: 
shows the outline font for 
screen display and print to 
a Windows printer

Style column:
shows the style 

(bold, italic, etc.) 
of the Windows 
font

Size column:
shows the point 

size of the 
Windows font

Device font (.PFM) columns: 
shows the names of the 
matching AFP or Metacode 
device fonts for all available 
orientations

Table name: shows the name of 
the Font Matching Table (preceded 
by the file's directory path)

Font count: shows 
the number of font 
rows in the table

Table type: shows 
the type of table 
(AFP or Metacode)

Windows font column: 
shows the outline font for 
screen display and print to 
a Windows printer

Style column:
shows the style 

(bold, italic, etc.) 
of the Windows 
font

Size column:
shows the point 

size of the 
Windows font

Device font (.PFM) columns: 
shows the names of the 
matching AFP or Metacode 
device fonts for all available 
orientations

Table name: shows the name of 
the Font Matching Table (preceded 
by the file's directory path)

Font count: shows 
the number of font 
rows in the table

Table type: shows 
the type of table 
(AFP or Metacode)



244

To Create a Font Matching Table Using Add Item

1. Choose New from the File menu.

The Enter the name ... dialog appears.

Do the following, as required:

To Do this

Specify a different folder to hold the table Click the arrow on the right of the Save in drop-down list, and then select a 
different drive and/or folder.

Specify a different type for the table Click the arrow on the right of the Save as type drop-down list, and then select a 
different (AFP or Metacode) table type.

Enter the name of the file to hold the table In the File name text box, type the name of the file (the editor will automatically 
append the .tbl extension to the name).



Chapter 11 – 

245

2. To save the table file using the current specifications, choose the Save button.

The Editor saves the table to a file, and displays it so that you can begin 
preparing the table. 

3. Choose Add Item... from the Fonts menu.

The Add Item window appears.

4. In the Name drop-down list box, select a scalable font you want to match with a 
device font. In the above illustration, you would substitute a Windows Arial font 
for a Xerox Metacode Arial font (e.g., AR110).
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5. In the Style drop-down list box, select the style for the Windows font.

6. In the Point Size drop-down list box, select the size for the Windows font, or 
press the corresponding number key(s).

7. In the Portrait, Landscape, Inverse Portrait, and Inverse Landscape text 
boxes, type the device font name of each orientation to be matched.

8. Choose OK.

The editor adds the font matching entry to font matching table in the next 
available row.

9. Repeat steps 3 through 8 until you’ve added all of the font matching entries 
required to specify corressponding Windows fonts for the device fonts used by 
your AFP or Metacode printer.

10. Choose Save... from the File menu.

The Font Matching Editor saves your changes.

To Open a Table

1. Choose Open from the File menu.

The Open Table dialog appears.

2. Do the following, as required:

If Do this

The incorrect drive or folder shows in the Look in text box Click the arrow on the right of the Look in text 
box, and then select the drive and/or folder 
where the table file is located.

The correct folder doesn't show in the Look in list box In the Look in list box, scroll to see more 
folders, or double-click a root folder to see its 
subfolders.

The correct table file name doesn't show in the Look in 
list box

In the Look in list box, double-click the correct 
folder to see its contents.

The name of the table file doesn't show in the File name 
text box

In the Look in list box, click to select the table 
file and place it in the File name text box.

You want to open the table file indicated by the current 
specifications

Choose the Open button.
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The table is opened and you’re returned to the Font Matching Editor window where 
you can proceed with editing the font table. The name of the table is displayed in the 
Status Bar (see To View/Hide the Status Bar).

To Close a Table

• Choose Close from the File menu.

The Table tab is cleared and you’re ready to edit another Font Matching Table.

To Save a Table

• Choose Save... from the File menu.

The Font Matching Editor saves your changes.

To Save a Table with a New Name

1. Choose Save As... from the File menu.

The Save As window appears.

2. Do the following, as required:

The table is saved to a new file with the new name and you’re returned to the Font 
Matching Editor window. The previous font table is still present on your hard drive 
and should be listed as a Recent File. The name of the table is displayed in the Status 
Bar (see To View/Hide the Status Bar).

To Do this

Specify a different folder to hold the table Click the arrow on the right of the Save in drop-down list, and then select a 
different drive and/or folder.

Enter the name of the file to hold the table In the File name text box, type the name of the file (the dialog will automatically 
append the .tbl extension to the name).

Specify a different printer type for the table Click the arrow on the right of the Save as type drop-down list, and then select a 
different printer.

Save the table file using the current 
specifications

Click the Save button.
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To Open a Recent File

• Choose Recent Files from the File menu and select a table to open.

The selected table is displayed and you may proceed with editing. The name of the 
table is displayed in the Status Bar (see To View/Hide the Status Bar).

Using the Table Tab

Use the first tab in the Font Matching Editor window to

• Add a font to a table

• Remove a font from a table

• Use the Windows Clipboard to manipulate fonts within a table

• Search for a given font

• View the Status and Tool Bars

• Refresh the display of a table

To Activate the Table Panel

• If the Table panel is not already showing in the Font Matching Editor window, 
click on the Table tab.

The Table panel appears.
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Because the Table panel provides controls for several tasks within the Font 
Matching Editor, this guide provides a separate topic for each task.

To Add an Item

1. Choose Add Item... from the Fonts menu.

The Add Item window appears.

2. In the Name drop-down list box, select the scalable font you want substituted for 
the device font. In the above screen capture, you would substitute a Windows 
Arial font for a Xerox Metacode Arial font (e.g., AR110).

3. In the Style drop-down list box, select the style for the substituted font.

4. In the Point Size drop-down list box, select the size for the substituted font or 
press the corresponding number key.

5. In the Portrait, Landscape, Inverse Portrait, and Inverse Landscape text 
boxes, type the font name of each orientation to be substituted.

The font item is added to the current font matching table on the next available line.

If you need to Go to

Add a font item to a table To Add an Item

Delete a font item from a table To Delete an Item

Cut an item to the Clipboard To Move an Item to the Clipboard

Copy an item to the Clipboard To Copy an Item to the Clipboard

Paste an item from the Clipboard To Paste an Item from the Clipboard

Find an item within a table To Find an Item

Toggle the view of the Tool Bar To View/Hide the Tool Bar

Toggle the view of the Status Bar To View/Hide the Status Bar

Refresh the table display To Refresh the Display
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To Delete an Item

1. Highlight the font item you want to delete.

2. Choose Delete Item from the Fonts menu.

The Delete Item window appears.

3. Click Yes to remove the font from the table; otherwise, click No.

The font is removed from the font matching table; however, this action in no way 
affects the fonts stored on your hard drive.

To Move an Item to the Clipboard

Use the Cut command to move a font item you've selected onto the Windows 
Clipboard. Unlike the action of the Copy command, Cut removes the selected font 
from its original location.

1. Select the font item.

2. Choose Cut from the Edit menu.

The font is place on the Windows Clipboard.

You can now insert the font item on other lines in the current table. For details, see 
To Paste an Item from the Clipboard.

To Copy an Item to the Clipboard

Use the Copy command to place a copy of a font item you've selected onto the 
Windows Clipboard. Unlike the Cut command, Copy leaves the selected font in its 
original location.

1. Select the text.

2. Choose Copy from the Edit menu.

The font is copied to the Windows Clipboard.

You can now insert the font item on other lines in the current table.  For details, see 
To Paste an Item from the Clipboard.
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To Paste an Item from the Clipboard

Use the Paste command to copy a font item from the Clipboard to a location where 
you have clicked an insertion point.

1. Click an insertion point at the location where you want the font to be inserted.

2. Choose Paste from the Edit menu.

The font is copied from the Windows Clipboard and stays there until you replace it 
with a font item from the next Cut or Copy operation.

To Find an Item

1. Choose Find... from the Edit menu.

The Table Search window appears.

2. Type the name of the attribute for which you want to search (e.g., Font, Style, 
Point Size, or Orientation).

3. Click OK.

The Font Table Editor locates the first item matching your search criteria and 
highlights it.

To View/Hide the Tool Bar

The Tool Bar displays several icons which represent shortcuts to some menu options. 
These icons save time because you can click on an icon versus choosing a menu 
option.

A slight disadvantage, however, is that the number of lines of displayed fonts is 
reduced by the amount of space dedicated to displaying the Tool Bar. Therefore, you 
can either display the Tool Bar on the main window or hide it from view.

• Choose Tool Bar from the View menu.

If a check mark is displayed next to the option when you make this choice, the 
Tool Bar will now be hidden, and vice versa. By removing the Tool Bar from the 
dialog, you can increase the number of font items which can be listed in the 
available space.

To View/Hide the Status Bar

The Status Bar displays relevant information about the current font matching table, 
such as the location and name of the file, the number of fonts, and the printer for 
which you’re building the list.
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A slight disadvantage, however, is that the number of lines of displayed fonts is 
reduced by the amount of space dedicated to displaying the Status Bar. Therefore, 
you can either display the Status Bar on the main window or hide it from view.

• Choose Status Bar from the View menu.

If a check mark is displayed next to the option when you make this choice, the 
Status Bar will now be hidden, and vice versa. By removing the Status Bar from 
the dialog, you can increase the number of font items which can be listed in the 
available space.

To Refresh the Display

Use the Refresh command to display an updated listing of your fonts in the Table 
pane.

• Choose Refresh from the View menu.

An updated listing of your fonts appears in the Table pane.

Using the Options Tab

Use the second tab in the Font Matching Editor window to specify

• The order in which the list should be sorted

• The column on which the sort order should be based

To Activate the Options Panel

• If the Options panel is not already showing in the Font Matching Editor window, 
click on the Options tab. 
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The Options panel displays.

Because the Options panel contains several group boxes of specifications, this 
guide provides a separate topic for each group.

To Select the Sort Order

Choose the order in which the Font Matching Editor listing is sorted (e.g., none, 
ascending, or descending).

1. Press TAB to reach the Sort Ordering group box.

2. Click on the option button representing your preference.

If you’re finished specifying the sort order, click Apply.

If you need to Go to

Select the Sort Order of the font items To Select the Sort Order 

Choose the column on which to base the Sort Order To Select the Sort Column 
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To Select the Sort Column

Choose the column(s) on which to sort the Font Matching Editor listing.

1. Press TAB to reach the Sort Column group box.

2. Click on as many columns as necessary to properly sort the font item listing.

If you’re finished specifying the sort column(s), click Apply.

Tip The Sort Column choices act as a “starting” and “ending” point for your sorting criteria. 
If you choose Columns 1 and 5, for example, your sorting choice includes all five 
columns.



Chapter 11 – 

255


	Start
	Introduction
	About This Guide
	What Is the Control Panel?
	System Requirements

	Downloading the Software
	Installing the Control Panel
	Using the Control Panel
	Navigating the Control Panel
	Changing Control Panel Applications (Objects)
	Editing an Existing Control Panel Object

	The Printer Definitions Object
	Using Printer Definitions
	Starting or Ending Printer Definitions

	Adding A Printer
	Using the Print Definition Dialog and Tabs
	Using the Paper Tab

	Using the Tray Dialog and Tabs
	Using the Paper Tab
	Using the Print Options Tab
	Using the CG Overlays Tab (AFP only)
	Using the Setup Options Tab
	Using the Device Options Tab
	Using the Advanced Options Tab

	Changing a Printer Definition
	Copying a Printer Definition
	Renaming a Printer Definition
	Deleting a Printer Definition

	The Electronic Document Libraries Object
	Using Electronic Document Libraries (EDLs)
	Starting or Ending EDL Setup
	Creating a New Library
	Backing Up and Restoring Libraries
	Editing Backup Styles
	Generating a Library Report
	Adding a File to a Member (Loading a Chain)
	Saving a Chain to a Disk File (Dumping a Chain)
	Deleting a Chain

	The File-Based EDL Object
	Using File-Based EDLs
	Starting and Ending the File-Based EDL Object
	Creating the Database and the First EDL
	Working in the File-Based EDL Main Window
	Editing Backup Styles
	Generating a Library Report

	About Setting File-Based EDL Preferences
	Using the Preferences Tab
	Using the Backup Tab

	The VLAMUser API (vlamuser.w32)
	Limitations with File-Based EDL Support
	Currently Supported Functions

	The Production Definitions Object
	Using Production Definitions
	Starting or Ending Production Definitions Setup

	Adding A New Production Definition
	Changing a Production Definition
	Copying a Production Definition
	Renaming a Production Definition
	Deleting a Production Definition
	The Merge Definitions Object
	Using Merge Definitions
	Starting or Ending Merge Definitions

	Adding a Merge Definition
	Using the Merge Definition Dialog and Tabs
	Using the Page Setup Tab
	Using the Processing Tab

	Changing a Merge Definition
	Copying a Merge Definition
	Renaming a Merge Definition
	Deleting a Merge Definition
	The Documaker fp Job Submission Object
	Using Documaker fp Job Submission
	Starting or Ending Documaker fp Job Submission

	Using the Job Submission Dialog and Tabs
	Using the Job Submission Tab
	Using the Queues Tab
	Using the Directories Tab
	Using the Advanced Options Tab

	The Output System Viewer Object
	Using the Output System Viewer
	Starting or Ending the Output System Viewer

	Using the Output System Dialog and Tabs
	Using the Output System Tab
	Using the Options Tab

	The Database Definitions Object
	Using 16-bit Database Definitions
	Using 32-bit Database Definitions
	Supported Databases
	Before You Start Setting Up the Database
	Starting Database Definitions
	Exiting Database Definitions

	Setting Up 32-bit Databases
	Using the PC VLAM Panel
	Using the Documerge Panel
	Using the Rulecommander Panel
	Using the Output System Panel

	Setting Up 16-bit Databases
	The Font Matching Table Editor Object
	Using the Font Matching Table Editor
	Starting or Ending the Font Matching Table Editor

	Using the Font Matching Editor Dialog and Tabs
	Using the File Menu
	Creating a Font Matching Table
	Using the Table Tab
	Using the Options Tab



